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Support 
 

1.1 Manuals and Tutorials 
April 2022 

 

Internet Resources 
 
This manual, CADD Standards manual, is available on the Internet: 
www.dot.nd.gov/manuals/design/caddmanual/caddmanual-ord.pdf.  Users should review this 
web site for all future revisions. 
 
The “How to Check Supplemental Design Data” guide provides recommendations for reviewing 
model information that is provided to contractors. 
www.dot.nd.gov/manuals/design/caddmanual/How%20to%20check%20Supplemental%20Design%20Data.pdf 

NDDOT Server Network Resources   
 
Axiom manuals are located under their respective folders under 
M:\APPS\Production\Design\AxiomV10. 
 
A variety of “How To” reference videos and guides are available under S:\SUPPORT\How_To. 
 
Chapter 21 –Surveys and Photogrammetry, CADD Editing, is available at 
S:\SUPPORT\Teams\Survey\NonMicroStationData\DraftingStandards\Level_1\CH21 CADD 
Editing Standards.pdf 

http://www.dot.nd.gov/manuals/design/caddmanual/caddmanual-ord.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/How%20to%20check%20Supplemental%20Design%20Data.pdf
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1.2 The CADD Specialist and Support Contacts 
April 2023 

 
The CADD Specialist (Jon Collado, 328-4439) provides technical engineering related support for 
CADD programs.  His other duties include: 
 
 Researching and maintaining CADD technologies 
 Providing application specific training 
 Coordinating engineering related standards development and implementation 
 
The CADD Specialist is the primary contact for technical engineering related CADD support 
questions.  Support from co-workers is also important.  Here is a list of other users who may be 
able to help you: 
 
Survey:   Troy Zornjak 
 
Alignments:   Sara Cahlin 
 
Earthwork:   Brady Haussler, Sara Cahlin 
 
Corridor Modeling:  Sam Welch, Jennifer Kern 
 
Corridor Templates:  Sam Welch, Jennifer Kern 
 
MicroStation:   Kris Altepeter, Chad Frisinger 
 
Information Technology: Carey Schriener 
 
Adobe Acrobat:  Travis Cork, Garrett Hartl 
 
GuideSign:   Travis Cork 
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1.3 Standards Committee 
April 2023 

 
Members: Adam Cahlin, Sara Cahlin, Jon Collado (chairperson), Travis Cork,  

Monte Deis, Brady Haussler, Jennifer Kern, Brian Raschke, Randall Sandvig, 
Alex Spady, Sam Welch, and Troy Zornjak 

 
The Standards committee is responsible for developing, maintaining, documenting, and 
providing training for the NDDOT CADD standards.  The standards committee is not 
responsible for enforcing the standards.  If a user has a problem or cannot use one of the 
standards, they should contact the CADD support specialist. 
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Project Administration 
 

2.1 Current Software 
April 2023 

 
The NDDOT is presently using the following versions of software.  

AutoTurn 11 
Axiom Toolkit 10 
Axiom Title Block Administrator 10.1a 
Bentley View 10.17 
GuideSign Plus 8.1.0.176 
MicroStation CE 10.17.2.61 
OpenBridge Designer 10.11.00.40 
OpenRoads Designer 10.11.03.02 

 
NDDOT is implementing ORD 10.11, OBD 10.11 and MCE 10.17 on June 1, 2023. 

• Early adoption of software updates listed above, based on project specific schedules, is 
allowed. 

• At this time, implementing ORD 10.12 or OBD 10.12 is not allowed for NDDOT 
projects. 

• NDDOT consultants that have concerns with updating software on active projects, such 
as ORD 10.10 to 10.11, can request an exemption to continue using software listed in 
contract agreements from a Design Program Manager. 
 

V8i Exemptions 
• Project Design may use V8i (SS10) software if both the environmental document and 

substantial design was completed before July 1, 2022. 
• If the above requirements are not met, an exemption to use V8i may also be requested 

from a Design Program Manager. Please include the reasons why V8i is being requested 
for the project in the exemption request. 

• Project Design may use V8i software for select workflows.  
o Addendums and Change Orders for V8i projects 
o Legal Description Editor 

 
 
 
Some NDDOT workflows have not been addressed in the current ORD standards.  The main 
development area in the current standards is roadway design and survey.  Standards for bridge, 
hydraulic, geotechnical and traffic design have not been pursued as much as roadway design. 
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2.2 Resource Files 
April 2023 

 
The current CADD Standard Index File is dated “4/26/2023 11:21:35 AM”.  This index is used 
with a macro to review your current version of NDDOT CADD Standards.  See the “Design” 
workflow, “Main” tab, “Help” Group, “Index NDDOT Standard Files”.  The index file 
(nddotUpdateIndex.csv) is a comma separated value file that can also be manually reviewed with 
a text editor or Excel. 
The following tables show the update dates for CADD Standard Resource Files.  The file name 
shown in blue is a hyperlink. 
Description File Name (Link to 

Resource) 
Updated Posted 

Installation and Administrative Files Install.exe 3/14/23 5/1/23 
Cell Libraries Cells.exe 2/15/23 5/1/23 
DGN Libraries Dgnlib.exe 3/21/23 5/1/23 
All other Resource Files Data.exe 4/26/23 5/1/23 
Workspace and Workset Files Workspace.exe 3/23/22 5/1/23 
GuideSign GuideSIGN.exe 5/6/21 5/11/21 

  

https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/Install.exe
https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/Cells.exe
https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/Dgnlib.exe
https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/Data.exe
https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/WorkSpaces.exe
https://www.dot.nd.gov/manuals/design/caddmanual/ORD_Reasource_Files/10.11/GuideSIGN.exe
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2.3 Standards Directory 
April 2023 

 
Most of the NDDOT CADD standards are stored under the S:\STANDARD\CE10\Organization 
folder.  This is a summary of subdirectories used to store resource files.  Files in these directories 
are used to configure many of the operations performed by software used for NDDOT CADD 
operations. 
 
Subdirectory Description 
  
Cell Cell Libraries 
Cfg Configuration Files 
Data Tags and WMS links 
Dgnlib Dgn Libraries 
Geographic Geographic Coordinate Systems 
Interface Default Function Keys 
Macros Visual Basic Macros 
Materials Materials Symbology 
Materials_Civil Materials Symbology 
Mdlapps MDL Applications 
Pltcfg Plot Drivers and Pen Tables 
Preference Seed Default Interface Preferences 
Reports Style Sheets for the Report Browser 
Scales Annotation Scale and Sheet Definition Settings 
Seed Seed Files 
Sheet Borders Sheet Borders as dgn 
Sight Visibility Sight Visibility Settings 
Superelevation Superelevation Settings 
Survey Text Import Wizard 
Symb Line styles, Fonts, Color Table 
Template Library Default Corridor Template Library 
Widening Curve Widening Settings 
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2.4 Project Directories 
April 2023 

 
The sharing of information is a vital part of the success of a NDDOT project.  Thus, when a new 
project begins, a centralized directory structure is needed.  Since it is important that data is 
shared but not corrupted by unauthorized users, the Department has established a standard 
procedure for directory creation and file naming. 
 
A NDIT help request is used to have NDIT create project directories.   
 https://northdakota.service-now.com/serviceportal 
 
Use the “Get Help” tool. 
 
 
 
 
 
 
 
 
 
 
 
NDDOT project numbers consist of a funding code, district, highway, agreement number, and 
mile point.  A typical number may be “SS-1-804(049)027”.   
 
The directory created for this project would be as follows: “R:\project\11804027.049”.   
Highways named with 4 digits should always use all 4 digits in the folder name even if the 
project number only uses 3 digits for the highway number. 
 
  

https://northdakota.service-now.com/serviceportal
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Each directory has the appropriate security access set by division.  Thus, Bridge staff is only 
allowed write access to the Bridge subdirectory.  Other directories will be “read only” for Bridge 
staff.  The directory under the R:\project\11804027.049 directory would consist of the following 
subdirectories: 
 
  Bridge  (Bridge Division) 

Consultant (Hired Consultant Firm) 
  Design  (Roadway Design Sections) 
  District (Any of the 8 District offices) 

DOTSC (DOT Support Center) 
  ePlans  (Electronic Plans) 
  ETS  (Environmental and Transportation Services) 
  Material  (Materials & Research Division) 
  Resources (common resources such as old plans) 
  ROW  (Right of Way Section) 
  Survey  (Preliminary Surveys Section) 
  Traffic  (Traffic Section) 
  Utilities (Technical Support Section, Utility Coordination Plans) 
 
 
On rare occasions other Divisions will require a project subfolder.   If needed, this can be 
included in NDIT help request. 
 
  Construction  (Construction Division) 

Maintenance (Maintenance Division) 
Planning (Planning/Asset Management Division) 

   
NDIT has optimized levels of security so that project related folders, up to and including the 
above root directories, cannot be deleted or edited.  However, any folder can be created by an 
individual user, past that level.  Obviously, users need to follow certain conventions of folder and 
file naming in order to effectively communicate with others. 
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Under each of these root directories, there are unique folders that describe the specialized 
operations of these users.  For example, the users in Preliminary Surveys would use the 
following directory when they are working on electronic field book data: 
R:\project\11804027.049\survey\EFB. 
 
The following are recommended subdirectories: 
(^T = Excluded in NDIT setup template, manually add as needed) 
(^C = See “F:\Design\78 Technical Support Section\zTemplate”) 
 
Bridge  

• Dgn 
o (Subdirectories for each 

structure, name based on 
structure number) 

• Standards 
• Out 
• Environmental 

o Field Review 
o Public Input 
o Management Presentation 
o SOV 
o CATEX 
o 404_Permit 
o Flood_Plain_Permit 

• Hydraulics 
o Structure 
o Roadway 

 
Consultant 

• CADD Files 
o As-built 
o Bridge 
o Design 
o Material 
o ROW 
o Survey 
o Supplemental Design Data 
o Traffic 

• Correspondence (^T^C) 
• Project Management (^T^C) 
• Submittals (^T^C) 

 
 
 
 

Design  
• Dgn 
• Standards 
• Out 
• Sheets 
• Supplemental_Design_Data 
• Environmental 

o Field Review 
o Public Input 
o Management Presentation 
o SOV 
o CATEX 
o 404_Permit 
o Flood_Plain_Permit 

• Support_Documents (Non 
Environmental) 

• Excel 
 
District (Same Structure as Design + 
Asbuilt) 

• As-built 
 
DOTSC (Same Structure as Design) 
 
ePlans (PDF Files Only) 

• 01_Preliminary  
• 02_PSE  
• 03_Final 
• 04_Addendum 
• 05_Change_Order 

 
ETS 
 
Material  
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Resources 

• Photos 
• Old_Plans 

 
ROW 
 
Survey 

• Aerial (^T) 
• Consultant (^T) 
• EFB (^T) 
• Final (^T) 

o Photos_Scans (^T) 

 
Traffic 

• Sheets 
 
Utilities 
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Occasionally, some projects are not associated with a project number.  The project may not be 
adjacent to a highway such as a wetland mitigation project.  Miscellaneous projects that don’t 
have standard project numbers should be stored in a subdirectory under R:\project\misc\.  A brief 
project description could be used as the project subdirectory name.  The sub directory structure 
will be set up the same as a normal project.  Users should call the help desk to get a base 
subdirectory created. 
 
Right of Way plots that are not associated with a highway project are stored in the 
“R:\project\PLATS_misc\” directory. 
 
Consultants 
 
Consultants shall set up and use a directory structure similar to the Central Office. 

1. Create a project folder using the NDDOT Standard directory structure.  Consultants 
can revise the server or drive designation as they need (example: 
x:\NDDOT\project\80013389.031).  Everything after the project number (example: 
80013389.031) must be setup the same as the NDDOT standard project directory. 

2. Work in this directory. 
3. When a project is complete copy the files to the applicable MFT folder for the 

Consultant and Project. 
a. Consultants shall notify their respective Technical Support Contact within the 

Design Division when final project files have been posted. 
4. The Technical Support Representative will import the project information to the R:\ 

drive. 
 
All users, especially District and Consultant users, need to use the “Save Relative Path” options 
when referencing files.  The “Save Relative Path” option will help keep the reference path 
integrity when the files are moved from one drive to another. 
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2.5 File Naming Conventions 
April 2023 

 
MicroStation drawing names have been standardized for easy, quick and consistent identification 
and they have been standardized to ease the preparation of plan plot sets.  Standard names also 
apply to non-drawing files that are used in a plan plot set.  This section applies to names of 
original files.  For names of the pdf plan sets, see Section 2.14 
 
Standard drawing names can be made up from 4 parts; prefix, plot number, suffix and suffix 
modifier.  The following drawing name is in accordance with the standards: 
    004SW_002_SCOPE.dgn 
 
In this example the “prefix” is 004SW, the “plot number” is 002, and the “suffix” is SCOPE.  
Note the underscore characters are standard name dividers. They are used after the prefix, plot 
number and between the suffix and suffix modifier.  The example standard name doesn’t use a 
“suffix modifier”. 
 
The “prefix” is used to divide and organize plot sets into sections.  The prefix is required for all 
drawings that are going to be directly incorporated into a plot set for plan production.  These 
plots are used to directly print a sheet in the plans.  The prefix should not be used for a 
referenced drawing that is indirectly included in the plans.  For example, topog information 
include in the plans is indirectly included in the plans because it is a referenced drawing.  The 
topog drawing should not have a prefix. The topog drawing would just be named TOPOG.dgn. 
 
Appendix A lists the current standard drawing names.  Check the appendix to find the correct 
naming convention when creating a new file. 
 
The NDDOT also has a custom 
macro that can be used to create a 
new drawing with a standard name.  
This macro creates a new drawing 
as you look up the standard name.  
The Macro is activated through 
most of the NDDOT workflows 
under the “Main” tab.  It is named 
“Create New File”.  
 
The macro accommodates suffix 
modifiers and the page number 
within section.  User will be 
prompted for this information through a dialog box.  
 
The new file will be created in the present drawing directory.  This macro doesn’t provide 
options to create drawings in other directories.   
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/appendixa.pdf
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Some other features of this macro include a safeguard to prevent creating a drawing that already 
exists (overwriting a file).  Different seed files are used based on the type of drawing selected.   
 
One limitation to this macro is metadata. This macro uses a file copy and open command in the 
background. The file metadata is not reset with a copy command.  Some properties such as 
author, logged edit time and number of revisions will not be reset.  These properties don’t affect 
file performance and metadata is presently not a CADD Standard. 
 
Please contact the CADD Specialist (see Section 1.2) if you need a file name that doesn’t fit the 
existing naming standards. 
 
The table on the following page lists standard sheet name prefixes. 
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Section 
Number 

Section Description Sheet Name 
Prefix 

001 Title Sheet 001TS 
002 Table of Contents 002TB 
004 Scope of Work 004SW 
006 Notes 006NT 
008 Quantities 008QS 
010 Basis of Estimate 010BE 
011 Data Tables (Concrete Pavement Repair Locations, Coring Data, 

Salvaged Base Summary, Earthwork Summary, Mass Diagram, etc) 
011DT 

020 General Details, Lift Station Details, Super Elevation Tables and 
Layouts 

020GD 

030 Typical Sections 030TP 
040 Removals 040RM 
050 Inlet & Manhole Summary,  Culvert Hydraulic Data 050IM 
051 Allowable Pipe List (Pipe Policy) 051AP 
055 Drainage Layouts (Separate Plan and Profile Sheets for Drainage 

Items, Use When PP Sheets too Crowded) 
055DL 

060 Plan & Profile 060PP 
070 Contours 070CT 
075 Wetlands, Mitigation and Environmental 075WL 
076 Temporary Sediment and Erosion Control 076TE 
077 Permanent Sediment and Erosion Control 077PE 
080 Layouts (Fencing, Curb Ramps and Miscellaneous Layouts) 080LO 
081 Survey Coordinate and Curve Data  081CD 
082 Survey Data Layouts 082SD 
085 Landscaping 085LS 
090 Paving Layouts 090PL 
100 Work Zone Traffic Control 100WZ 
110 Signing 110SN 
120 Marking 120MK 
130 Guardrail 130GR 
140 Lighting 140LT 
150 Signals 150SL 
160 ITS 160IT 
170 Bridges & Box Culverts 170BR 
175 Soil Boring Logs 175SB 
180 Pit Plats and Borrow Areas 180PT 
190 Haul Road Restrictions 190HR 
199 Tied Plans Not Contractually Requiring NDDOT CADD Standards 199TI 
200 Cross Sections 200XS 

 
Note, If Signing and Marking are on the same layout sheet use section 110-Signing 
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Information that is included in sections 040 Removals, 055 Drainage Layouts, 080 Layouts, 085 
Landscaping, and or 090 Paving Layouts can be included in section 060 Plan and Profile instead 
of segregating information in their respective drawings.  If the plan and profiles don’t have 
enough space to clearly communicate details, additional sections, such as 040, 055, 080, 085 and 
90 should be used. 
 
The “plot number” is used to organize drawings within a section (prefix) of the plans.  When plot 
numbers are used, they should start out at 001 for each section and increment up through the end 
of the section.  Plot numbers are used to organize sheets within a section.  They are not intended 
to be the sole tool to organize all the sheets within a plan plot set.  
 
For example, plan and profile sheets could be organized so that mainline plan and profile sheets 
are before side street plan and profile sheets.  A project may have 7 mainline plan and profile 
sheets and 4 side street plan and profile sheets.  The mainline sheets could be numbered 001 
through 007 and each specific side street sheet could be organized by the next plot number.  The 
sheet that directly precedes the mainline plan and profile sheet would be numbered 008, the next 
sheet would be numbered 009 and so on.  Note: the plot number should be named with three 
characters for sorting purposes.  Zeros should be used as place holders for plot numbers less than 
100.  The text “2” is after the text “002”.  The text “2” is also after the text “003”.   
 
Leading zeros should not be used in the sheet title block for section and page number. 
 
Plot numbers are not needed for drawings that are not directly used for plan plot sets.  They are 
optional for drawings that are directly used for a plan plot set if the full drawing name is 
sufficient to sort the names in the correct order.  Example: a drawing that is the only drawing 
within the section would not need a plot number.  A plan plot sets may not need a “plot number” 
for the “Scope of Work” sheet if it is the only sheet in the section.  There are no other sheets 
within the “Scope of Work” section to organize. 
 
The “suffix” part of the name is used to identify a sheet within a section by content.  For example 
there are many different types of Data and Table sheets. Several are in section 011.  However 
users need a suffix to distinguish by name the Coring Data Sheets from the Earthwork Summary 
Layout sheets.  For drawings that are not directly included in a plan plot set (a referenced 
drawing), the suffix part of the name is the same as the name of the drawing.  Example the 
drawing named TOPOG.dgn has a suffix that is the entire name. 
 
Suffix modifiers may be added after the suffix to give additional distinction to a standard 
drawing name.  Suffix modifiers are usually optional.  They are only mandatory for as-builts, 
addenda and change orders (see sections 7.1 and 7.4).  If used, they should be based on the 
information in the drawing.  Users are to use their discretion when creating a suffix modifier.  
Example, construction sign layout sheets may have suffix modifiers to indicate the phase and 
location.  The following drawing name is an acceptable standard name: 
100WZ_012_CS_Phase1EighthSt.dgn.  The suffix is CS and the suffix modifier is 
Phase1EighthSt.  Suffix modifiers can be used with any drawing name. 
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2.6 Configuration Setup 
April 2023 

 
The majority of NDDOT CADD standards are implemented at the “Organizational” level of 
configuration files and they are directed to the network at S:\STANDARD\CE11.  The 
following recommendations are for configuration setup. 
 

1. Make sure Bentley software is installed correctly and launches correctly without NDDOT 
standards loaded.  The CE11 folder is intended to support  

• OpenRoads Designer Connect Edition (ORD) 10.11 
• OpenBridge Designer Connect Edition (OBD) 10.11 
• MicroStation Connect Edition (MCE) 10.17  
• Bentley View (BV CE) 10.17   

 
2. Close Bentley CADD applications. 

 
3. Run the following batch file.   

S:\STANDARD\CE11\Install\Setup_local_workspace.bat 
 
Note, this batch file will adjust local files for both CE and V8i.  The V8i files are no 
longer detailed in this manual.   The V8i file work with standard files located in the 
S:\STANDARD\V8i folder. 

 
In summary the batch file does the following: 

• Creates a local user folder for user files that pertain to the NDDOT CADD 
Standards. 

o C:\NDDOT_CADD\s_drive\Support\users\%username%\ 
 BV CE 
 MicroStation CE 
 ORD 10.11 
 OBD 10.11 
 V8i 

If these files already exist, the batch file will not edit these folders and manual 
adjustments may be needed in this directory. 

• Installs the applicable configuration file  
[C:\ProgramData\Bentley\{application}\Configuration\ 
ConfigurationSetup.NDDOT] file.  By default, NDDOT standards are installed in 
the disabled mode. 

• Replaces Batch Tools (C:\NDDOT_CADD\Batch Tools).  This also updates the 
V8i tools. 
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4. Add the administrative “CADD” toolbar to the Windows taskbar.  This is done by right 
mouse button click pressing on the Windows taskbar.  Then select “Toolbars > New 
Toolbar”.  Then select C:\NDDOT_CADD\Batch Tools\CADD.  Use the “Select Folder” 
button to complete the selection.  Note the sub folders for multiple Bentley Applications. 
 

5. The CADD toolbar should now appear in the Windows taskbar.  There should be 
subfolders for installed CADD Applications. From applicable folder select “CADD 
Standards Toggle” to enable CADD Standards connection.  Each CADD application has 
an independent toggle.  Consultants can use the CADD Standard Toggle to quickly 
connect and disconnect the NDDOT CADD Standards. 

The following is an overview of what the CADD Standards Toggle does.  The toggle exchanges-
renames the following files; ConfigurationSetup.cfg, ConfigurationSetup.Default and 
ConfigurationSetup.NDDOT.  ORD configuration setup files are located at: 

C:\ProgramData\Bentley\OpenRoads Designer CE 10.11\Configuration\ 
 
There should only be 2 of these files on any computer for each CADD application.  The file 
extensions are changed based on the toggle.  The file with the cfg extension is the active file. 
The NDDOT version of this file points to NDDOT standards.  The Default version points to 
Bentley standards within the “C:\ProgramData\Bentley\OpenRoads Designer CE 10.11\ 
Configuration” folder. 
 

Additional Notes for Consultants 
Consultants are encouraged to connect to NDDOT standards like NDDOT staff connects. 
Other deployment methods are allowed, but they won’t typically be supported by NDDOT staff.    
If consultants use the same method, they might not need to review and/or adjust as many 
installation details as compared to a modified method.  The more a consultant administrator 
changes the installation method, the more they will need to review and/or adjust it on their own. 
Example, Consultants will need to manually review the batch file commands in step 3 above if 
they modify NDDOT standard paths. 
 
The NDDOT installation practices allow NDDOT CADD standards to be supported 
independently of other workspaces – other CADD standards.  The NDDOT CADD standards can 
easily be disabled and enabled.  Consultants can turn off NDDOT CADD standards when they 
need to work with other clients CADD standards. 
 
Consultants need to download NDDOT CADD resource files.  See the hyperlinks in section 2.2. 
Consultants need to Decide how end users should access the resource files.  They could be saved 
on local machine for each user or saved to a network location.  Saving resource files to a network 
location can be advantageous.  If multiple users are accessing the standards. Managing standards 
in one place is usually easier than managing them on multiple computers.  Move the standards to 
where you intend to manage and access them.  Be sure to keep the structure below the “CE10” 
folder the same as the NDDOT.  You can change parent folders but not the sub folder structure. 
Example the NDDOT uses “S:\STANDARD\CE11” but standards can be directed to other paths 
such as “X:\XXX\XXX\CE11”. 
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Consultants may need to edit the NDDOT version of the ConfigurationSetup file if they are not 
storing the NDDOT standards at S:\STANDARD\CE(XX).  This path should be edited to point 
to the NDDOT CADD standards folder.  If multiple CADD applications are used, multiple 
Configuration Setup files will need to be edited.  
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2.7 Preference Settings 
April 2023 

 
The NDDOT default preference are different from Bentley’s default preferences.  Each CADD 
application has a separate preference file, 

• C:\Users\%username%\AppData\Local\Bentley\View\10.0.0\prefs\Personal.upf 
• C:\Users\%username%\AppData\Local\Bentley\MicroStation\10.0.0\prefs\Personal.upf 
• C:\Users\%username%\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs\Personal.upf 
• C:\Users\%username%\AppData\Local\Bentley\OpenBridgeModeler\10.0.0\prefs\Personal.upf 

 
The NDDOT CADD Standards use a seed preference file.   This seed file can be used to set the 
NDDOT default preference.  Follow the next steps to reset NDDOT preferences. 

1. Make sure the NDDOT CADD standards are turned on for the applicable 
application. 

2. Exit the applicable CADD application. 
3. Delete the applicable “Personal.upf as noted in the paths above. 
4. Restart the applicable CADD application.  A new “Personal.upf” file should have 

been created from the NDDOT Seed. 
 
If you check your preferences from within the 
CADD application, you can see if you are 
using preference from the NDDOT seed file.  
The name for Preferences will show “NDDOT 
10.11 Preference”.  
 
 
 
The following table lists some NDDOT preference settings that are different from Bentley’s. 
These settings are recommended for the general user.  
 
 
 

Preference Name Description Setting 

Input>Allow ESC key 
to stop current 
command 

When the ESC key is selected, 
the current command is 
stopped and the default 
command is started. 

enabled 

Raster Manager > 
Default Raster 
Attributes  

Use Active Level 
 
Default level that rasters are 
attached to 

disabled 
 
Level = Raster Group 1 
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Raster Manager > 
Default Raster 
Attributes 

Set Geographic Coordinate 
System from Raster 

 
Raster Manager > 
Georeference (tab) > 
(as shown) 

These are some settings 
needed for working with raster 
images created by the 
Preliminary Surveys Section 
 
 
 
 
 
 
 
 

 
Reference > Set Default 
Attachment Preferences 
> Display Raster 
References 

When references are attached, 
they can also automatically 
attach the rasters that are 
attached to the reference. 

Disable 

View Options >  Element Highlight color 
 
Selection Set Color 

Yellow 
 
Yellow 
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Some preferences are stored in the preference file (upf) but are not changed through preference 
settings.  The following table lists some NDDOT preference settings that are different than the 
MicroStation default settings, but not edited in the preference dialog box. 
  

Preference Name Description Setting 

File > Tools > 
Compress Options 

Allow deletion of unused – 
empty parts of the dgn file 

All settings enabled 

AccuSnap Settings > 
Enable For Fence 
Create 

Allows AccuSnap while 
placing a fence. 

enable 

Within MicroStation 
Print Dialog Box – 
“Settings>Preferences> 
Allow Paper Size 
Editing 

This setting is needed to 
create custom plot sizes 
from roll plotters 

enable 

Within “Change 
Attributes” tool 

Defaults Use Active Attributes: On 
Level: On 
Color: On 
Style: On 
Weight: On 
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2.8 Local User Files 
April 2022 

Default Directories 
Many custom user files should be stored in subdirectories within 
“C:\NDDOT_CADD\s_drive\Support\users”.  A subdirectory named after your user name 
should have been created under this directory.  In this explanation “jcollado” is used.  But, 
everyone will have their own unique name.  CADD standards have been created to help you 
leverage this directory without having to adjust configuration files. 
The directory “c:\NDDOT_CADD\” has been structured the way it is for a couple reasons: 

1. Modified local CADD files are grouped together for easer management. This standard 
workspace area helps automate many user processes. 

2. Files are grouped for easier portability.  NDDOT CADD Standards and project 
information can be used locally, such as on a laptop –that is disconnected from the 
network.  See NDDOT CADD Standards for “Taking Electronic Drawings into the 
Field”. 

3. Files are grouped the way they are to copy some of Bentley’s default paths. 
4. Files are grouped the way they are to enable networked workspaces.  A very small 

group of users keep workspace settings under “s:\Support\Users\”.   Guidance for 
these users is not discussed in this reference. 

 

Cells 
If you put personal cell libraries in the cell directory 
(example, C:\NDDOT_CADD\s_drive\Support\ 
users\jcollado\MicroStation CE\cell), they will 
automatically be added to your cell list.  You should not 
have to search for your personal cell libraries.  
 
 
 
 
 
 
 
 
 
 
 

Interface (Tools and Ribbons) 
If you create a dgnlib for custom tools and ribbons for personal use, it should be stored in your 
GUI directory for each applicable CADD application (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\MicroStation CE\dgnlib\GUI\ 
jcollado.dgnlib).  Changes will be appended to the standards. 
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Function Keys 
If you create custom function keys, you should save your changes to the Interface subdirectory 
for the applicable CADD application and name the file after your user ID (Example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\MicroStation CE\Interface\jcollado.mnu)  
This file must be named using your user ID in order for it to be attached without editing 
configuration files. 

Accudraw Shortcut Keys 
If you edit Accudraw shortcut keys, you should save your changes to the Interface subdirectory 
for the applicable CADD application and name the file after your user ID and the appended 
“_shortcut.txt” (Example, C:\NDDOT_CADD\s_drive\Support\users\jcollado\MicroStation 
CE\Interface\ jcollado_keyboardshortcut.txt).  This file must be named using your user ID and 
the appended “_shortcut.txt” in order for it to be attached without editing configuration files. 

WMS Server List 
If you want to edit and use your own WMS Server List, copy the following: 
S:\STANDARD\CE10\Organization\Data\WmsServerList.xml, and pasted it in your user\data 
directory (Example, C:\NDDOT_CADD\s_drive\Support\users\jcollado\MicroStation CE\ 
Interface\jcollado_WmsServerList.xml). 
This file must be named using your user ID and the appended “_WmsServerList.xml” in order 
for it to be attached without editing configuration files. 

VBA Macros 
If you create personal VBA, you should save them to the VBA Folder (example, 
C:\NDDOT_CADD\s_drive\Support\users\jcollado\MicroStation CE\VBA\jdc_test.mvba).  This 
is the first place MicroStation will look for your macros. 
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2.9 NDDOT Custom Tools 
April 2023 

 
Most of the NDDOT Custom Tools can be accessed from a NDDOT custom workflow > Main 
(tab).   
 

 

DD Cell NDDOT 
This is a quick way of loading ddcell mdl and launching the NDDOT tool box for dimension 
driven cells. 

Level Symbology 
This tool is used for some typical level symbology overrides. 
 

Features > Set by Symbology 
This tool compares the level, color, weight, and style of elements.  If the symbology of the 
element matches the symbology of a certain feature, then feature properties are assigned to the 
element. There are 4 categories that can be processed. 

• Fence-Guardrail 
• Right of Way 
• Utilities 
• Wetlands 

 
Having graphics with the correct level, color, style and weight attributes is a prerequisite. 
Features are typically created from a 2D model.  A managed model with linked 3D Features will 
be created later in the workflow. Use the Macro to set the applicable feature definitions. This 
macro can take over a minute to process.   
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Tool Relationships 
This tool adjusts the NDDOT commands used in most NDDOT tools that work with symbology.   
 
Linear elements can have 1 of 4 following defaults. 

• Simple Lines Only 
• Simple Lines and Civil Features (ORD linear features if available) 
• Smart Lines Only 
• Smart Lines and and Civil Features (ORD linear features if available) 

 
Cell elements can 1 of 2 of the following defaults. 

• Cells Only 
• Cells and Civil Features (ORD point features if available) 

 
ORD users will have the full set of choices.  MicroStation users will not have options to use civil 
features. 

Attach Mosaics 
This tool is only available to NDDOT staff.  This tool gives you spatial hints to what aerial 
photos are available and help you quickly reference (attach) them to your drawing. 

Glossary 
This tool can be used to look up NDDOT abbreviations and send them to your clip board and 
MicroStation Text editor – Word Processor dialog. 

Survey VBA on Import 
This toggle switch enables a macro to place additional survey text on import. 

ITL File Copy 
This tool checks to see if you have the NDDOT.itl file in your working directory.  If this file is 
not in your working directory, it is copied there. 

Nudge Line Start Point 
ORD Linear features can’t be shapes or closed line strings.  This tool helps convert ArcMap 
shapes to ORD open line strings.  This tool edits closed line strings into a line string with a gap 
so that it can be turned into a linear feature. 

Pipe by 3D Line 
Draws 3D pipe by 3D Line.  See Appendix Q – Drawing Production Guidance – DS_Util 

Rotate Cells 
This works with ORD aligments to rotate cells.  It is provided in this menu for easier access.  It is 
used in the “XSG_Utility_Cell_as_Lines” workflow.  

Rotate Text 
This works with ORD alignments or MicroStation linework to rotate text and text nodes.  It is 

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixQ/Drawing_Production_Guidance.pdf
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provided in this menu for easier access.  

Shape to line with gap (Old V8i Tool) 
ORD Linear features can’t be shapes or closed line strings.  This tool helps convert ArcMap 
shapes to ORD open line strings.  This tool edits MicroStation shapes into a line string with a 
gap so that it can be turned into a wetland feature. 

Select Sub Set 
This tool can refine a selection set of lines by length and angle parameters. 

Steel Sections 
This tool places a steel section shapes. 
 

Applications 
Short cuts have been created to quickly turn on and off CADD related Applications such as 
AutoTurn, GuidSign, and QuickMap.  Note these applications will not work if they are not 
installed on your computer.   

Help 
This panel contains shortcuts to common help references. The ”Index Standard Files” tools is 
locate on the help panel under administration.   This tool compares the active CADD standards to 
an Index of posted CADD standards 
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2.10 WorkSpaces, Worksets and Roles  
April 2023 

There are 7 levels of Connect Edition configuration variables. 
1. System  
2. Application 
3. Organization 
4. WorkSpace 
5. WorkSet 
6. Role 
7. User 

This section will discuss how the NDDOT is applying the Organization, WorkSpace, WorkSet 
and Role levels.  Most of the NDDOT CADD Standards are being applied at the Organization 
level.  The WorkSpace level is being used for different work groups based on work place 
divisions and sections.  The WorkSet level is being used for specific NDDOT projects.   
These levels are part of a hierarchy tree system where; a specific Organization can contain 
multiple WorkSpaces but a Workspace belongs to only one Organization, and a specific 
WorkSpace can contain multiple Worksets but a Workset belongs to only one WorkSpace. 
 
The NDDOT uses 2 different grouping systems for CADD data, one based on specific NDDOT 
projects and one based on specific work groups such as survey, roadway design, traffic design, 
and bridge. Applying these groupings to the hierarchy tree system required that one grouping 
control the other.  The NDDOT uses very few project specific standards.  However, some work 
group standards are used at the NDDOT. These work group standards are usually applied 
consistently over different projects.  This is why the work group was prioritized over the project 
and this is why the WorkSpace level was used for the work group. 
 
The directories – folders used for Organization and WorkSpace level are self-described. 

S:\STANDARD\CE*\Organization 
S:\STANDARD\CE*\WorkSpaces 

 
The folder for the Workset is a little more complicated.  Under this hierarchal system there are 
many work group to NDDOT project combinations (example Project X for the Surveys and 
Project X for Bridge).  There are multiple Worksets for the same project.  There are separate 
directories for each of these Worksets.  The NDDOT stores CADD Data the opposite way the 
NDDOT applies CADD standards.  The NDDOT stores most project data first by project and 
then by work group (example, …\60002911.125\Survey\...).  On the other hand, the work group 
CADD standards are applied before project CADD standards (…\Survey\WorkSets\...). 
It is desirable to keep all project related data under one parent directory.  The NDDOT redirects 
all the different WorkSets used for the same project back into a single project folder. This folder 
structure is similar to previous (V8i) project folder structures (example, 
…\60002911.125\Survey\...).    
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The NDDOT uses a hybrid Workset structure.  In this hybrid system most of the WorkSet files 
are redirected, but there are 2 files for each workset that are not redirected.  The workset 
configuration file and workset properties file (*.cfg and *.dgnws) are stored at a different 
location. These 2 workset files are stored under a Workspace folder (example; 
S:\STANDARD\CE*\WorkSpaces\Design\WorkSets).  The configuration file will typically be 
created and edited by administrative staff.  The dgnws – properties file will be edited by CADD 
users and will be discussed in other areas of this document. 
 
The following is an example list of workset files and the workset directory for a specific project: 

S:\STANDARD\CE(XX)\WorkSpaces\Design\WorkSets\00000000.001.cfg 
S:\STANDARD\CE(XX)\WorkSpaces\Design\WorkSets\00000000.001.dgnws 
R:\project\00000000.001\... 

 
The WorkSpace and WorkSet are selected and applied from the Work Page during an ORD 
session. 

 
 
NDDOT staff will be able to select any WorkSpace\WorkSet combination stored on the NDDOT 
network, but they will only have write access to some of these combinations.   
WorkSpace\WorkSet edit capabilities are controlled by Active Directory network permission set 
by NDIT. 
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WorkSet Creation (internal NDDOT staff) 
1. Ask NDIT to create a project folder on the “R” drive with the applicable name and 

privileges (See section 2.4 Project Directories).  The project folder must exist before 
creating a WorkSet. 

2. Open the ORD application and access the Work Page (Page where WorkSpace and 
Workset are selected and created). 

3. Select the applicable WorkSpace for the workgroup (Division – Section).  Confirm that 
the WorkSet has not already been created. 

4. Create the new WorkSet.  The WorkSet name must be the same as the name of the parent 
project folder.  If the names don’t match the configuration variables won’t work 
correctly. 

5. Once the WorkSet is created,  review the workset  parent directory, 
“S:\STANDARD\CE*\WorkSpaces\ $(_USTN_WORKSPACENAME)\WorkSets\”.  
The Workset creation process should have created a subdirectory, cfg file and dgnws file.  
The subdirectory should be bypassed with NDDOT workflows.  Delete the subdirectory, 
named after the WorkSet, in order to avoid any future confusion on storage locations.  
The only files that should remain in the applicable WorkSets Folder are cfg and dgnws 
files.   
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2.11 CADD Standard Revisions (When to Use Old Standards).  
April 2022 

 
CADD Standards often change while users are in the middle of a project.  Productivity may be 
increased by switching to the new standard.  However, continuing to use the previous standards 
may be more convenient.   The previous or old CADD Standards can be used if all of the 
following occur: 
 

1. The active project is presently incorporating the previous CADD standard. 
2. Productivity, project uniformity, and/or plan readability are diminished by switching 

to the new standard. 
3. The previous or old CADD standard is not considered a primary standard. Certain 

CADD Standards revisions must be implemented immediately.  The following is a 
list of primary standards in which the most current version must be used: 
a. Title sheet changes. 
b. Standards needed to implement NDDOT software changes (example: 

OpenRoads Designer 10.11) 
 
When a new project is started the most current version of the CADD standards are to be used.  
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2.12 Global Protect  
April 2022 

 
There is an issue using Global Protect and CADD applications to connect to files on the R and S 
drives.  The mapped drives are usually connected with Global Protect, but they also need to be 
opened before opening the CADD application.  If the mapped drive is not opened before the 
CADD application is opened, the CADD application might not be able to find the applicable 
CADD standard files.  Click on the applicable drives in Windows file explore to make the red x 
on the drive icon go away before opening CADD Applications.  Drives with a red x icon may be 
connected but not opened.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This connection issue is also applicable to Axiom Users.  If the M drive connection is not opened 
before launching a CADD application, Axiom tools may not be accessible. 
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2.13 Virtual (Local) Drives  
April 2022 

 
Virtual drives are a way to temporarily map a drive letter to a specific folder.  Virtual drives can 
be used in case where the CADD network is not accessible or access is slow.  One example is 
using a laptop in the field. Field computers are not typically connected to the network (CADD 
Servers).   
 
Several important resource files are stored on the network and if computers cannot find these 
resources they will not operate correctly.  Some reference and raster files use a specific (full) 
path.  These reference and raster files may not be properly attached when they are moved off the 
network (“R” drive).  The following procedure discusses a method of copying and mapping 
resource files to a computer that is not networked or will not be networked when CADD tools 
and files are needed.  
 
This procedure involves: 

1. Copying the resource files to “C” drive. These files must be stored in a specific 
location. 

2. Copying the needed project drawings and files to “C” drive. These files must be 
stored in a specific location. 

3. Learning to use the appropriate batch file - shortcuts.  These shortcuts maps the 
resource files and project files in a manner that is similar to the way the files are 
mapped on the network.  The shortcut creates a local “S” and “R” drive. 

4. Updating resource files and project files as needed (as they change). 
 
 
Step 1 can be accomplished by running a batch file or manually copying files.  Running the batch 
file is the preferred method. The computer must temporarily be connected to the network (“S” 
drive).  After the computer is connected to the network, double click on the batch file 
S:\STANDARD\CE11\Install\CopyStandardsLocal.bat.  This file will copy the needed files 
locally (on the computer’s hard drive) to the directory 
“C:\NDDOT_CADD\s_drive\STANDARD”.   
 
Step 2 involves copying the project files needed for field work.  CADD project files are stored on 
the “R” drive.  Files should be copied from “R:\project\*.*” to 
“C:\NDDOT_CADD\r_drive\project\*.*”.  Similar - relative paths should be used when files are 
copied.  Example: if the file R:\project\10083088.059\Design\Design.dgn is going to be taken 
into the field, it should be copied to 
C:\NDDOT_CADD\r_drive\project\10083088.059\Design\Design.dgn. 
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Step 3 uses a batch file to temporarily create “S” and or “R” drives on your computer and start 
MicroStation.  Caution, local “S” and or “R” drives cannot be created if networked “S” and or 
“R” drives are already connected.  Make sure your computer is disconnected from the network R 
and S drive before proceeding with step 3.  The batch files for Drives and Mapping can be 
accessed through the CADD Administrative tools within the “Other” folder. 
 

  
 
 
 
 
 
 
 
 
 
 
The Swap_r_drive and Swap_s_drive batch files can be used to map the applicable virtual drives.  
The batch files run a “Command Prompt” script, typically in a black dialog box.  A new path 
“S:\” will be created.  The files in C:\ NDDOT_CADD\s_drive and S:\ will be the exact same 
files.  They will just have different paths.  The local “R” drive will have a similar relation to C:\ 
NDDOT_CADD\r_drive. 
 
 
Step 4 is to remember to update the standard resource files on “C” drive as needed.  This should 
be done at least seasonally.  To do this, just repeat step 1.  Project files should also be updated on 
the “R” drive as required.  The “R” drive is the official location to save project CADD files. 
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2.14 Final Plan Delivery  
April 2023 

 
The “Final Plan Delivery” includes several products such as production drawings, resource files, 
supplemental design data, and pdf plan sets. Some requirements are provided in this section.  
Additional requirements are also listed in the “Scope of Work for Consultants Performing 
Preliminary Highway Surveys” and in other areas of the Design Manual. 
 

1. Production Drawings – These files are typically MicroStation Drawings (dgn).  
Production Drawings are required on projects under a direct contract with the 
NDDOT. 

 
2. Resource Files - These files are not directly used in the plans but are used to design 

projects or can be used to help build a project.  Modeling files (itl, xml) are examples 
of resource files.   

 
3. Supplemental Design Data – These files include a subset of production drawings and 

resource files.  This subset of files excludes data that isn’t directly applicable to 
construction. Supplemental design data has an emphasis on Automated Machine 
Guidance workflows.   
 

4. PDF Plan Sets – PDF’s (portable document format) are required on all projects.  
 

Printed plan sheets are not required on digital signature pilot projects.  
 
The “Final Plan Delivery” shall not include copies of the correspondence documents and 
preliminary reports.  If the NDDOT Technical Support Contact person requests additional copies 
of the correspondence documents and preliminary reports, this information should be sent in 
separately. 
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Production Drawings 
Production drawings shall follow the NDDOT CADD Standards.  They shall be developed with 
Bentley CADD applications. 
  
Conceptual production (dgn) drawings should be delivered when the project is being developed 
by a consultant that is only responsible for developing the environmental document.  If the same 
consultant is responsible for developing the final plans, most conceptual production (dgn) 
drawings should not be submitted.  Drawings that are displayed for the public (environmental 
documents, public input meetings and hearings) are exceptions to this rule. Keep records of 
drawings that were displayed for the public according to the Design Manual (see II.03.02.04 
Public Involvement Report). 
 
Production drawings shall only include files required for the development of the final plans. All 
of the conceptual drawings are seldom desired (see above paragraph).  The Production files shall 
only include the essential (CADD Standard) files.  Temporary, junk, alternative drawings not 
used in the final plans, backups, and other interim drawings shall not be submitted.  The goal is 
to make it easy to review the project files and avoid the transmittal and storage of unnecessary 
files. 
 
Drawing display setting (levels, reference files, view attributes and other rendering settings) shall 
be set and saved as they were used to create the final printed plans.  The goal is to make it easy 
to review and print files.  The reviewer should not have to figure out what reference files need to 
be turned on and what display settings need to be used. 
 
Consultants should use the directory structure discussed in section 2.4 and they should use the 
“Save Relative Path” when referencing drawings.  The goal is to make project files portable.  
Broken reference paths are CADD standards violations. 
 
Production drawings should be set to read only before the plans are signed and stamped as 
required by the Board of Professional Engineers and Land Surveyors.  The goal is to use the file 
modify date to flag and eliminate changes to the plans after they have been signed. 
 

Resource File  
Resource Files and Supplemental Design Data are required on projects under a direct contract 
with the NDDOT and that require substantial earthwork.  Projects that don’t involve earthwork 
(grading) will not require resource files to be delivered with the plans. 
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Supplemental Design Data 
Supplemental Design Data is provided to the contractor in order to help them prepare a bid and 
construct the project.  Supplemental Design Data includes AMG (Automated Machine Guidance) 
data such as surface files.   
 
Since supplemental design data includes a subset of production drawings and resource files, the 
applicable files should be copied into a “Supplemental Design Data” folder under either the 
Design project folder or Consultant project folder. 
 
Supplemental Design Data includes the following; 
 

1. Supplemental Design Data Notification  
2. Surface Files 
3. AMG AAreadme file for contractor 
4. Earthwork_End_Area Volumes Spread Sheet 
5. Drawings 

 
The following is an example list of file to provide as supplemental design data. 
 
Supplemental Design Data.pdf 
AAReadMe.docx 
Alignment.xml 
Terrain_Exst.xml 
Terrain_T.xml 
Terrain_B1.xml 
Terrain_DG.xml 
Terrain_Exst.dgn 
Terrain_T.dgn 
Terrain_B1.dgn 
Terrain_DG.dgn 

Earthwork_Volumes.html 
Earthwork_Volumes.xslx 
Earthwork_Cut-Fill_Volumes.dgn 
Control.dgn 
Design.dgn 
DS_Align.dgn 
RW_Bndry.dgn 
Topog.dgn 
200XS.dgn 
RDM.dgn

 

Supplemental Design Data Notification 
See the following: 
http://www.dot.nd.gov/manuals/design/caddmanual/SDD/Posting%20Supplemental%20Design%20Data.pdf 
 
Consultant staff only need to create the notification pdf.  Technical support staff will post the 
actual documents. 

Surface Files 
Surface files are provided to the contractor as MicroStation terrain elements and xml files. 

Alignment Information 
Alignment Information is provided to the contractor as MicroStation civil geometry elements and 
xml files.   

http://www.dot.nd.gov/manuals/design/caddmanual/SDD/Posting%20Supplemental%20Design%20Data.pdf
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Drawings Provided to Contractor 
The following drawings should be provided to the contractor if available.   These drawings do 
not need to be created if they are not needed for plan preparation.  

1. Control 
2. Design 
3. DS_Align 
4. Earthwork_Cut-Fill_Volumes 
5. RW_Bndry 
6. Terrain_T 
7. Terrain_B1 
8. Terrain_DG 
9. Terrain_Exst 
10. Topog 
11. 200XS_* 
12. RDM 

 

Supplemental Design Data AAreadme file for Contractor. 
An informational text file shall be provided to the contractor.  This AAredme file should include 
the following information as a minimum. 

• Alignment Key (description information, see section 5.3)  
• Modeling Limitations 

o The aareadme file should also describe general limitations with the model 
(examples; driveways were not modeled, the terrain near bridge XYZ was not 
modeled, approaches were modeled without the appropriate in-slopes – use plan 
information to build approaches, etc).  Include the following phrase. 
 “This aareadme file does not list all limitations with the model.  It is only 

provided as a place to start your review.  The contractor is responsible for 
reviewing model information and determining if and where it may be 
applicable.” 

• CADD Standard Overview for Contractors (Include link to Appendix J) 
• List Non-Standard Files (not described in Appendix J) that are included in Supplemental 

Design Data. 
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PDF Plan Sets 

Sheet Size 
The paper size format for the pdf must match requirements for paper delivery (example, plan 
sheet intended to be printed on 11x17 inch paper should be formatted to be printed on 11x17 
inch paper).  PDF’s should be created at 600 dpi.  Supplemental images - Rasters may be printed 
at a lower resolution.   
 
The overall electronic files size of the PDF plan set is a concern.  There may be problems 
downloading very large pdf files.  

File Size and Volumes 
PDF files used for electronic distribution (posted on internet for bidding purposes) shall be less 
than 300 MB. If needed, divide the plan set into separate volumes to avoid individual files over 
this limit.  The individual sections, as defined by section numbers, shall not be split between 
volumes.  The volumes may be spilt where the section numbers change.  Designers shall use 
their discretion when deciding where the splits occur. 
  
Cross Sections are typically published as a separate volume.  
 
Separate volumes are not required for other phases of project development such as PS&E review 
or the original digital signature version of plans. 
 
The PDF shall be optimized with Adobe Professional.  Most NDDOT Plan Sets are less than 300 
MB if optimized correctly. 
 
Please notify a CADD standard representative if a plan set exceeds 300 MB. 

PDF Optimizer 
The “PDF Optimizer” tool usually reduces the file sizes.  The following is an overview of the 
Optimizer Settings. 

 
The “PDF Optimizer” tool is found in the Adobe Acrobat Pro menu under “Save As Other> 
Optimized PDF”.  Optimizing a file can take several minutes.  Copy the pdf to a local drive 
before using the “PDF Optimizer” tool in order to improve performance. 
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The standard-default 
“Images” settings should 
be used.   
 
In the Fonts category, 
“Do not unembed any 
font”.  Fonts must be 
embedded within the 
PDF. 
 
 
 
 
Optimization settings for 
“Transparency” aren’t 
enabled. 
 
 
 
 
 
 
 
 
Discard Object Settings 
are as shown.  
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Discard User Data 
Settings are as shown.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The standard-default 
“Clean Up” settings 
should be used.  
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PDF File Names 
The pdf plan set files must be named according to a standard naming convention.  PDF files 
should be named by combining, in the order shown, the following information: 

1. “Project Number”  
a.  If the plan set includes multiple project numbers (multiple project numbers 

shown on title sheet) the project numbers should be included in the name 
separated by a space character, “and” (text), and another space character 
(example: “SS-3-001(015)128 and SS-3-020(071)044 Final Plans 1of3 
ED.pdf”).  The space characters are needed for the proper word wrapping 
when the document gets posted on the web. 

b. If naming the pdf using multiple project numbers will create a very long name 
(over 100 characters long), then only the first project number listed on the title 
sheet should be used follow by the phrase “and Other Projects” (example: 
“STM-SU-1-988(024)036 and Other Projects Final Plans 1of2 ED.pdf”). 

2. Project phase such as 
a. Preliminary 
b. PS&E – Use The suffix “PSE”.    The character “&” will cause complications 

on an Adobe Shared Review. 
c. “Final Plans” 
d. Addendum1,  Addendum2, etc – Use the suffix “AD1”, “AD2”, etc 
e. Change Order1,  Change Order 2, etc – Use the suffix “CO1”, “CO2”, etc 
f. Asbuilt – Use the Suffix “AB” 

3. The specific volume number and total number of volumes shall be included in the file 
names (example “1of3”).  Every volume shall be counted, including cross sections 
and standard drawings.  The volume suffix is only required for final plans used for 
bidding purposes (electron distribution version).  

4. If the project requires cross sections, they must be included as a segregated file.  The 
file name for cross sections shall include the abbreviation “XSEC”. 

5.  “Color” if the plan set is in color.  All other sets will be assumed “black and white”. 
6. “ED” (for electronic distribution) or “DS” (for Profession Engineer signing and 

stamping using Digital Signatures). 
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The following is a list of example names. 
 

IM-2-094(070)275_Preliminary  
IM-2-094(070)275_PSE  
IM-2-094(070)275_ED_Final Plans_#of# 
IM-2-094(070)275_ED_Final Plans #of# XSEC  
IM-2-094(070)275_DS_Final Plans  
IM-2-094(070)275_ED_AD1 
IM-2-094(070)275_DS_AD1 
IM-2-094(070)275_ED_AD2 
IM-2-094(070)275_DS_AD2 
IM-2-094(070)275_ED_CO1 
IM-2-094(070)275_DS_CO1 
IM-2-094(070)275_ED_CO2 
IM-2-094(070)275_DS_CO2 
IM-2-094(070)275_AB 
 
(Replace # with actual numbers, example 1of3) 

 
At this time, color final plans are not posted on the internet for bidding purposes.  They may be 
used by field personnel as an added convenience.  A Black and white version of the PDF Final 
Plans and Addendums shall be used for the internet. 
 
Optically scanning the original paper plan set in order to create a pdf plan set is discouraged 
because the image quality is degraded.  
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2.15 Plan Submittal and Distribution 
April 2022 

 
Refer to the Design Manual for information on Plan Submittal and Distribution; 
  
Digital Signatures for Plan Production Using DocuSign 
https://www.dot.nd.gov/manuals/design/caddmanual/DigitalSignatures/Plan%20Production%20
Using%20DocuSign.pdf 
 
Plan Review Distribution List 
http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.
pdf 
 
I-08.03 Final Plan Submittal 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=109 
 
 
I-09 Plan Revisions and Change Orders 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=119 
 
 
I-11 Cost Estimates, Bid Items and Incidental Work 
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=127 
 
 
 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/DigitalSignatures/Plan%20Production%20Using%20DocuSign.pdf
https://www.dot.nd.gov/manuals/design/caddmanual/DigitalSignatures/Plan%20Production%20Using%20DocuSign.pdf
http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.pdf
http://www.dot.nd.gov/manuals/design/designmanual/Plan%20Review%20Distribution%20List.pdf
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=109
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=119
http://www.dot.nd.gov/manuals/design/designmanual/Chapter%201.pdf#page=127
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2.16 AAREADME File for Survey Folder 
April 2023 

 
The project “Survey” folder should have an AAREADME file in it.  The AAREADME file 
should be a Microsoft Word file that helps users find data within a project folder.  This file is 
simply a text file that describes the folder contents. 
 
All AAREADME files should contain: 

1. Directory being described. 
2. Project Number(s) 
3. PCN Number 
4. County Name 
5. Brief Project Description 
6. If a project was abandoned or shelved, a history of what was designed should be 

detailed. 
7. Names of staff who worked on the files within the directory.  
8. File Index 

a. File Name 
b. Progress  
c. Description 

9. Journal (in paragraph format) 
It might include a dated description of how the data was collected, where it came 
from, or what needs to be done in the future.  Each entry should be dated and the 
author should attach their name to the information in case someone has questions.   
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Example for a Survey Folder 
 
R:\project\70002091.065\SURVEY\EFB> 
NH-7-002(065)091 
PCN 14794 
Reconstruction, Palermo Section, Stanley, east 10 miles 
Mountrail County 
 
081CD_001.dgn    98% Curve and Coordinate data sheet 
AAreadme.docx    N/A Project Journal 
Control.dgn    98% Alignment and boundary graphics  
DTM.dgn    100% Digital Terrain graphics 
Terrain_Exst.dgn    100% Terrain with US 2 profile 
Terrain_Exst_Alt.dgn    100% Terrain includes alternate graphics 
Topog.dgn    95% Utility and topographic graphics 
 
18 March ’22  [J. Doe]..…  Tammy Doe e-mailed in five (5) .dat files, and an excel file with the 
observation of the station information.  These data files are the GPS observations of the control 
points for the above said project.  I sent these .dat files into the NGS OPUS processing center 
and received back the OPUS derived coordinates.  The dat files and opus results (*.doc) 
documents can be found under …. 
 
25 March ’22  [E-mail from ABC engineering] 
Good morning John, 
We have completed the first segment, project number PCN14794. There are several things to 
note. I changed the point numbers of the targets we discussed last week. Point numbers 312 and 
313 had already been used for … Tioga and heads east next week. Thanks for all your help. 
 
Tim Smith, ABC Engineering 
(701)555-1234 
 
30 March ’22  [J. Doe]..…  The editing for this project is almost complete. I provided a set of 
questions for the survey field crew. When the questions are answered we should be able to 
transmit this project.  
  



CADD Standards 
 

2.17 Directory Cleaning 
April 2022 

 
CADD Files should be cleaned (organized and purged) regularly during project development.  
Some CADD files should also be purged after the following milestones: 
 

1. Final Plans Have Been Submitted 
2. Final Construction Records Have Been Completed (including as-built drawings) 
3. Three Years After Project Completion – Final Construction Records Have Been 

Completed. 
 
Preliminary files that were only used for conceptual planning, like environmental documents, 
should be kept through the design phase.  The main environmental document should be stored on 
FileNet.  However, most conceptual planning documents on the r: drive should be purged after 
the Final Plans Have Been Submitted for construction.   
 
Microsoft Word and other word processing documents should also be purged after the Final 
Plans Have Been Submitted for construction.  Only documents that directly support the plans, 
like plan notes, should be archived in the project directory.  Other documents such as 
correspondence and reports should be in FileNet.  These documents should not be archived with 
the project directory. 
 
The only conceptual drawings that should be kept after the final plans have been submitted are 
drawings that were displayed at a public meeting.  Drawings displayed at public meetings should 
be kept until Three Years After Project Completion and then discarded.  Drawings displayed 
at public meetings should be grouped in a project sub directory for easy identification and 
protection (example r:\project\30002269.080\DESIGN\Public Hearing\).  Remember that 
drawings displayed at public meetings should not be edited after the meeting.  You must keep an 
unedited version of the drawings (including reference files).  All files stored in a directory named 
like “Public Meeting”, “Public Input”, “Public Hearing” or “Public Information” will be deleted 
three years after the project is completed. 
 
After the Final Plans Have Been Submitted, the only files that should be in the design folder 
are files that directly support the final plans.   Temporary files and files detailing alternates that 
were not advanced should be deleted after the final plans have been submitted.  Alternates or 
options advanced as part of the plans (bidding options like a steel bridge vs. a concrete bridge) 
should be archived. 
 
After the final plans have been completed, the pdf plan set for preliminary review and PS&E 
review should be deleted.  The PS&E review version of plans with archived Adobe shared 
review comments should be stored in FileNet.   
 
Consultants submitting final plans should clean the project directory before the electronic files 
for final plan submittal are packaged and delivered to the NDDOT. 
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MicroStation 
 

3.1 Seed Files  
April 2023 

 
Seed files are used to set several DGN file parameters.  When a creating a new DGN, the correct 
seed file needs to be selected.  Presently the NDDOT is using 4 different seed files; 

1. NDDOT_seed.dgn 
2. NDDOT_seed_Ft&In.dgn 
3. NDDOT_seed_Photog2D.dgn 
4. NDDOT_seed_3D.dgn 
5. NDDOT_seed_Photog3D.dgn 
6. NDDOT_seed_GuideSIGN.dgn 

 
The following are some of the features adjusted in the NDDOT seed files. 
 

 Design File Settings 
Angle Readout 
Only Applicable to 

• NDDOT_seed.dgn 
• NDDOT_seed_3D.dgn 
• NDDOT_seed_Ft&In.dgn 
• NDDOT_seed_GuideSIGN.dgn 

DD MM SS 
Accuracy 0.1 
Bearing 

Angle Readout 
Only Applicable to 

• NDDOT_seed_Photog.dgn 
• NDDOT_seed_Photog3D.dgn 

DD MM SS 
Accuracy 0 (no decimal) 
Bearing 

Color   Element Highlight Color: Yellow  
Selection Set Color: Yellow 

Civil Formatting Coordinate Settings 
  Format  X,Y 
  Precision  0.12 
Ration Settings 
  Format  D:1 
  Precision  0.12 
Station Settings 
  Format  sss+ss.ss 
  Format Delimiter  + 
  Precision  0.12 
  Equation By Index 
Radius Settings 
  Degree of Curve Method Arc 
  Degree of Curve Length 100’ 
  Radius Toggle Char d 
Profile Settings 
  Elevation Precision 0.12 
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  Slope Format Percentage 
  Slope Precision 0.12 
  Ratio Format Run:Rise 
  Ratio Precision 0.1 
  Vertical Curve Parameter Format K=L/(G2-G1) 

Locks Level Lock: Off 
Graphic Group: Off 

Snaps Snap Lock: On 
Mode: Keypoint 
Divisor: 2 
Association: On 

Working Units > Linear Units 
Only Applicable to 

• NDDOT_seed.dgn 
• NDDOT_seed_3D.dgn 

Format = MU 
Master Unit = Feet (Label = ‘) 
Sub Unit = Custom (Label = th) (1000 th = 1 feet) 
Accuracy 0.1234 

Working Units > Linear Units 
Only Applicable to 

• NDDOT_seed_Ft&In.dgn 
• NDDOT_seed_GuideSIGN.dgn 

Format = MU:SU 
Master Unit = Feet (Label = ‘) 
Sub Unit = Inches (Label = “) 
Accuracy 0.1234 

Working Units > Linear Units 
Only Applicable to 

• NDDOT_seed_Photog.dgn 
• NDDOT_seed_Photog3d.dgn 

Format = MU 
Master Unit = Feet (Label = ‘) 
Sub Unit = Custom (Label = th) (1000 th = 1 feet) 
Accuracy 0.12 

Working Units > Advanced Settings  Resolution = 304800 per Foot 
Solids Area = 10 Miles 

 Other Design File Settings 
View Attributes ACS Triad: Off 

Clip Volume: Off 
Data Fields: On 
Fill: On 
Grid: Off 

“Place Note” tool Start at “Terminator” 
“Scaling” tool Scale Dimension Values: Off 

Scale Annotations: On 
Model Properties > Line Style Scale Annotation Scale 
Only Applicable to 

• NDDOT_seed_GuideSIGN.dgn 
Embedded Text Style: TSText 
Zoom Adjusted Closer to 0,0 
Annotation Scale Toggle: Off 

Default Drawing Scale 
Only Applicable to 

• NDDOT_seed.dgn 
• NDDOT_seed_3D.dgn 

1” = 200’ 

Default Drawing Scale 
Only Applicable to 

• NDDOT_seed_Ft&In.dgn 
• NDDOT_seed_GuideSIGN.dgn 

1” = 5’ 

Only Applicable to 
• NDDOT_seed_Photog.dgn 
• NDDOT_seed_Photog3d.dgn 

The Level Filter Used was set to default. 
The standard Survey level filters were imported. 
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3.2 Global Origins 
April 2022 

 
Drawings created with very old CADD standards seed files may have used a Global Origin other 
than 0,0,0.  All current drawings should leave the Global Origin at the 0,0,0 value. 
 
The global origin in a MicroStation design file will not need to be changed if referencing is done 
with the “Coincident –World” option.  This option has been set as the default in the NDDOT 
Standards and will automatically be selected for most users. 
 
If this option is not used and the active file has a different global origin than the reference file, 
the data may appear to reference into the active file correctly, but the coordinate values of the 
referenced data may change!  
 
To check the existing global origin of a file, key ‘GO=?’ into the key-in box. The value will 
appear in the bottom right-hand corner of the screen.  Do not key in any other GO commands - 
except ‘GO=?’, the coordinate values of existing points in the design file could change! 
 

3.3 Coordinate Systems 
April 2022 

 
When creating a new plan view drawing, assumed drawing coordinates should be avoided.   Plan 
view drawing elements should be drawn as close to real ground coordinates as survey data 
allows.  Using real ground coordinates will help with the exchange and comparison of data with 
other sources (example; wetland delineations can be compared to all plan view drawings if real 
ground coordinates are used, GIS data can easily be imported into MicroStation). 
 
If real ground coordinate survey information is not readily available for projects such as ones 
that use 90-1 surveys, spatially correct base maps should be used to get reasonably close to real 
ground coordinates. MicroStation base maps can be referenced from the directory 
R:\project\BaseMaps\. Each county has its own base map because each county has a slightly 
different projection. Highway centerlines, Mile Points, and Section lines are some of the drawing 
features that can be used to tie plan information to real ground coordinates. The base maps are 
exported into MicroStation with a high degree of accuracy, but the accuracy of the GIS data 
varies considerably. Users should be conscience of the degree of accuracy when comparing 
information. Just because information is very close doesn’t always mean it is acceptable.   
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3.4 Symbology 
April 2022 

 
Symbology is the study of symbols. CADD Symbology is the representation of real-world 
elements in a CADD environment.  These representations includes both graphical and non-
graphical properties.  Color, line weight, and line style are examples of graphical symbology.   
Level and display class are examples of non-graphical symbology. 
 
Symbology (properties) management is a large part of CADD standards.  There are many tools to 
manage and use CADD symbology. Understanding the tools that manage symbology can 
simplify the application of symbology.  Example, you might not need to know all the properties 
for a concrete line if you understand the tools to draw the edge of concrete. 
 
Sometimes it is helpful to take a backward approach to learning about CADD standards.  Instead 
of starting with the fundamentals of symbology (properties), it may be easier to learn where 
tools are located, why they were organized the way they were, how to use the tools, and finally 
what do the tools produce (elements of a particular symbology). 
 
“Where” will be discussed with the section on “Workflows, Ribbons and Task Groups”. 
“Why” is partly discussed with the sections on “Named Expressions”, but “why” is usually for a 
specific work product. 
“How” and “What” will be discussed with the sections on Level, Line Styles, Cells, Annotation 
and Dimensioning.   
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3.5 Workflows, Ribbons and Task Groups 
April 2022 

 
• Workflows are containers for Tabs. 
• Tabs are containers for Ribbons. 
• Ribbons are containers for Panels. 
• Panels are containers for tools. 
• Task groups are also containers for tools.  Task groups are containers independent of 

Workflows, Ribbons, and Panels.   
 

 
 
The NDDOT uses many custom workflows. The various Bentley applications also include 
default workflow.  Some of the NDDOT workflows are always visible while others are only 
visible when certain drawing names are active.  The following are some NDDOT custom 
workflows that are always visible. 

• Bridge 
• Design 
• Materials 
• Photo (Preliminary Surveys and Right of Way) 

 
Note there are several traffic workflows that will be discussed in the “Named Expressions” 
section of this manual. 
 
Each workflow displays a set of tabs, and each tab is associated to a 
ribbon. Ribbons contain panels that are used to organize tools. The 
name of the panel is displayed at the bottom of the panel (example, 
Linear). Note the little triangles near the tool icons or tool lables.  
These triangles are split or drop-down butttons that contain additonal 
tools.  Click the triangle to see and select from these additonal tool. 
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The task groups dialog box is not displayed by 
default.  The dialog can be turned on through the 
“Select V8i Mode” button near the workflows menu.  
 

 
 
 
 
 
 
 
 
There are numerous Task groups.  Some are delivered 
with MicroStation, other groups have been created by 
the CADD standards.   
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3.6 Tool Organization and Named Expressions 
April 2022 

 
Most NDDOT custom ribbons and task groups are organized to draw specific elements in a 
specific drawing or group of drawings.  This organization promotes drawing with the correct 
standard in the correct drawing.  For example, existing power poles are found in the Topog 
ribbon or task group and they should be drawn in the file named Topog.dgn.  Several ribbons and 
task groups are intended for only one particular type of drawing.  Some ribbons and task groups 
are intended for a group of drawings.  Appendix A explains which ribbons and task groups are 
used with which drawings.   
 
The standard NDDOT interface hides some workflows, ribbons and task groups based on the 
active drawing name.  The standard interface makes it easier to pick the appropriate group of 
tools while promoting the use of standard drawing names. For example; to display the Topog 
task group, the active drawing typically needs to have a name starting out with the word 
“Topog”.  If you were in a drawing named “Design.dgn” you would not typically be able to see 
the Topog task group.  The hiding of workflows, ribbons and task groups uses a function called 
“Named Expressions”. 
 
Most of the NDDOT custom ribbons and tools are setup with similar tool.  Example the “topog” 
ribbon contains most of same tools as the “topog” task group. The custom ribbons tend to 
include additional common tools such as a Main, Drawing and Utilities panels. While task 
groups have a main task toolset. 
 
Task groups can be organized in a directory structure with parent child relationships.  For 
example the Topog task group is found under the Photo task.  The Photo task is the parent task 
and the Topog task is the child task.  The next page lists standard task group parent child 
relationships. 
 
 
 

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixA.pdf
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Bridge Work Flow 
Section 170  

 
Design  

001TS Title 
004SW Scope 
011DT Data Tables 
020GD Details 
030TP Typical 
100WZ_ConSign 
AutoTurn 
Consign 
Countour 
Cut Sheets Design  
Design 
DS Align 
DS Util 
DTM 
Environmental 
Fencing 
Paving 
Profile 
Removal 
P_Erosion_C 
T_Erosion_C 
Shape 
Wetland Impacts 
Xsec 

 
Materials 

Materials 
180PT_PitPlat 

 
Photo 

081CD_Survey 
Control 
RW Bndry 
Topog 
DTM 

 
Planning 

Planning 
 
 
 
 

Traffic Work Flow 
 Section 100 

ConSign 
CSDtl 
DTmpLtDe 
LTmpLt 
DIntDe 
Lint 

Section 110 
DOHDet 
DSignDet 
LOH 
LRemSign 
LSign 

 Section 120 
LPvmt 
DPvmtDet 

 Section 130 
LGdrl 
LJBar 
GdrlDe 
DBarrier 

Section 140 
DHMDet 
DLitDe 
DLitOH 
DULDet 
LHM 
LLight 
LLitOH 
LUL 

Section 150 
DFlsh 
DIntDe 
DSigDet 
DATRDet 
LFlsh 
LInt 
LRemSgl 
LScop 
LSgnl 
LATR 

Section 160 
DITSDet 
LITS 
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3.7 Element Templates 
April 2022 

 
Element templates manage symbology.  Element templates associate many different properties 
for a specific CADD element.  The template can be used to apply these different properties a one 
time.  There may be times when a CADD user needs to access an element template directly, but 
usually templates are used indirectly through other tools. 
 
Tools often reference the symbology in a template.  Tools also offer some additional control of 
symbology that might not be available in the template.   
 
NDDOT custom tools simplify the placement of most drawing elements.  These tools are used to 
change several settings at one time while executing commands.  Example; the level, color, line 
weight and style, text height and width and justification could all be switched and the place text 
tool could all be activated with one click of a button. 
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3.8 Levels  
April 2022 

 
Many levels are named with the noun first and then the adjectives, example “Pole Wood Cell 
Exst”.  Abbreviations are often used.  The “Exst” (Existing) adjective is used at the end of level 
names when applicable. Level names without the “Exst” adjective are intended to indicate an 
undefined or proposed state of presence. 
 
Levels have been set up for specific pay items.  The names and descriptions for these levels are 
based on the pay item spec-code number and description, example “722-3690 INLET SPECIAL 
42IN” 
 
Level descriptions are similar to level names except the “Exst” adjective, when used, is first and 
the element type is not used, example “Exst Pole Wood”. 
 
Level numbers have been set up as an identification number.  The digits in the number represent 
attributes of the items on that level.  Most standard levels are numbered from 1,000,000,000 to 
4,294,967,294. The numbering system is as follows: “A,BCC,CDD,DDE” 
 
A – 1 digit – Type of element  

1= Points, Lines, Curves, and shapes 2=Cells, 3=Text and Dimensions, 4=Patterns 
B – 1 digit – Presence 
 0=Undefined, 1=Existing, 2=Proposed 
C – 3 digits – Closest NDDOT Specification Number 
 Some CADD specific specifications have been added. 
D - 4 digits – Subsection or NDDOT Code. 
 When used as subsection it helps ensure uniqueness. 
E – 1 digit – Pay Item Use 
 0=No, 1=Yes 
 
Notes 

• The maximum level number is 2^32-2= 4,294,967,294. 
• Component names are usually based on the level names except that the element type is 

not used in the component name. 
• Special levels have been set up for raster attachments. 

Level Name   Level Number 
“Raster Group 1”                              101 
“Raster Group 2”                              102 
“Raster Group 3”                              103 

Rasters should be attached to the level named “Raster Group 1”.   The levels “Raster 
Group 2” and “Raster Group 3” can also be used if you desire to stratify rasters by level.   
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Level Libraries 
The level information is stored in drawing libraries (dgnlib) files.  Most levels are automatically 
attached with the NDDOT standards.   
 

ByLevel 
The standard Levels have been set up for “ByLevel” use.  However, the linestyle scales have to 
be manually set by the user.   
 
A Few element templates use “ByLevel” settings directly such as manhole cells.  “ByLevel” 
settings are only recommended when they are used by the NDDOT custom tools. 
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3.9 Line Styles 
April 2022 

 
Users are strongly encouraged to use NDDOT custom tools and Annotation Scale to set the 
appropriate line style settings.  A user could individually set the Level, Color, Weight, Style and 
Style Scale for each element.  However, this is not recommended because changing each setting 
individually/manually takes more effort and time and has a higher potential for user errors. 
 
Many line styles use both a line style scale factor and Annotation scale.  One of the common line 
style scale factors is 1/240 = 0.004167.  This factor is based on how the original line styles were 
created.  The displayed line style uses the product of line style scale and Annotation Scale.  
NDDOT custom tools automate the line style scale factor. 
 
There are a few line styles that are not plotted with a “Scale Factor”.  These line styles typically 
represent the true physical size of a feature such as guardrails, curbs, curb and gutter and dowel 
joints. These features are always drawn at the same scale and will be plotted on paper 
proportional to the plotting scale.  These line styles are digitized by turning off the scale factor 
toggle and ignoring the Annotation Scale. Again, NDDOT custom tools automate the line style 
scale factor.  The line styles that are drawn to a physical size are highlighted with an asterisk in 
Appendix B.   
 
Certain line styles are directional, in that their pattern component is not symmetrical.  An 
example would be the ‘Exst Wetland Delineated’ custom line style.  The small filaments that 
represent vegetation and grasses should point in toward the water side of the wetland.  
Consequently, the line needs to be digitized in the direction that will produce this effect (counter-
clockwise on a closed shape.)  Check Appendix B for directional information. 
 
 
Tech Tip: Use the “change curve direction” tool to change the direction of a line 
style.  This tool can be located in the Drawing (workflow) > Curves (tab) > Curve 
Utilities (panel).  
 
 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixB.pdf
https://www.dot.nd.gov/manuals/design/caddmanual/AppendixB.pdf
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3.10 Cells 
April 2022 

 
NDDOT cell libraries are located at “S:\STANDARD\CE10\Organization\Cell”.  The following 
is a list of the active NDDOT cell libraries: 
 
Bridge.cel   Bridge items 
Cells 1 scale.cel  General cells placed at 1 scale 
Cells plot Scale.cel  General cells placed at plot scale 
CSP_end_sections.cel  Corrugated steel pipe end sections 
drainage_structures.cel Drainage structures 
Driveway.cel   Dimension driven driveway cells 
Guardrail.cel   Guardrail items 
Hatch.cel   Patterning items  
Ltg schematic.cel  Lighting schematic items 
Manholes.cel   Manholes 
Pipe.cel   Pipe End View 
pipe_bends.cel   Pipe Bends 
Pvmtmkg.cel   Pavement marking 
RCP_end_sections.cel  Reinforce concrete pipe end sections 
Sheets.cel   Sheet borders (see Appendix H) 
Signal_Det.cell  Signal Detail Items 
Signals.cel   Signal items 
Signs.cel   Signing items 
 
For a comprehensive listing of the available cells (see Appendix C).   
 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixH.pdf
https://www.dot.nd.gov/manuals/design/caddmanual/AppendixC.pdf


CADD Standards 
 

3.11 Annotation and Fonts 
May 2016 

 
All features on plan sheets should be annotated whenever possible.  To ensure the final plans 
have a consistent and clear readability, operators must follow the standard guidelines for upper 
and lowercase letters, font type, annotation size, underlining and bolding, use of levels and 
abbreviations. 
 
Lowercase annotation is used for all annotation except for: 

• Capitalization at the beginning of a description (e.g. Bridge begins 1200+65.0)  
• Abbreviations for separate words (e.g., the abbreviation for power pole is PP, for cable 

guardrail is C Gdrl, for corrugated metal pipe is CMP). 
• Utility Companies Abbreviations are all capital letters. 
• Pay Item Headings and Descriptions 

 
The most common text font used for NDDOT plans is “NDDOT” (true type font).  Some 
standard annotation is placed with font “engineer” or true type font “Dot Matrix”.   The use of 
the “engineer” and “DotMatrix” fonts are for unique situations as programmed into the 
Templates or other NDDOT standard tools.  Engineer font is used with some documentation to 
avoid formatting problems such as spacing and special characters.  “DotMatrix” font is used with 
particular labels used on ROW plats.  The only fonts to be used on NDDOT plans and related 
drawings are fonts “NDDOT”, “engineer”, and “DotMatrix”. 
 
Annotation should be underlined when it is in a title that is outside of a title block, or when it is a 
Pay Item.  Slanted or italicized text will not be used on plan sheets. 
 
Pay Items that are itemized on sheets should use the following format. 

1. Include heading labels in capital letters on each sheet at the beginning of a pay 
item list.  The headings are; SPEC, CODE, BID ITEM, QTY, and UNIT. 

2. Include Spec and Code Numbers.  A hyphen should not be used between the sec 
and code. Always use 7 digits for the spec and code (example: 123 0001). 

3. Include Pay Item Name In All Capital Letters.   
4. Underline the Spec and Code and Pay Item Name.  The underline should extend 

through the quantity and unit columns. 
5. The itemized quantity information should be indented from the spec and code.  

The itemized quantity information should be left aligned with the bid item name. 
6. Include measurement units with the quantities. 
7. Use the font size specified by the MicroStation task group for the applicable 

sheet. 
8. Individual sheet subtotals should not be used. 

 
Designers should use their discretion for pay item location descriptions. Station and offset 
information doesn’t have to be used for all quantities. 
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This formatting is not required for pay item used in tables such as the “Traffic Control Device 
List” and earthwork summary tables. 
 
The following is an example of Pay Item formatting. 
 
 SPEC CODE BID ITEM QTY  UNIT 
 
 867 5309  GARBAGE CAN   
   Sta 6+00 83’ Rt 1 Ea 
   Sta 7+00 97’ Lt 1 Ea 
    
 328 1722 EXTENSION CORD   
   Sta 6+00 83’ Rt to 7+00 97’ Lt 145 LF 
   Sta 7+00 97’ Lt to 8+00 97’ Lt 100 LF 
    
Additional characters have been added to the font tables to enable the placement of such 
characters as fractions, Greek symbols and mathematical symbols.   Appendix L lists the 
available characters.   To draw a special character into a MicroStation drawing, open the “Place 
Text” box and enter back slash  (\)  followed by the special character number designation (from 
0-255).  The special character will be visualized on the screen and it can be placed by left mouse 
clicking. 
 
A special character was added to the NDDOT true type font library in March, 2014.  This 
character looks like a question mark with a box around it.  This character is located after the 
square root symbol.  The character is in keystroke \208 which is not normally programmed on 
most keyboards.   
 
This character is used to describe some surveyed items that “Indicate a feature that has an 
unknown characteristic, potentially based on: lack of description, location accuracy or purpose.”  
This special character will simplify CADD labeling.   
 
True type fonts are not resources that are directly installed on the network.  Users will need to 
have the fonts installed or updated on their computer every time there is a font update.    
 
Standards have been set for the size (height and width) of annotation.  Task Navigation – 
Templates have been programmed with the standard sizes and should be used for the placement 
of most annotation.  The typical annotation heights used on NDDOT plans range from 0.05 to 
0.17 inches when plotted to paper.   
 
Plan Note sheets should use a 0.12” text height - (12) Arial font.  The summary of “Estimated 
Quantities” should use a 0.09” text height - (9) Arial font.  
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixL.pdf
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3.12 Abbreviations 
April 2023 

 
When so many features are annotated in a set of plans, space is at a premium.  To generate more 
available space, operators should use abbreviations as often as possible.  We have established a 
comprehensive list of abbreviations that are commonly used by the DOT.  These abbreviation 
lists can be found in Appendices E and F.  
 
The NDDOT also has a glossary tool (macro).  This is used to look up NDDOT abbreviations 
and send them to your clip board and MicroStation Text editor – Word Processor dialog.   This 
macro can be accessed from the main pull down menu NDDOT>Tools>Glossary.  It is also 
accessible with short cut key combination “Ctrl + F10” if the NDDOT function key menus are 
used. 
 
Most abbreviations are placed without any punctuation (e.g., CI is 23.9' Lt of Hyd at Elev 
1800.6').  The only time a period (.) is used in an abbreviation is when the abbreviation matches 
an unrelated word.  Example Bus. is the abbreviation for “business”. 
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3.13 Dimensioning 
Sept 2010 

 
Commonly used dimension settings are grouped and stored in dimension styles.  Dimension 
styles are available to the designer through the “Dimension and Text Styles" dgn library file.  A 
complete list of styles and their settings can be found in Appendix P. 
 
There are several settings within the standard dimension styles that can be modified based on 
clarity and space.  The following is an overview of these settings. 
 
Tool Settings 
 
Alignment: Determines the axis along which the dimension is aligned (View, Drawing, True, 

or Arbitrary 
 
Location: Controls the location of dimension text (Automatic, Semi-Auto, or Manual.) 
 
Dim Offset: Sets a standard offset for the placement of a dimension. 
 
 
Style Settings 
 
Fit Options 
 
Text/Terminator: Selects the minimum fit dependent on the text, terminator or combination 

(Text Moves First, Terminator Moves First, Smallest Moves, Both Move, Text 
Inside, Term. Outside, Term Inside, or Term. Reversed.) 

 
Angle Format 
 
Units: Sets the units of measurement for angular dimensions (Length or Angle.) 
 
Display: Sets the display format for angular dimension text (D.DDDD, DD^MM', 

DD^MM'SS", C.CCCC, or Radians.) 
 
Accuracy: Sets the number of decimal places to display for angular dimensions. 
 
Text Format 
 
Orientation: Sets the orientation of dimension text relative to the dimension line (Aligned or 

Horizontal.) 
 
Location: Sets the location of the text relative to the dimension line (Inline, Above, Outside, 

or Top Left.) 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixP.pdf
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3.14 Patterning and Hatching 
April 2022 

 
Patterning and hatching are used for drawings that require material definitions, such as concrete, 
rock and excavations.  A list of patterns is shown in Appendix G. 
 
Users are encouraged to use NDDOT custom tools for patterning and hatching because several of 
the settings are automated.    If NDDOT tools are not used, settings such as scale, row spacing, 
column spacing, and angle will have to be manually calculated and entered. 
 
The standard patterns are stored in the cell library Hatch.cel.  
 
Tips 

• If an operator is working in a file with a lot of hatching or patterning, they should 
probably toggle off “Patterns” under “View Attributes.”  This will help with refresh 
speed.   

 
• If they toggle on “Associative Pattern” in the “Pattern Area” box, the operator will be 

able to manipulate the closed shape and still have the pattern fill the altered shape. 
 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixG.pdf
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3.15 Print Drivers 
Sept 2010 

 
NDDOT customized print drivers have been setup for printing.  These print drivers files have the 
extension “pltcfg”.  These files work together with the Windows system print drivers.  These 
files adjust many configurations for NDDOT work. The following is an overview of some of the 
adjusted print configurations. 
 
Printers 
The drivers in the “…\plotdrv\Manually_Pick_Printer” folder don’t force a certain printer.  You 
need to select a printer during the printing process or your default windows printer will be used.  
The drivers in the “... plotdrv\Printer_Specific” folder automatically select a designated printer. 
 
Forms and Sheet Sizes 
Some printer drivers work more efficiently with designated form names and sheet sizes. These 
have been adjusted accordingly. 
 
Pen Tables 
Several pen tables have been set up to control the way some drawing elements are printed such 
as sheet stamps, tags, border comments and general color control.  
 
Print Styles 
Print Styles can control most of the same settings found in plot drivers.  One key feature of print 
styles is automatically coordinating the print area with the sheet cell boundary. 
 
Color Settings 
Print drivers control what is printed in color, black and white, and gray scale. 
 
Points Size 
Most NDDOT print drivers don’t display points in output. 
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Weights 
 
The table on the right is a line weight guide.  It is provided as a 
cross reference for evaluating your printer output.  These widths 
have been used to develop the CADD standards. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Line Caps and Joins 
 
The "NDDOT print drivers"  
print lines with the following 
attributes: 
   
 
 
 
 
 

MicroStation 
Line Weight Millimeter 
0 0.0423 
1 0.1270 
2 0.2540 
3 0.3810 
4 0.5080 
5 0.6350 
6 0.7620 
7 0.8890 
8 1.0160 
9 1.1430 
10 1.2700 
11 1.3970 
12 1.5240 
13 1.6510 
14 1.7780 
15 1.9050 
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3.16 Print Organizer 
April 2022 

 
Print organizer is a utility for plotting one or more design files at a time.  A single print organizer 
job can print drawings from multiple directories.  This section only discusses the NDDOT 
standards set up for print organizer.  The following is a quick guide. 
 

1. Use the NDDOT standard sheet cells. 
a. The NDDOT standards for print organizer use a plot boundary defined by a 

particular shape.  These shapes are included in all of our sheet cells.  The 
shape is the outer box with attributes; level = Sht Lines, color = 102, Weight = 
1, Style = 1. 

b. Do not use the “Use Shared Cells” option when placing sheets.  Printing will 
not work correctly if this option is used. 

c. Borders in reference files will not be found. 
 

2. Invoke print organizer under MicroStation file commands. 
 

3. Check the current assigned printer in the lower right of the screen.  If it is correct, 
skip to step 5, if not, follow step 4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. Under the File command, select Printer Setup.  In the new window, choose printer 

from the drop down box.  Click OK. 
 

a. If the file you intend to print contains multiple sheets within on drawing, such 
as a cross-section file, changing printers later in the process will be more 
complicated. 
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5. Select files to batch plot under the print organizer “add files to set” icon.  Click the 
Add button to browse for files.  Select desired files and click Done.  You may click 
the Add button again to browse for files in other directories. When all files have been 
selected, browse for the print style name that matches your printer and desired output 
format.  Click OK. 

 
a. Print style must match the chosen printer or output errors may occur.  The 

drawings will print to the printer indicated in the lower right, see #3.  If the 
print style does not match the printer; paper size or color output may be 
incorrect; ex. a color drawing may print in grayscale.  

b. If the file you intend to print contains multiple sheets within one drawing, 
changing print styles later in the process will be more complicated.   

 
 

6. Sort the files into the correct order by clicking on the File Name in the left-hand 
column.  The up and down arrow icons in the tool bar will now be active.  The same 
options are available under the Edit command. 

 
7. Click “File>Save As” on the menu bar and save the print set into a working directory, 

in case you need to make any changes later.  The print sets should be saved in the 
corresponding ePlan folder under the project directory.  For example, you are in 
Bridge and are working on PS&E plans.  First you would navigate to the PS&E folder 
under the ePlan directory.  Next create a new Bridge folder by clicking on the Create 
New Folder  button.  Double click on the newly created Bridge folder.  Type 
“Bridge PSE01” in the File name field and click the Save button. 

 
8. Selecting the print command will give you a pop-up box.   

 
a. There is a box that allows a choice of “send to printer”, “create print file”, and 

“create Windows metafile”.  For paper copies, the “send to printer” option 
should show.  For PDF or electronic files, this box should be grayed out. 

b. There is also a box that allows a choice of “single print job” or “separate print 
jobs” when a PDF or electronic file is to be created.  “Single print job” should 
be selected to create a single file that contains all the pages.  This box will be 
grayed out for paper copies. 

c. Review the Destination box for desired location and name for PDF or 
electronic files. 

d. Click OK when ready to print. 
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9. Changing Printer or Print Style 
 

a. If NONE your drawings contain multiple sheets, you may change either of 
these items at any time.  Printer may be changed from Printer Setup under the 
File command.  Print Style can be changed by using “apply print style” under 
the Tools icon.  Be sure to match printer and print style.  If you do this step to 
change printer or print style for a file that contains multiple sheets, you will 
receive a single sheet printed multiple times. 

b. If any your files contain multiple sheets and you must change the printer or 
print style, follow these steps: 

i. Delete only the files with multiple sheets 
ii. To change the printer, follow step #4 above. 

iii. To change the print style: 
1. If you have other files still existing, select the Tools icon and 

“apply print style” to apply your new selection, otherwise skip 
to step B. 

2. Re-add the deleted files following step #5 above, being sure to 
use the correct, new print style. 

iv. Follow steps #6 - 8 as necessary. 
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3.17 Referencing Drawings and Attaching Rasters 
April 2023 

 

Reference Paths 
Use the “Save Relative Path” options when referencing files.  The “Save Relative Path” option 
will help keep the reference path integrity when the files are moved from one drive to another.   
The “Save Relative Path” option requires that the original directory structure is similar to the 
final directory structure.  Reference paths must be the same through a common parent directory 
(higher level directory).   
 
Referencing by “Primary Search Paths” or by “Configuration Variables” is not the preferred 
method to reference drawings and attach rasters.  Sometimes rasters are referenced from 
drawings in multiple directories.  If this type of raster attachment is necessary, a project 
configuration variable file can be used.  This project configuration file must be submitted with 
the project files.  Consultants must discuss their use of “Primary Search Paths” and 
“Configuration Variables” for referencing with their assigned “Technical Support Contact”. 
 
Broken reference paths are CADD Standard violations even if the references are not important.   
Unimportant-Temporary-Junk references and raster attachments should be deleted when final 
plans are completed.  Consultants and District users should do this before the electronic files are 
submitted. 
 

Reference Transparency 
Reference Transparency settings for the following sections and reference files are an option to be 
used at the designer’s discretion.  In sections 40, 55, 60, and 80 the reference files Topog.dgn 
and RW_Bndry.dgn can be referenced with a transparency setting of 50%.  These optional 
setting can help clarify dense urban drawing.  Using transparency will lighten up some reference 
files, allowing other files to have more of an emphasis.  
 
Note, The NDDOT is using transparency as interpreted by Adobe which doesn’t require the 
rasterized option.  In order to print with transparency with only MicroStation, the rasterized 
option needs to be used. 
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Note, Currently Bentley defect 960383 complicates printing refence files with transparency set at 
in the reference settings.   The reference transparency setting will display correctly, but it will not 
print to a pdf file correctly.  Additional steps are required to work around this defect. 
 

1. Select the reference file using reference transparency within the Reference dialog 
box. 
 

2. Select “Properties > 
Adjust Colors” from the 
Reference dialog box. 

 
 
 
 
 

3. Turn on “Print Adjusted Colors” and select “OK”.  Now 
the reference transparency can be correctly printed to 
pdf.  
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Live Nesting 
“Pointer Files” are encouraged because they can simplify revisions in drawings that use nested 
referencing.    The following is an overview of “Live Nesting” referencing and “Pointer Files”. 
 
A nested reference file is a reference file that is referenced by way of at least one other reference 
file.  If file “A” is referenced by file “B”, and then file “C” references file “B” with a nested 
depth of 1, then file “A” would be a nested reference file when viewed in file “C”.   
 
“Pointer Files” are drawings that should have nothing drawn directly in them.  They consist of 
only references to other files. These files are used to manage reference files for sheet drawings in 
the plans.  Each section of the plans could have its own pointer file (“Pointer_” and Section 
Number); Pointer_040.dgn, Pointer_055.dgn, Pointer_060.dgn, Pointer_070.dgn, 
Pointer_075.dgn, Pointer_076.dgn, Pointer_077.dgn, Pointer_080.dgn, Pointer_082.dgn, 
Pointer_090.dgn, Pointer_100.dgn, Pointer_110.dgn, Pointer_120.dgn, Pointer_130.dgn, 
Pointer_140.dgn. 
 
NDDOT process for ORD sheets use a pointer model within the applicable sheets drawing.  
Example 060PP_*.dgn would contain a pointer “design” model and separate “drawing” and 
“sheet” models.  Files named “Pointer_*.dgn” are not typically needed in ORD workflows 
because the “design” model with referencing is that actual pointer model. 
 
The Pointer file controls which reference files and level will be displayed in your sheet models.  
The Pointer file can be used to turn on and off levels in multiple models.   They can also be used 
to attach or detach reference files in multiple models.  The Pointer file makes it easier to 
consistently adjust what is displayed in your sheet models.  Multiple sheet models can reference 
the pointer model and reference adjustments including level display can be made in one place. 
 
Level display settings can be changed for the active file, a reference file and a nested reference 
file.  MicroStation has “Display Overrides” for “nested” reference files.   The “Display 
Overrides” are not applicable to regular reference files.  This is an important difference between 
reference files and nested reference files.  Whenever you reference a “Pointer” file, “Live 
Nesting” should be set, 
Display Overrides 
should be set to “Never” 
and the Nesting Depth is 
usually set to “1”.  
 
 
When you reference files into the pointer model, Live Nesting is not typically used because the 
Pointer model is usually referenced by others with nesting depth of 1.  If the Pointer file is 
referenced with a Nesting Depth of 2 or more then the Live Nesting and Display Override 
options within the Pointer file are also important.  The Nesting Option outcomes become more 
complicated as the Nesting Depth increases.  
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3.18 Printing Rasters (Pictures) 
Oct 2008 

 
Embedding pictures within a MicroStation drawing is discouraged.  Don’t cut and paste pictures 
into MicroStation.  Pictures should be attached to drawings using Raster Manager.  Pictures 
attached with raster manager are easier to adjust then embedded pictures. 
 
Printing color pictures in grayscale is easier to do with raster manager than with embedded 
pictures.  Color Pictures should be printed as grayscale when creating black and white plan sets. 
 
The raster settings for printing with just MicroStation can be found in the “Print” dialog box 
under “Settings>Raster Options. 
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3.19 Annotation Scale 
April 2022 

 
The NDDOT CADD standards use annotation scale.  Standards have been set up for placing 
cells, custom line styles, text, patterns, etc. to insure uniformity in all prints. Most of these 
settings are automated in the NDDOT custom tools.  For example, one user is creating a border 
sheet set to plot at 1"=40' and another user is creating a border sheet set to plot at 1"=200'.  If 
both sheets were plotted and compared, the text in the title block should be the same size even 
though they were plotted using different scales.  By using NDDOT’s custom tools, a user can 
place cells, custom line styles, text, patterns, etc. quickly and easily, because the individual 
element scale factor are adjusted by the drawing scale.  
 
Annotation scale (for placement) should be on for most elements.  Annotation scale affects more 
than just annotation.  Annotation scale affects the scale for line styles, cells, text, dimensions, 
hatching and patterning.    
 
Annotation Scale is part of the Drawing 
Scale.  The Drawing scale also contains the 
working units settings and Annotation Scale 
Lock toggle.  The Annotation Scale can be 
selected from the “Drawing” workflow, 
under the “Utilities tab.  
 
MicroStation drawing elements that directly use annotation scale will automatically change scale 
when the Annotation scale is changed.  One drawing model can use only one Annotation scale at 
a time.  Example, you can’t correctly draw two different scaled typical sections in one model.  
The annotation scale for one of the typical sections will be off. 
 
There are a lot of settings related to annotations scale.  Most of these settings are AUTOMATED 
in the standard NDDOT tools. 
 

Annotation Scale for Line Styles 
• This is a model property.  NDDOT Standards use “Annotation Scale” for Line Styles 

Scale. 
• The standard resource file (dotlst.rsc) uses a property named “physical” to indicate which 

line styles should not be adjusted by annotation scale such as “24 inch RCP”. 
• Custom Line Style scale factor. 

o Annotation Scale and line style scale factors are different properties.  
o Line styles that should not be scaled will use a factor of 1.  
o Line styles that should be scaled, dependent on annotation scale, will use a factor 

of 0.0041666 (1/240). 
o Line Style Scale Factor is it used in conjunction with annotation scale.  What you 

see is the product of the two different factors (annotation scale x line style scale). 
o NDDOT custom tools will automatically adjust the line style scale factors as 

needed.    
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Annotation Scale for Cells 
• Annotation Scale for Cells consists of two properties; model and placement (“Annotation 

Purpose” and “Is Annotation”). 
• Both of these properties need to be on if the cell is to be directly adjusted by annotation 

scale. 
• The cell property “Annotation Purpose” (model) is set by CADD standards.  User will 

not adjust this setting. 
• The cell property “Is Annotation” (placement) can be toggle on or off during placement.  

Users could change is setting but typically shouldn’t.  NDDOT tools automate this 
setting.  

 

Annotation Scale for Text (Text Styles) 
Text Styles are used to help implement annotation scale for text.  The actual paper scale values 
are used for text height and width.  Many NDDOT custom tools note the text size by the unit of 
inches (example (07) for 0.07 inches tall.  The actual values will be in master units – feet.  The 
style “text 0.07” will display a text height and width of 0.0058 feet.  The actual drawing text 
height and width will be a product of the text style values x the annotation scale.  At an 
annotation scale of 1” = 40’, the actual drawing height, not the value shown in the tool settings, 
will be 2.8 Feet (0.07 x 40 = 2.8 ≈ 2.784 = 0.0058 x 12 x 40). 
 

Annotation Scale for Dimension Styles 
Dimension settings are dependent on text height values.  The NDDOT Dimension Styles have 
been set up using text styles. 
 
 

Annotation Scale and Referencing 
In the references dialog box the “Use Active Annotation Scale” toggle can make the reference 
file use the active model’s annotation scale.   
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3.20 Priorities and Masking Elements 
Jan 2017 

 
MicroStation shape elements with an opaque color matching the background color (number 255) 
are being used as masking elements within many sheet cells.  These masking items are being 
used to hide referenced elements that might overlap a title block.  These elements are being used 
with MicroStation “priority” attributes.  Reference elements with a lower priority are covered up 
and hidden by the masking element. 
 
There are a few things to remember when using these masking elements.  First, masking 
elements are on their own level (Mask Lv Priority 100).  The level can be turn off if you don’t 
want to use the masking elements. 
 
Second, the “Fill” view attribute must be turned on.  
 
 
 
 
 
Third, the reference update sequence may need to be 
changed if a 3D drawing is referenced.  This step isn’t 
needed if all references are 2D.  Note, most “Topog” 
drawings are 3D. 
 
If a 3D drawing is referenced, all of the cut sheets – 
sheet drawings will need to be edited.  With the sheet 
drawing active, open the reference dialog box and 
select “Settings > Update Sequence”.   Move the active 
sheet drawing to the end of the update sequence list. Be 
sure to save settings after the update. 
 
If a drawing with opaque shapes are referenced, they should be first in the update sequence.  
Next should be any 3D drawings, then regular 2D references, and lastly the active sheet drawing.  
This adjustment is typically need for sheets in sections 075 through 077. 
 
Fourth, if the sheets are being created from a drawing that used an older level priority definition 
for sheet lines, this level priority definition will need to be updated.  Do this before cutting sheets 
if possible.  If done after, all cut sheets will need to be edited.  
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Within Level Manager, 
select the “sht Lines” level.  
Then select the “update 
levels from library” button.  
Level definitions not 
matching the present CADD 
Standard definition will be 
marked with the modified 
attribute as shown. 
 
 
Most users will not need to change priority setting.  The following is a summary of NDDOT 
standard priority attributes.  Display priority is determined by a combination of element, level 
and reference priorities.  Reference priorities are a 1000 times that of level priorities and level 
priorities are a 1000 times that of element priorities. 
 
Display priority = (1,000,000 x reference priority) + (1000 x level priority) + element priority. 
 
Most CADD standards don’t use reference and element priorities.  Most CADD standards have a 
level priority of 100 (display priority 100,000) or less.  Many sheet cells have display priorities 
greater than 100,000.  The following are some of the sheet display priorities.  Bigger display 
priorities display on top of smaller display priorities. 
 
Items Level Priority Element Priority Display Priority 
Masking Element 100 10 100,010 
Sheet Lines 100 20 100,020 
Sheet Text 100 30 100,030 
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3.21 Geographic Coordinate Systems (GCS) 
Feb 2023 

 
The NDDOT has assigned a special coordinate system to each county.  Most NDDOT projects 
use one of these county coordinate systems.  Three libraries of coordinate systems are included 
in the CADD Standards;  

NDDOT_County_Coordinates.dty 
NddotCountyNAD83-CORS96.dty 
NddotCountyNAD83-2011.dty 

 
The library NDDOT_County_Coordinates.dty and NddotCountyNAD83-CORS96.dty are no 
longer used.  These are older libraries that were used with MicroStation SS2 and other older 
projects.  These are kept with the standards incase work needs to be done with older software.  
These libraries are not attached by default.   
 
By assigning a GCS to each drawing you enable additional capabilities.  MicroStation can use 
these GCS to project and re-project data from different geographic coordinate systems. This data 
includes Bentley data and many other formats such as pictures and ESRI formats. 
 
The GCS’s are not set with the default NDDOT seed files.  They need to be set up on an 
individual drawing basis.  The Coordinate System tool can be found in the Drawing (workflow) 
> Utilities (tab) > Geographic (panel). 
 
This will bring up the "Geographic Coordinate System 
Dialog.  Select the second button "From Library".  
 
 
 
 
 

Select the Coordinate system to apply to the DGN file 
from the available selections.  Most Projects within 
the DOT will use one of the NDDOT county systems.  
After selecting the appropriate Coordinate System, 
click OK.   
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Typically the Preliminary Survey section will determine what coordinate system to use.  Review 
their AAreadme file to determine which coordinate system to use.  Their files can also be 
reviewed in order to determine the applicable coordinate system.   
 
Hint: The set Geographic Coordinate System from 
Reference File tool is a quick way to lookup the GCS 
from another related project file and set it at the same 
time.   
 
 
 
 
Hint: When working with older Geographic Coordinate Systems, note the slight variation in 
names.  The CORS96 GCS’s will not have a year listed in the name.  The 2011 GCS’s will show 
the year in the name. 
 

 
 

 



CADD Standards 
 

 
 
Hint: When working with different GCS’s, 
look for and use the option “Geographic – 
Reprojected” when using tools such as 
referencing. 
 
 
 
 
 
 
 
 
 
 
 
Hint: When working with different GCS’s and rasters, the 
user preferences discussed in Section 2.7 of this manual are 
relied upon to reproject the raster (Geo Priority = File 
[Raster Header]).  Make sure the GCS is set before 
attaching rasters.  
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3.22 Item Types 
April 2023 

 
Item types are a property type that can be attached to an element. They can provide for a vast 
amount of input and can autogenerate fields such as station, offset, fundamental geometry 
measurements and other calculations based on user input. Some common uses are to populate 
plan sheet fields such as project number, project description, and to generate tables. The item 
type values are visible and can be manipulated by accessing the properties for an element. 
 
Notes:  

• Item Types are available for MicroStation CE, OpenRoads Designer and OpenBridge 
Designer.  However, some item types work directly with civil properties (civil tools).  
Item Types referencing civil properties may not update when opened in MicroStation CE.  
Full functionality of an item type property such as stationing requires that file be opened 
in the applicable civil software.  

 
• The Control and RIMS item types will automatically be attached to the appropriate 

graphics in ORD 10.11 and later. If you are working with graphics produced in earlier 
versions, then you will need to manually attach the item type properties.  

 
Available item type properties can be attached to an element from multiple locations.  

• Survey (workflow) > Utilities (tab) > Item Types (panel) > Attach Item  
• Drawing (workflow) > Attach (tab) > Item Types (panel) > Attach Item  

 
The Attach Item dialog will show you the available item types 
that you can attach to an item on the left-hand side. You can 
choose to select a single item type like ControlPoints or an entire 
group like RIMS. The act of attaching an item type works by 
selecting multiple items before you activate the tool or by 
activating the tool and then selecting an element.  
 
An item type may need to be embedded in the DGN before you 
can attach it to multiple items at once. A quick technique to 
accomplish this is to create a sacrificial element to attach all the 
item types that you want to use in your file. You can delete the 
element as soon as you are done attaching the item types to it. A second option is to simply 
import the particular item type property(s) you need using the Item Types dialog.  
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The properties that will be attached to an item will display on the right once an item is selected 
on the left. Fields you can populate will be white like various field in the Control item type set. 
Field that cannot be manually populated are grey like all the fields in the RIMS item type set. 
Populating some fields before attaching them can be very efficient. For instance, the 
ControlPoints and ReferenceMarkers item types both contain a ReferenceAlignment field. If you 
populate the field with the name of your alignment you will be using, then every element you 
attach it to will automatically receive the correct station and offset based on that alignment input. 
This mass edit can also be done after they are attached by selecting multiple items with the same 
item type and accessing the properties. 
 
Access the properties of an element to manipulate or review the item types after they are 
attached, if needed. Each item type attached to an element will appear in its own ribbon within 
the properties dialog. A field that appears with a greyed out name cannot be edited.  
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Section 4 is intentionally blank (reserved) 
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OpenRoads 

5.1 OpenRoads Survey 
April 2023 

 

Survey Decorators 
Survey decorators are text labels that are 
typically temporary and dynamic.   They 
label imported survey elements.  These 
labels include Names, Field Codes, 
Elevations and Descriptions. 
 
The settings for survey decorators are 
adjusted within the Preferences dialog 
(File > Settings > User > Preferences > 
View Options – Civil > Survey 
Decorators). 
 
The decimal settings for elevation text is 
controlled by the Design File Settings 
(File > Settings > File > Design File 
Settings> Working Units).  
 
 
 

Suvey Link Codes 
Survey Link Codes are setup in the NDDOT stardard 
files (Survey_Settings.dgnlib).  Most users will not 
need to adjust these setting.  They only need to ensure 
that the NDDOT standards are correctly enabled.  
Survey settings can be reviewed through Explorer > 
OpenRoads Standards >Survey Settings > Link Codes.  
Note that you must click in the “Link Codes” field and 
then click on the “…” to open the LinkCodes dialog 
box.  
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Survey TIW (Text Import Wizard) 
The NDDOT text import wizard file is setup for survey text information in the following format. 
 

Point Name, Northing, Easting, Elevation, LinkCode PointCode, Note  
 
 
 
 
 
 
 
 
 
 
 

Survey Macros 
The NDDOT OpenRoads settings for importing survey data is supplemented with macros that 
can expedite CADD editing.  These macros add additional labels.  Many of these labels will need 
additional editing and all will need to have their locations manually adjusted.  The following are 
some examples. 
 

The feature “FNW” will include the label “Wood” if the macro is active. 
 
The feature “GM” will include the label “OWNER?”.  The CADD editor is expected edit 
this label with the gas main owners name. 
 
The feature “24RCPF” with a survey comment of “gf” will include the label  

24” x ‘ RCP (good) – RCFES (fair) 
The CADD editor is expected to manually edit the length and add the station and offset to 
the alignment. 

24” x 64‘ RCP (good) – RCFES (fair) 
 
Using the macros during import will take longer for the computer.  If the macros are off 
(unloaded) the import will still work but the additional labels will not be included.  Tools to load 
and unload the survey macros are located in the Photo (workflow) > Main (tab) > Macros (panel) 
> Survey > VBA on Import > On or Off. 
 
The Survey Macro VBA creates text that is linked to the survey graphic.  There are many things 
that will cause the survey graphic to refresh.  When a graphic refreshes/redraws, then the label 
will be redrawn into the file with the original VBA text.  Example, the default VBA label for a 
gas main is "Owner?". If this label is edited to "ACME PL" and moved to an appropriate 
location, this edit may later be undone.   If the gas main line is edited to remove a stray point, 
then the "ACME PL" annotation will be moved back to its original location and be change back 
to "OWNER?".   
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5.2 OpenRoads Feature Definitions 
April 2023 

 
Most of the NDDOT Feature Definitions for OpenRoads are stored in the file 
“Features_Annotations_Levels_Elem Templates.dgnlib”.    This file is referenced with the 
CADD standards.  Most users will only need to access feature definitions.   
 
Note the structure for Feature Styles, Feature Definition and Element Templates is intended to be 
the same.   This should simplify user navigation and standard maintenance. 
 

Feature Definition Macro 
 
The “Tool Relationships” macro is briefly discussed in Section 2.9 of this manual.  Some of the 
NDDOT custom tools work with feature definitions.  Several NDDOT drawing elements are 
directly related to NDDOT feature definitions.   
 
Dependent on the “Tool Relationships” setting, accessing a NDDOT tool for a drawing element 
may also set a feature definition if applicable.  If there is no applicable feature, the feature 
definition will not change.   
 
For example, if Tool Relationships” has Civil Features “on” and “Aggr A” is selected from the 
NDDOT tools, the Feature Definition Toggle Bar should open and also switch to “Aggr A”.    
 
Note, some tools don’t automate feature definitions.   Example, the feature definitions for 
elements such as terrains will need to be manually set at the time of creation. 
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5.3 Civil Geometry 
April 2023 

 

Horizontal Alignments 
There are 3 groups of NDDOT CADD standards for alignments; Large Scale, Small Scale and 
Survey Centerline.  Within the small and large scale groups there are 8 different alignments that 
are similar but use different levels and colors. 
   
Small scale alignments are typically used on urban projects where most plan sheets are 80 scale 
or smaller.  Large scale alignments are typically used on rural projects where most plan sheets 
are 100 scale or larger.  The main difference between these 2 formats is the station labels.  Large 
scale uses a +00 format every 500’ and uses a large offset that places the label outside of the 
roadway.  Small scale uses an abbreviated station format (without +00), is placed at a 100’ 
interval, and uses a small offset that usually places the label within the roadway. 
 
Survey Centerlines are existing alignments that have been used in legal descriptions such as right 
of way plats. There is both a large scale and small scale version of survey centerlines.  The main 
difference between Survey Centerlines and other alignments is that the bearing of lines is 
labeled.  Survey centerlines should not be used for Office Location alignments. 
 
ORD software has a few limitations that need to be manually adjusted. 

1. The software does not distinguish between a point of intersection (PI) without curves and 
point on tangent (POT).  Both types of these points have been set up with a PI label.  
POT’s must be manually identified and the labels will need to be manually corrected. 

2. The deflection of all PI’s should be labeled on Survey Centerlines.  This includes PI’s 
without curves.  The software doesn’t automate this label because the angle is derived 
from “two” lines, whereas PI’s with curves can derive the angle from “one” element (the 
curve).   The deflection should be labeled with the tie line.  Example: 

¼ Line Xing 
6655+64.80 
#8 Rebar 
É = 0^ 00' 01" Rt 

 
3. The Combination PI label orientation will need to be manually rotated 180 degrees on 

curves that turn right.  The software doesn’t distinguish between right turning and left 
turning Combination PI. 
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4. Combination PI labels and leaders should be used anytime there is a spiral.  Combination 
PI labels and leaders should not be used on simple curves or PI’s without curves.  The 
software uses an all or nothing approach for Combination PIs.   

a. The automation for the combination leaders has been turned off.  These leaders 
will need to be manually placed.   

b. The automation for the combination labels has been turned on.  These labels will 
need to be deleted for PI’s without spirals.  Note these labels are on their own 
level. 

c. The individual spiral data tables should only be kept if the spiral was stored as an 
independent component.   If the spiral was stored as a curve combination, a 
“Curve Combination” table will be created with the annotation group. If a curve 
combination is used, the simple curve table and the spiral curve table for the 
combination should be deleted.  Also note that Curve Combination tables include 
both entry and exit spiral information.  For spiral curve spiral combinations that 
uses symmetric spirals, the exit spiral info should be deleted from the curve 
combination table. 
 

Sometimes the Combination PI label and leader overlap the curve PI label and leader.  
Manual adjustment are sometime needed for these labels anyway. 

5. ORD alignment curves don’t have names.  If curve names are desired, they will need to 
be manually named. 

 

Profiles 
Profile data is stored with its associated horizontal alignment.  Therefore, profiles are stored in 
the alignment drawings.  Designers will typically need to work with existing alignments, 
including profiles.  Designers may need to create proposed profiles for existing horizontal 
alignments.  They may also need to change display settings for existing profiles.  Designers will 
need write access to the existing alignments.  Survey data is often set as read-only to staff outside 
of the survey section.   
 
Designers may need to copy an existing alignment into a drawing 
(DS_Align.dgn) to which they have full access and control.  Using 
the tool “Geometry > Horizontal > Single offset Entire Element” is 
one way to do this.  The existing alignment drawing can be 
referenced, and the “Single Offset Entire Element” tool can be used 
with a 0’ offset.  Designers may want to “Remove Offset Rule” to 
eliminate direct dependencies to the existing alignment.  
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There are 5 feature definitions for existing profiles and 5 for proposed profiles.  There are 3 
variations of “Profile Existing 1” and 3 variations of “Profile Proposed 1”.  The profile - 1 
versions are setup for elevation “Strip Grades” when used with plan and profile sheets. 

• SG020 – Strip Grade every 20 feet – 40, 60 and 80 Scale Plan and Profile sheets 
• SG050 – Strip Grade every 50 feet – 100 Scale Plan and Profile Sheets 
• SG100 – Strip Grade every 100 feet – 200 Scale Plan and Profile Sheets 

The strip grades settings are not used in the dynamic profile view.  The strip grades are used in 
the drawing models.  
The Profile - 2 and 3 versions don’t use strip grades.  They just use different symbology. 
 

Alignment Naming Convention 
 
Horizontal 

• OL_*   = Office Location _ Descriptive Suffix 
• OCL_* = Office Location Centerline_ Descriptive Suffix 
• SCL_*  = Survey Centerline_ Descriptive Suffix 

Vertical  
• Terrain Profiles are named by ORD application after the Horizontal Alignment 
• Use “EX” for existing profiles that are created independent of a terrain. 
• Use “PRP” for proposed profiles. 
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Alignment Key 
 
Include an “Alignment Key” in the AAreadme file for supplement design data. 
 
Example Alignment Key 
 
Horizonal 
Alignment Name 

DGN File Name Extended Description Derivation 

OCL_WB104OS DS_Align.dgn Highway 2 West Bound 
104’ Offset from East 
Bound 

Newly created project 
alignment 

 
 
 
Vertical Alignment 
Name 

Parent 
Horizonal 
Alignment 

Extended Description 

OCL_WB104OS OCL_WB104OS Existing profile from Terrain_Alt 
PRP_Surcharge OCL_WB104OS For temporary surcharge embankment 
PRP_Median OCL_WB104OS For highway center median ditch 
PRP_WBML_N_Ditch OCL_WB104OS For Hwy 2 north ditch 

 
 
Other examples of horizonal alignment “Derivation” 

• copied from ..\Survey\Control.dgn 
• imported from ..\Survey\job001.gpk. 
• copied from a different Project ..\00000000.001\Survey\Control.dgn 
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5.4 Terrains 
April 2023 

 

Preliminary Survey Terrains 
The existing ground surface may be represented by different types of terrains.  Standard drawing, 
terrain and feature definition names have been assigned to communicate the differences between 
these terrains.   
 
Separate drawings are required for each terrain.   The DTM drawings should not include any 
terrains.   These drawings should only include the information used to create the terrains.   The 
actual terrains should be stored in separate drawings by themselves. 
 

1.  Drawing Name 
2.  Terrain Name 
3.  Feature Definitions Description 
1.  Terrain_Exst 
2.  Exst 
3.  Terrain Boundary Exst 

Continuous Along Primary Road Alignment - Used 
to create continuous existing profile for primary 
design road. 

1.  Terrain_Exst_Alt 
2.  Exst_Alt 
3.  Terrain Boundary Alt Exst 

Discontinuous Along Primary Road Alignment - 
May include underpasses, overpasses or exclude 
primary alignment structures.  Used for alternate 
profiles and earthwork calculations. 

1.  Terrain_Exst_No_Voids 
2.  Exst_No_Voids 
3.  Terrain Boundary No Voids Exst 

Similar to "Exst" terrain except voids are modeled 
as break lines and obscured data may be considered  

1.  Terrain_Exst_Alt_No_Voids 
2.  Exst_Alt_No_Voids 
3.  Terrain Boundary Alt No Voids Exst 

Similar to "Exst_Alt" terrain except voids are 
modeled as break lines and obscured data may be 
considered 

1.  Terrain_Exst_Drape 
2.  Exst_Drape 
3.  Terrain Boundary Drape Exst 

Extended terrain coverage is obtained with less 
regard to accuracy.  Used to drape features along 
surface, Voids modeled as break lines, 
Supplemental data is used to increase extent of 
terrain, Do not use for earthwork calculations 

 
The Terrain_Exst drawing is required for all earthwork projects.  The requirements for the other 
terrain drawings are dependent on project complexity.  
 
The “Terrain_Exst” and “Terrain_Exst Alt” drawings are the only drawings that meet the 
NDDOT survey accuracy requirements.   
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The “Terrain_Exst_No_Voids” and “Terrain_Exst_Alt_No_Voids” may use obscured data under 
certain circumstances.  Additional project documentation and direct coordination with the 
NDDOT Survey Section is required when incorporating obscured data.  Examples of obscured 
data may include data such as photogrammetric elevations obtained in dense vegetation.  
Designers should compare the Exst to Exst_No_Voids and the Exst_Alt to Exst_Alt_No_Voids 
terrains.  Designers are responsible for understanding the limitations and complications with 
using obscured data. 
 
The “Exst Drape” terrain should not be used for earthwork calculations.  The “Exst Drape” 
terrain includes information from automated elevation software that has not been refined.  The 
“Exst Drape” terrain may contain surface data on top of features like buildings, cars and 
vegetation.  In order to stress accuracy concerns with “Exst Drape” terrains, the DTM 
information used for the Exst_Drape terrain and the actual Terrain_Exst_Drape drawing shall be 
segregated into its own “Drape” folder under the “Survey” folder. 
 
 

Design Terrains 
Terrains for proposed surfaces shall be created for most earthwork projects. Three surfaces are 
usually provided for AMG: Dirt Grade (DG), top of Base (B1), and the top surface (T).   
 
Exterior Triangles that don’t accurately represent surfaces should be removed.  At a minimum, a 
reasonable triangle side length should be used in order to remove the majority of bogus exterior 
triangles.  Additional break lines may be required to prevent gaps in surfaces.  These gaps 
typically occur at the corridor beginning, corridor ending and at intersections.  A terrain 
boundary feature may also be used to eliminate all bogus exterior triangles. 
 
Terrain anomalies within the primary roadway pavement and under it (base and dirt grade) 
should be eliminated or thoroughly documented in both the drawing and the AAreadme file for 
contractors.  A perfect terrain representation of the proposed design is desirable but may be time 
and cost prohibitive to create. Minor anomalies within the inslope, backslope and with 
intersections should be avoided but can be tolerated. 
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Graphical Filters for Existing Terrains 
Graphical filters standardize the terrain generation. The graphics are filtered based on their 
symbology such as feature definition, level name, and cell name. These make up the Filter 
Groups that are used to extract graphical data into a terrain. 
 
Graphical filters are accessed from Open Roads Modeler or Survey (workflow) > Terrain (tab) > 
Create (panel).  When launched you will need to select the ellipsis button for the Graphical Filter 
Group. The existing surface filters are stored in the Survey_Terrain_Filters.dgnlib, while the 
proposed surface filters are stored in the Corridor_Model Terrain_Filters.dgnlib. Select the 
appropriate filter group that relates to the graphics that will be extracted into the terrain.  
 
The Terrain Filter Manager can be used to review what graphics will be extracted by a filter 
group.  Find the filter group in the list and expand it to see its individual components.  For an 
example you can access the proposed filter group Base 1.  Within the filter group there is a 
Boundary and a Break component.  If you select the component Base 1 – Break, then you can see 
basic information about the component. You can see additional details by selecting Edit Filter. 
On the left side of the Edit Filter dialog will be a list of symbology parameters.  Only the Civil 
Features is being used for this component.  When Civil Features is selected the full extents of the 
graphics used for this component are listed.  Some filters may use multiple symbology 
parameters for a single component.  

Creating XML Files from Terrains 
Contractors might not have software that can work with MicroStation terrain elements.  The 
terrain elements should also be saved as XML files for a broader range of compatible software 
formats. 
 

1. Select the “Export to File” tool from OpenRoads Modeling (workflow) > Terrain (tab) > 
Miscellaneous (panel).  
 

2. Select the terrain in MicroStation. 
 

3. Set the Export Options.  Typically the Triangles 
are exported without the terrain Features.  
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5.5 Corridor Modeling Templates 
April 2023 

 

Notable Differences Between ORD and V8i 
The following notes discuss general changes between the SS10 and ORD template libraries. 
 

1. SS10 corridor template libraries are not directly compatible with ORD feature definitions. 
2. Template preferences are now stored in the active template library (*.itl).   There are no 

longer stored in a xin file.  

 

RDM and RDPG (“Roadway Design Model” and “Roadway Design Plan Graphic”) 
Corridor models shall be saved in the RDM_*.dgn (roadway design model) drawing.  Multiple 
“RDM_” files are recommended for large project in order to simply corridor processing.  
Descriptive suffixes for these files are strongly encouraged. 
 
RDM_All.dgn is a file that doesn’t directly contain any corridor models.   This file is used as a 
pointer file that references all project applicable corridor models into one file. 
 
Corridor feature reference graphics can be drawn in a drawing named rdpg_*.dgn (roadway 
design plan graphics). 
 

Template Library (Inroads Template Library - *.itl) 
Each project that uses corridor modeling should use a project specific template library.  This 
library is usually copied from the NDDOT standards. 
 

• S:\STANDARD\CE*\Organization\Template Library\NDDOT-ORD.itl  
 
ORD will look for the project template in one of two places. Copy the itl file to one of the 
following applicable directories. 
 
If you used a workset, ORD will first look in the workset standards directory for the itl file.  
 

• CIVIL_ROADWAY_TEMPLATE_LIBRARY = $( _USTN_WORKSETSTANDARDS)NDDOT-ORD.itl 
• Example, R:\project\00000000.001\Design\Standards\NDDOT-ORD.itl 

 
If a workset is not used, ORD will look in the active dgn directory for the itl file. 
 

• CIVIL_ROADWAY_TEMPLATE_LIBRARY =  $(_DGNDIR)NDDOT-ORD.itl 
• Example, R:\project\00000000.001\Design\dgn\NDDOT-ORD.itl  (assuming dgn file is 

in dgn directory) 
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The NDDOT template library contains the following main folders. 

1. Components (No End Conditions) 
2. End Conditions 
3. Linear Templates 
4. Surface Templates 
5. Example Templates 
6. Project Specific 
7. Training 

 
Copy the templates to be used for your template drops into the “Project Specific” folder.  Project 
templates are typically customized.  This folder will help manage edits. 
 
The right side of the road is used as the default for individual roadway components and 
templates. 
 
Use the underscore (_) to delineate affixes.  Hyphens (-) can be used to tie phrases together, but 
spaces are also acceptable. 
 

Parametric Constraints (Template Variables) 
Parametric Constraints such as Inslope1_R will have to be manually edited to Inslope1_L if 
mirrored. 
 
Default variables values should be used in the library.  This makes editing and building templates 
easier. See Appendix R 
 
Parametric constraints are rounded to the accuracy set in user preferences.  Four decimal places 
are used in the template library for consistency purposes (example, 4” = 0.3333’,  4” is not equal 
to 0.33’) 
 
Widths on the right side are typically positive values.  Widths on the left side are typically 
negative values.   
 
Parametric Variables are case sensitive.  Parametric Variables should be title case. 
 
  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixR.pdf
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Point Names 
Standard point names aid with point styles, template transitions, point controls, labeling and 
alternate surfaces.  The Names also provide a partial description.  The names have up to 5 parts.  
The standard point name is the combinations of the parts: 
  

1. Layer Description  
2. Horizontal Description  
3. Repetitive Affix (count) 
4. Parent Component Name (Optional-use to avoid duplicate names) 
5. Right or Left Side Affix 

 
There are 3 common layer descriptions:  

T  (Top - Finished Grade),  
B1  (Top of Base 1),  
DG (Dirt Grade) 

 
A variation of the T and DG series is included (T_A_* and DG_A_*).  These points use the 
same feature styles as T_* and DG_*.   The intent for these points is to provide more flexibility 
in cross section labeling.  For example, there may be 2 template drops in a set of cross sections 
having similar points.  On one of the template drops a label may be desired, on the other the label 
may not be desired.  One template could use a T_A_* version and the other could use a T_* 
version.  This way labels can be applied discriminately to the different versions. 
 
Some points don’t belong to a surface.  These points still have a layer description.   
 DNC (Do Not Construct – This is a marking point) 
 Find (This point is usually part of an end condition looking for a feature) 
 
The “Horizontal Location” describes common horizontal markers.  If one of the following points 
doesn’t adequately describe a point this part of the name is optional, and the Repetitive Affix 
(count) is used.  
 CL (Center Line) 
 EOL (Edge of Lane) 
 Shldr (Shoulder) 
 EOSP (Edge of Sluff Pavement) 
 EOSB (Edge of Sluff Base) 
 Gutter 
 FOC (Face of Curb) 
 BOC (Back of Curb) 
 Tie (Tie Between Finished and Existing Grade) 
 Bnch-Front (Bench Front) 
 Bnch-Back (Bench Back) 
 Ditch 
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The number –repetitive affix or count part of the name is used to keep the name unique.  If the 
name would be unique without the count part of the name, this part of the name is unnecessary 
and should be omitted.  Points are typically number away from center line (bigger number used 
when it is further from center line). 
 
The component part of the name is used for points in different end conditions within the same 
template.  Again, if the name would be unique without the component part of the name, this part 
of the name is unnecessary and should be omitted. 
 
Sometimes boundary suffixes are used (_Bndry1 and _Bndry2).  These points are setup in the 
graphical filters to be used as boundaries for terrains.   
 
The last part of the name is the right or left affix. This affix can be automatically included in the 
name by the Roadway Designer tools.  It is often used to keep the point names unique when a 
component is mirrored. 
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Components and Volume Options 
Corridor modeling components use mesh feature definitions to create material volumes. Mesh 
feature definitions have a “Volume Option” property that affects how the volume is addressed in 
earthwork calculations.  The “Volume Option” setting is one reason why selecting appropriate 
feature definitions for your template components is important. 
 
The following is an overview of the “Volume Options” used in mesh feature definitions. 
 

Volume 
Option 

Description Earthwork Pitfall 

None The mesh/terrain is totally ignored when the 
earthwork is computed. 

 

Existing Lowest existing or unsuitable mesh defines 
suitable grading surface.   Corridor template 
end conditions tying to existing or unsuitable 
surfaces will use the lowest existing mesh.  

When used to define an existing volume such as 
existing pavement, it is treated as unsuitable and is 
removed.  An Asphalt overlay over an "Existing" 
volume (existing pavement) will not work correctly 
because the existing pavement will be removed and 
replaced by fill. 

Cut Material above or removed by a design mesh-
volume and below lowest existing mesh. 

 

Unsuitable Like "Existing volume".  If used with split 
option, volumes will be track in 2 groups 
(removed and replaced with proposed 
construction materials; and removed only) 

Unsuitable split can identify material that is replaced 
with design or fill material.  However, this is not the 
same as remove as needed.  In cut situations there can 
be material that needs to be removed but not replaced 
with another material.  Unsuitable meshes is the most 
direct way of doing removal calculations.  However, 
the limits of unsuitable modeling must be coordinated 
with design meshes edges. 

Substrata Existing material that can be built on top of 
with fill or design volumes.  Substrata cut can 
be tracked separately. 

This can be used for removals such as pavement 
removal on a widening project if the removed material 
is always replaced by a design volume- mesh or cut.  
However, it can create undesirable results in fill 
situations.  Example, on most projects we cannot 
build over topsoil. 

Design Mesh/Terrain that are proposed construction. CE "design" meshes-volumes no longer have 
provisions to be included in the mass ordinate.  
Embankment above subgrade will require a work 
around to include it in the mass ordinate. See section 
5.11. 

Fill Volume typically created between lowest 
design mesh and lowest existing or unsuitable 
mesh. 

 

Custom Both an Existing and Design Volume.  
Provides an existing volume from volume 
replace by custom material. 

 

Subgrade Defines construction volumes but not at 
finished grade. 
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Volume Option Defines Proposed 

Construction 
Volume 

Defines 
Existing 
Volume 

Mass 
Ordinate 

Splitable Used in 
NDDOT 
Standards 

None no no no no yes 

Existing no yes no no yes 

Cut no yes yes no yes 

Unsuitable no yes no optional yes 

Substrata no yes optional no yes 

Design yes no no no yes 

Fill yes no yes no yes 

Custom yes yes optional optional no 

Subgrade yes no no no no 

 
 
A corridor Model that represents the existing roadway can be used to calculate removals.  
Usually, the existing and proposed corridors are drawn in separate models and then referenced 
together before drawing cut fill volumes and performing earthwork calculations. 
 
The feature definitions for proposed construction components use a setting for “Volume Option” 
that is set to Design. 
 
The corridor models for the existing conditions use feature definitions that have their “Volume 
Option” set to Existing, Unsuitable, or Substrata.  
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General Geometric Rules for Templates and Typical’s 
1. Material thicknesses such as pavement, base and topsoil are measured vertically.  The 

distance value used in the MicroStation command “Move/Copy Parallel” is not the same 
as a material thickness if the line has any slope. 

2. The base extension for concrete paving sections has increased to 40 inches. 
3. The offset for the edge of dirt grade is determined by projecting a line from the top edge 

of pavement (top of sluff) to the bottom of the base line at the in-slope rate.  Topsoil will 
be projected up from this line.  

4. The offset for the edge of dirt grade will be variable with changes in super-elevation.  
The offsets are controlled by slope rates. 

5. Topsoil extensions should be used to develop full topsoil thickness on asphalt sections. 
Topsoil extensions also accommodate base extensions on concrete sections.  The topsoil 
extensions should be tied to the top edge of pavement, and they should be parallel to the 
pavement.  The top of topsoil grade breaks to the in-slope at the end of the topsoil 
extension. 

 
 
 
 
 

Super Elevation and In-slope Relationships 
 
Super elevation and inslope rates are project variables that indirectly affect dirt grade widths.  
Consistent relationships between these slope rates help facilitate template transitions and the 
comparison of alternates.   The development of the NDDOT template library uses the following 
philosophies: 
 

1. The top edge of dirt grade offsets will be variable through a supper elevated curve.  
These offsets will be controlled by slope rates. 

2. The edge of the roadway dirt grade will be determined by projecting a point from the 
top edge of pavement (top of sluff) to the bottom of base line at the in-slope rate for 
both concrete and asphalt templates.  Topsoil will be projected up for both asphalt 
and concrete templates.   

3. The templates will address safety edges and traversable stuffs. 
4. Topsoil extensions that are parallel to the roadway pavement are desirable. Topsoil 

should tie to the top of asphalt sluff pavement. 
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5.6 Corridor Modeling Requirements 
Jan 2019 

 
 

1. Corridor modeling break lines (feature styles) are required deliverables.  These break 
lines are drawn with the corridor within the RDM file.  Some break lines are optional 
other are required.  Some of the break lines don’t need to be created. Points used to 
calculate and mark points such as a minimum dich depth where it isn’t used as a 
break point, can be omitted from the terrain.  Other break lines should be included 
even if it doesn’t represent a break point.  The following are required break lines and 
shall be included in the terrains: 

• EOP – Edge of pavement for all surfaces (T, B1, DG) 
• SHLDR - Shoulder for all surfaces (T, B1, DG) 
• EOL – Edge of lanes for all surfaces (T, B1, DG) 
• B1-EOSP – Edge of sluff for pavement 

 
2. The following intersections must be modeled in areas to be constructed. 

a. Highway to Highway Intersections  
b. Principal Arterials 
c. Minor Arterials 
d. Collectors (includes County Major Collectors) 
 
Note, modeling lower classification intersections may be desirable but is not required 
 
See County Classification Maps 
http://www.dot.nd.gov/business/maps-portal.htm#countyfunctionalclass 
See Urban Classification Maps 
http://www.dot.nd.gov/business/maps-portal.htm#urbanfunctionalclassandsystem 
 

3. If multiple models are used with one construction project, they should have 
coincident adjoining edges if they connect.  Avoid overlapping model areas.  
Example, two roads intersect. One of the models includes the intersection the other 
model should stop at the beginning of the intersection modeling. 
 

4. Models for work zone traffic control such as median cross overs, ramp connections 
and temporary bypasses are required if cross sections for these same areas are 
required. 

 

http://www.dot.nd.gov/business/maps-portal.htm#countyfunctionalclass
http://www.dot.nd.gov/business/maps-portal.htm#urbanfunctionalclassandsystem
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5. If a proposed surface has gaps in it, then the model should also reflect these gaps,  
Example, a widening project has shoulders added to both sides of the road but the 
center is unchanged.  The proposed surfaces should not cross over unaffected areas.  
The follow are ways to create the applicable gaps. 

 
a. Rename the points and alternate surfaces to simplify the creation of a separate 

base surface.  Example the base surface on the left side of the road could use “B1” 
points, alternate surfaces and graphical filters.  The base surface on the right side 
of the road could use “B2” points, alternate surfaces and graphical filters. 

b. Separate corridors could be used to segregate the left and right side of road.  
Surface that need to be merged could be done as a separate step. 

c. Terrains can manually be created from the applicable proposed break lines and 
boundaries.  

 
6. Break line and boundary prefixes must match the related surface.  Example, a “B1” 

break line must belong to a “B1” terrain, the “B1” break line shouldn’t be used in a 
“B2” terrain even if the terrain is correct.  Rename template points to avoid 
mismatched prefixes.  Matching prefixes are required for the standard graphical filters 
for terrains.  Matching prefixes also simplifies model review. 
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5.7 Template Drop Interval and Design Stages 
April 2023 

 
The maximum template drop interval for NDDOT projects is 25’.  However, this drop interval 
may not provide enough detail for some corridor references such as intersections and approaches.   
Shorter distances are recommended for better accuracy.  
 
Short corridor references also require a shorter template drop interval.  All components must 
start with a template and end with a template.  Components reflected with just one template will 
not be drawn correctly when cut into cross sections.   Example: if there is only one template 
(drop) for a driveway, it may appear in the dynamic cross section but it won’t appear in the cross 
section for sheets. 
 
Processing requirements (time) increase as the template drop interval is shortened.   Designers 
need to balance the requirements for accuracy with the time needed to process a corridor.  A 5’ 
template drop may seem like an easy way to promote accuracy, but it isn’t usually feasible. 
 
Consider the cross section sheet interval when selecting a template drop interval. If there isn’t a 
template drop where there is a cross section for sheets, the sheet information will be interpolated.   
Example, an end condition tie point will be interpolated (close but not actually tying). If the 
template drop started at an even station with a 10’ interval and the sheet interval started at an 
even station with a 25’ interval, then the sheet sections at +25 and +75 would be interpolated.  
The interpolated section might be acceptable for a sliver grading inslope, but an interpolated 
section may be problematic for a bridge tie point.  In this example adding a key station for the 
bridge tie point would be a simple solution. 
 
A 25’ template drop interval with the corridor design stage set to “Critical Sections” works for 
most mainline models.  The template interval will be shortened as needed with this corridor 
design stage. 
 
The corridor sections (actual template drops) are determined from a combination of settings 
including; 

• Template Drop (Distance) 
• Key Stations 
• Template Drop Interval Multiplier 
• Critical Sections 

 
Two of these settings can be quickly changed for an entire corridor by changing the “Corridor 
Design Stage”; Template Drop Interval Multiplier and Critical Sections.    
 
The “Conceptual” corridor design stage has the template drop interval multiplier of 2.  This 
increased distance simplifies the corridor and process faster, but may overlook some necessary 
detail.  This is the only NDDOT standard corridor design stage with a template drop interval 
multiplier other than 1. 
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The NDDOT standard corridor design stages include critical sections in varying degrees.  Design 
stages that use more critical sections settings general have a shorter template interval. 
 
 
 
Corridor Design Stage 

Horizontal 
Cardinal 
Points 

Vertical 
Cardinal 
Points 

External 
Control 
Points 

Densify 
Horizontal 
Curves 

Densify 
Vertical 
Curves 

1 - Conceptual no no no no no 
2 - Design – No Critical Sections no no no no no 
3 - Design – Control Points no no yes no no 
4 - Design – Critical Sections yes yes yes yes yes 

 
When “Densify Horizontal Curves” is used, the NDDOT standards use a maximum chord height 
of 0.05’.  The following are example curves and template spacing that accommodate this chord 
height. 
Degree of Curve Template Drop Interval 
1 45’ 
2 30’ 
5 20’ 
10 15’ 
20 10’ 

 
When “Densify Vertical Curves” is used, the NDDOT standards use a maximum chord height of 
0.05’.  The following are example curves and template spacing that accommodate this chord 
height. 
Rate of Vertical Curve, K Template Drop Interval 
300 100 
100 60 
50 40 
25 30 

 
Most rural main line alignments meet a 0.05’ chord tolerance by using a 25’ template drop 
interval. 
 
Projects that use an existing profile might have VPI’s (vertical points of inflection) that are very 
close together.  The profile may cause numerous corridor sections if the “Vertical Cardinal 
Points” or “Densify Vertical Curves” critical sections are used with the design stages.  Consider 
avoiding or manually overriding these options if your corridor uses an existing profile.  Example, 
use the design stage “3 – Design – Control Points”. 
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5.8 Super Elevation 
April 2022 

 
The Superelevation tools are in the OpenRoads Modeling workflow, Corridors tab, and 
Superelevation group.  There are 4 main steps in using superelevation. 

1. Create sections 
2. Create lanes 
3. Calculate Superelevation  
4. Assign Superelevaton to corridor 

The “Minimum Tangent Length” value is used to control where there are breaks in sections 
(multiple sections for one alignment).  Separate sections are typically used when different parts 
of a corridor are designed for different speeds.   Use a large “Minimum Tangent Length” such as 
10000’ if separate sections are not desired.  Use a small value if separate sections are desired. 
 
The NDDOT uses the 
“NDDOT_Superelevation.xml” 
Rules file.  This rule file only uses 
modified 6% tables and modified 
relative gradients. The NDDOT 
version contains only 6% tables and 
is incremented at 0.1% instead of 
0.2%. 
 
There are 3 choices for transition method (L Selection): 

1. NDDOT relative gradient where the number of lanes drawn equals the number of lanes 
rotated 

2. NDDOT relative gradient where the 2 lanes drawn equals 1.5 lanes rotated 
3. NDDOT relative gradient where the 3 lanes drawn equals 2.5 lanes rotated 

Most sections will use the first option.  The second and third options have been setup for half 
lane conditions.  The NDDOT CADD standards have be setup so the half lane is a separate 
skinny lane, often 6 feet wide.  For example a roadway with an eastbound lane, westbound lane 
and a center turn lane would actually be draw with 4 total lanes; 

-18’ to -6’ 
-6’ to 0’ Centerline 
0’ to 6’ 
6’ to 18’ 

In this example, option 2 should be used (…2 lanes draw equals 1.5 lanes rotated). 
Caution, the lane width is used in runoff and runout calculations.  Users may want to use 12 feet 
for a lane width even if the actual lane width is different in order to maintain standard transitions. 
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The NDDOT uses a table based on table 3-9 of “A Policy on Geometric Design of Highways and 
Streets” (Green Book), 2018 to calculate super elevation.  The 6% e max table is used for most 
highway designs.  Intermediate values for every tenth of a percent have been interpolated into 
this table. 
 
Super elevation runoff and tangent runout 
are based on a “relative gradient”.  The 
NDDOT uses relative gradient values that 
are flatter than the 2018 Green Book 
(second to last paragraph of page 3-62).  
The table on the right shows desired relative 
gradients used by the NDDOT. 
 
The Maximum Relative Gradients shown in 
the table are from the 2011 Green Book 
(table 3-15).  The NDDOT Relative 
Gradient is 83.3% of the “Maximum 
Relative Gradient”.  The NDDOT relative 
gradient results in runoff and runout lengths 
that are 120 % of the minimum lengths (120 
% = 1 / 83.3%). 
   
These values are the same values used prior 
to the 2018 Green book. 
 
For non-spiral curve combinations, 1/3 of the runoff is placed on the curve and 2/3 of the runoff 
is placed on the tangent.  For spiral curve combinations, all of the super elevation runoff is 
usually placed on the spiral.  Often, the super elevation runoff used in spiral curve combinations 
is changed to match the spiral length.  Tangent runout should be directly proportional to runoff.  
On very long spirals, the tangent runout can be placed on the spiral if the maximum relative 
gradient is not exceeded. 
 

Design 
Speed 

Maximum 
Relative 
Gradient 
(%) 

NDDOT 
Relative 
Gradient 

(%) 

Equivalent 
Relative 

Slope 
15 0.78 0.650 1:153.85 
20 0.74 0.617 1:162.07 
25 0.70 0.583 1:171.53 
30 0.66 0.550 1:181.82 
35 0.62 0.517 1:193.42 
40 0.58 0.483 1:207.04 
45 0.54 0.450 1:222.22 
50 0.50 0.417 1:239.81 
55 0.47 0.392 1:255.10 
60 0.45 0.375 1:266.67 
65 0.43 0.358 1:279.33 
70 0.40 0.333 1:300.30 
75 0.38 0.317 1:315.46 
80 0.35 0.292 1:342.47 
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Simple Curve Example 
 
Given 
 PI = 1409+95.59 
 PC = 1403+11.54 
 PT = 1416+73.20 
 Delta = 13d 37m 0s left 
 R = 5729.58 
 V = 75 mph 
 
Solution 

e = 3.8 % interpolated from 6 % max table  
(Preferences are set to use “Radius Interpolation” as “Conservative Entry”) 
(5560’ = 3.8 %, 5745’ = 3.7 %, 5729.58’ => 3.8 %) 
 
NDDOT Relative Gradient (from table) = 0.317 % 
 
Runoff on high side = e * width of traffic lane / relative gradient 
Runoff on high side = 3.8 % * 12’ / 0.317 % = 143.84’ => 144’ 
(Preferences have been set to round runoff to the even foot.) 
 
Runoff on low side is proportional to runoff on high side. 
Runoff on low side = (e - normal crown) / e * Runoff on high side 
Runoff on low side = (3.8 -2.1) / 3.8 * 144.0’ = 64.42’ 
 
Runout is proportional to runoff on high side. 
Runout = normal crown / e * Runoff on high side 
Runout = 2.1 % /3.8 % * 144.0’ = 79.58’ 
  
Begin e on right side (high side) = PC – 2/3 * Runoff – Runout = sta 1401+35.96 
Begin full e = PC + 1/3 * Runoff = sta 1403+59.54 
End full e = PT - 1/3 * Runoff = sta 1416+25.20 
End e on right side (high side) = PT + 2/3 * Runoff + Runout = sta 1418+48.78 
  
Begin e on left side (low side) = Begin full e - (Runoff on low side) = sta 1402+95.12 
End e on left side (low side) = End full e + (Runoff on low side) = sta 1416+89.62 
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5.9 Linear Features Represented as Cells in Cross Sections 
Feb 2023 

 
OpenRoads cross sections show information from a 3D model.  Some of the 3D information is 
drawn as linear elements.  Most linear elements when cut into cross sections show up as a point.  
Standards have been setup to replace this point symbolization with a cell in the cross section 
view.  These cells usually have a label and are much more identifiable.  Additional work may be 
required to display features in cross sections. 
 
Additional drawing versions are usually required for OpenRoads Cross Sections.  The most 
common drawings needed include;  

XSG_Guardrail.dgn 
XSG_RW_Bndry.dgn 
XSG_Utility_Cells_as_Lines.dgn 
XSG_Utility_Crossing.dgn 
XSG_Utility_Linear.dgn 
XSG_Wetland.dgn 

 
These drawings contain civil feature elements that can be referenced into the cross sections.  The 
civil features have Plan (2D), 3D, Profile and Cross Section components.   
 
XSG drawings require linear geometry features with both 2D and 3D components. Simple lines 
and line strings (non-features) will not work. 
 
The following is a general overview of creating an XSG drawing.  Additional notes for specific 
XSG drawings are provided in Appendix Q – Drawing Production Guidance.   
 

1. Create a XSG drawing from a 2D seed drawing.  Linear Geometry uses a 2D model.  It is 
usually easier to let the civil geometry tools create the 3D model from the 2D model. 
 

2. Import graphics.  Simple lines and line strings (non-features) can be referenced and 
copied.  Copy only the elements to be converted to features.  You probably don’t need to 
copy elements like text and dimensions. 

 
a. MicroStation shape elements will not work as linear features.  The shape surface 

will display in the cross section view instead of the desired cross section feature.  
MicroStation shape elements will need to be dropped down to simple lines and 
line strings for this conversion process. 
 

  

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixQ/Drawing_Production_Guidance.pdf
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3. Set features and drape them to the existing ground terrain. 
 

a. The “Set by Symbology” macro can be used to set feature definitions to multiple 
lines and line strings in the drawing.  See section 2.9 of the CADD Standards for 
a description of this macro. 

 
 
 
 
 
 
 

b. Alternately, feature definitions could be set manually. 
 

i. Select all drawing elements that you want to convert to a specific type of 
feature.  Each feature type will be processed separately, one at a time. 
Example, New RW will be processed separately from Existing RW lines. 
 

ii. Select the appropriate Feature 
Definition.   

 
 
 

 
iii. Set the feature definition. The “Set Feature 

Definition” tool is located in the OpenRoads 
Modeling (workflow) > Geometry (tab) > 
General Tools (panel).  

 
 

 
 
 
 

c. Reference in the existing ground terrain.  If available, use a terrain that covers the 
same areas as the elements that you are converting to features.  If you don’t have 
coverage or if a void is overlapped, features may be missed in your cross sections.  
Reference in the terrain model and then make 
this terrain your active terrain model. A 
Default-3D model should have automatically 
been created by setting your active terrain. 
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d. Use the “Profile from Surface” tool to create both a profile element and 3D Linear 
Element. This tool is located in the OpenRoads Modeling (workflow) > Geometry 
(tab) > Vertical (panel). Note the “Quick Profile from Surface” tool doesn’t 
create the needed 3D Linear Element.  

 
e. Switch to the Default-3D model.  You should see the 3D Linear elements.  

 
4. Reference XSG drawings into models used for cross sections and use annotation groups 

to display cell representations in cross sections. 
 

a. When Dynamic cross sections are 
viewed, the features should appear 
with the NDDOT CADD standards 
as a feature cell (example, Existing 
R/W).  Note the scale of the 3D 
reference XSG model affects the 
scale of the label in the Dynamic 
cross section. 
 
Note Defect 1042141 ‐ Dynamic Cross Section elements from linear features with 
cross section symbology don't display when the dynamic cross section is created 
from an alignment.  These elements will display if the dynamic cross section is 
created from a corridor. 

 
b. Display of linear feature in the sheet models for cross sections is not automatic.   

The linear features need to be displayed with an annotation group.  See section 
5.10 of the CADD Standards manual for information on “Drawing Model 
Annotation”. 

 
 
3D solids can also be reference directly into the model and cut into cross sections.  These 3D 
solids don’t need to be featurized.  Note, some surfaces don’t cut into cross sections.  Solids, 
terrains and meshes work better. 
 
The drawing DS_Util.dgn should contain a 3D representation of drainage pipe and structures. 
(See also Appendix Q – Drawing Production Guidance – DS_Util) 
 

https://www.dot.nd.gov/manuals/design/caddmanual/AppendixQ/Drawing_Production_Guidance.pdf
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5.10 Cross Section Annotation Groups 
April 2022 

 
Cross sections sheets should be labeled.  Several 
Annotation Groups have been set up for labeling.  
Annotation Groups automate many labeling tasks.   
 
The “Cross Section * Scale” annotation groups are applied 
when sheets are created.   The other annotation groups are 
applied separately.  Use the “Drawing Model Annotation” 
tool to apply the annotation groups (OpenRoads Modeling 
(workflow) > Drawing Production (tab) > Annotations 
(panel).  Remember this tool works in the Drawing models 
and not the Sheet models. 
 
The Drawing Model Annotation usually needs to run 
multiple times for all the different Annotation Groups.   
 
The default “Cross Section * Scale” annotation groups may need to be edited for your specific 
templates.   The standard Annotation Definitions will most likely work but the specific points 
labeled may need to be edited.  The default groups use (on_top) and (on_bottom) location 
placement.  However, this typically labels too many points that cause overlaps making labels 
difficult to read. 
 
When an Annotation Group is first used, the Group and its Definitions are copied from the 
standards dgnlib and placed in the active drawing.   The local version of the Annotation Group 
can be edited independent of the CADD standard.  Note the local Annotation Group can not 
be edited from a Drawing or Sheet Model.  The local Annotation Group is edited from a 
Design model. 
 
From Project Explorer right click on the local Annotation Group 
to be edited.  Select manage from the popup menu.  
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The “Location” placement for “XS Point Up 
Annotation” and “XS Point Down 
Annoation” may need to be adjusted. Select 
the applicable Annotation Group.  Click in 
the Location field and then click on the 
elipses.  
 
 
 
 
Use the Annotation Filter to 
select the points to be 
labeled (important break 
points).  The Annotation 
Filter dialog can be used to 
filter points from a list 
(“Create list of Points”) or 
“Use all Points”.  Boolean 
expressions can also be 
created to fine tune your 
filter.  
 
The “XS Point Down Annotation” is 
intended to be used for dirt grade points.   
 
 
 
 
 
 
 
 
The “XS Point Up Annotation” is 
intended to be used only for surface 
(top) points.  
 
Top of base points are not typically 
labeled because sheet space is limited.  
End users may need to deduce base 
point elevations from the top of 
pavement elevation, dirt grade 
elevations and typical sections. 
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5.11 Earthwork 
April 2023 

Unsuitable Materials  
Removed materials such as pavement removals and existing topsoil need to be modeled in order 
to accurately calculate earthwork.  See Section 5.5 Corridor Modeling Templates – “Components 
and Volume Options” for a discussion on unsuitable and modeling considerations. 

Create Cut Fill Volumes 
The “Create Cut Fill Volumes” tool is used to draw volumes for earthwork calculation.  The tool 
is in the OpenRoads Modeling (workflow) > Home (tab) > Modeling Analysis and Reporting 
(panel).   
 
NDDOT standards include 2 feature definitions for cut (Volumes_Cut, Volumes_Cut_Alt).  The 
Alt version can be used to segregate volume such as wetland excavation versus roadway 
excavation.   Both definitions use a cut factor of 1. 
  
NDDOT standards include 5 feature definitions for fill (Volumes_Fill, …Fill_Alt, …Fill_020, 
…Fill_025, …Fill_030).  The Alt version can be used to segregate volumes such as bridge 
surcharge versus roadway excavations.  The …Fill_020, …Fill_025, and …Fill_030 versions use 
the respective Fill Factors of 1.2, 1.25, and 1.3.   The feature definitions with adjusted fill factors 
may not need to be used if calculations are adjusted outside of the ORD application.  In some 
cases, it may be easier to make all adjustments within an Excel spreadsheet. 
 

Calculation Methods 
There are 4 main methods to Calculate Earthwork:  

1. Analyze Volume 
2. Element Component Quantities 
3. Quantities Report By Named Boundary 
4. End are Volumes Report 

“Analyze Volume” is for basic terrain to terrain or 
terrain to elevation calculations.   
 
“Element Component Quantities” can provide a 
summary of component quantities for a corridor, but it 
provides no details by station range. 
 
“Quantities Report By Named Boundary” uses plan view 
boundaries to clip component quantities.   Drawn Cut-
Fill Volumes are required for earthwork Calculation.  
Quantities by an interval can be provided by this tool but 
no end area quantities are provided. 
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The “End Area Volumes Report” tool is based off cross section sheets.  The cross-section sheet 
boundaries are needed to use this tool. 

Earthwork Tables 
Earthwork tables shall be created for all projects that calculate volumes.  The earthwork table 
that shows volumes by station is no longer included in the plans.  However the earthwork 
“summary” table is still included in the plans.  
 
The earthwork table that show volumes by station are stored in an excel spreadsheet that shall be 
made available as supplemental design data.  

Embankment above Subgrade 
Cross sections that use a closed shape component (from template) to account for embankment 
are sections that have “Embankment above Subgrade”.  This material is usually handled twice.  
It is placed after the subgrade has been established.   
 
The feature definitions “Grnd A” and “Grnd B” have their volume options set to “Design” not 
“Fill”.  Volume Options set to Design are not automatically included in the mass ordinate.  These 
features are intended to be tracked separately and used in calculations outside of the ORD 
application.  They are usually incorporated into Excel spreadsheet calculations. 
 
All projects that have embankment above subgrade shall include a note with the summary 
of earthwork that explains special handling requirements such as double handing or 
separate construction operations.  Indicate whether the mass ordinate includes or excludes 
embankment above subgrade.  Including embankment above subgrade usually simplifies the 
mass diagram.  State that this work is paid as --- and there is no other compensation. 
 

Unintentional Earthwork Voids 
With OpenRoads earthwork, it is possible to unintentionally design voids between Roadway 
Designer Components.  A void can be created when material needs to be removed for 
constructability and it isn’t replaced by another material.  
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5.12 Earthwork Reports 
April 2022 
   

The NDDOT has a customs earthwork reports. The default earthwork reports are under the 
“NDDOT” Folder.  The NDDOT reports are in the “NDDOT” folder near the bottom of the list.  

EndAreaVolume-NDDOT.xsl 
This custom report addresses multiple types of Excavation and Embankment.   An Alternate 
excavation feature definition can be used to keep track of two separate excavation work items.  
This report also addresses feature definitions with different compaction factors.  All of the 
different excavation and embankment feature are included in the mass ordinate. 
 
Roadway component quantities usually don’t address all quantities needed for the project.  This 
report excludes quantities from civil cells and other manual calculations.  In order to avoid 
confusion and misunderstandings, only the “EndAreaVolume-NDDOT” report (without added 
roadway components) should be distributed with the supplemental design data. 

VolumesOnly- NDDOT.xsl 
This report is includes common roadway component volumes.  It does not include end areas.  
This report is intended to be run from the “Quantities Report by Named Boundaries”. 

Saving Reports 
Earthwork Reports should be saved in both the xml and xslx formats.  Within the “Bentley Civil 
Report Browser” dialog box, select File > Save As.  Then change the “Save as type” option to 
xml File.  The final posted report should be named “Earthwork_Volumes*.xml” 
A file name suffix can be used to describe multiple reports.  Repeat this workflow a second time 
while using the “Save as type” option of html and name of “Earthwork_Volumes*.xslx” 
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5.13 Bentley Civil Report Browser 
April 2022 

 
Bentley Civil Report Browser is used to generate 
many different types of OpenRoads Reports.  This 
includes alignment and earthwork reports.  Users 
may need to adjust measurement format setting for 
these reports.  This can be done within the Bentley 
Civil Report Browser by selecting “Tools > Format 
Options”.  
 
 
 
The settings shown are some common formats for the NDDOT. 
 

 
 
Presently the only custom reports for the NDDOT pertains to Earthwork Quantities.  Users may 
need to cut data from the default Bentley reports and reformat data for other plan production 
tables. 
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5.14 Mass Diagrams 
April 2022 

 
A mass diagram shall be included in the plans for most rural grading, sliver grading and 
widening projects.  A mass diagram is not needed if any of the following conditions apply: 

• Urban projects - The earthwork hauling on urban project is largely controlled by project 
phasing and traffic control. 

• Projects that are shorter than ½ mile, require no excavation, use only one borrow source 
and have a single balance in the mass diagram - These short projects may include 
independent turn lane projects, intersection improvements and small grade raises. 

 
Calculate and document the “average haul for project” on all required mass diagrams. 
 
The NDDOT uses 2 different ways to draw Mass diagrams, ORD default tools and Mass 
Diagram by Profile. 
 
The ORD default tools have a couple of deficiencies. 

1. All volumes must be modeled including borrow, waste and miscellaneous additions.  
Earthwork from a borrow or waste site cannot be added without a graphic volume.  These 
volumes must be manually drawn as needed or the mass diagram must be manually 
edited. 

2. Creating a mass diagram from multiple earthwork runs is not automated.  Example, if 
earthwork is calculated from multiple earthwork – named boundaries, multiple mass 
diagrams can be drawn but they will need to be manually merged and edited with basic 
drawing tool. 

 
Drawing Mass Diagrams with Profile tools is more involved, but it has a couple advantages. 

1. Calculations from ORD can be edited in Excel before being drawn.  This allows for 
merging multiple earthwork reports, handling compaction factors outside of ORD, and 
volume edits independent of graphics. 

2. Profile text favorites can be used to label critical mass ordinates needed in average haul 
for the project calculations. 

 
 

ORD Mass Diagram Default Tools 
The Mass Haul Diagram tool is in the OpenRoads Modeling (workflow) > Home (tab) > Model 
Analysis and Reporting (panel). 
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Multiple annotation groups for mass diagrams are included in the 
NDDOT CADD Standards.   Incorporating the mass diagram on one 
sheet is desired.  Use a scale that will allow project lenth to be 
printed on one sheet. Example a project length of 6000’ at 500 scale 
will be 12 inches long at paper scale (6000/500 = 12). 
 
Modest adjustments to the mass diagram drawing scale can easily be 
made.  If too big of an adjustment is made, the text in the axis will 
overlap or be sparsely labeled.   
 
The Vertical Exaggeration is project dependent. Use an exaggeration factor small enough so that 
the largest and smallest project mass ordinated fit on a single sheet.  Remember to use the 
exaggeration factor in haul calculations. 
 

Mass Diagram by Profile 
An Excell spreadsheet can be used to calculate mass ordinates and profile tools can be used to 
draw a mass diagram.  The entire process for drawing a mass diagram from a spreadsheet will 
not be covered in this document.  Only a few key points will be discussed. 
 
Recalculating volumes in Excel may require converting station values to numbers.  Example, 
convert the text string “14983+00.00 R1” to a number using the formula. 

=VALUE(SUBSTITUTE(LEFT(A1,LEN(A1)-3),"+","")) 
• A1 is the excel cell for the station as text.   
• The blue part of the formula trims off the right 3 characters “ R1”, removing the region 

information.   
• The red part of the formula removes the “+” character.  The purple part of the formula 

change the text to a number. 
 
Showing a number value in the stationing format may be desired. Use custom excel formatting to 
show numbers as stationing (Examples;  ##+#0, ##+#0.00) 
 
A txt file with Station and mass ordinates is used to be imported as a 
profile.  
 
Do not include the mass diagram in the same drawing as the actual 
profiles.  Copy the applicable DS_Align drawing, rename it to 
0011DT_*.   The profile reference and setting can then be cleaned and 
edited without affecting the main profile drawings. 
 
Use the “Import Vertical Geometry from ASCI File” tool to import the 
profile.  This tool is in the OpenRoads Modeling (workflow) > Geometry 
(tab) > General Tools (panel). 
 
Manually create a profile drawing (mass diagram).  Use an applicable annotation group as 
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discussed in the default mass diagram tool workflow.  The profile drawing and scale should be 
set up so that the diagram will fit on one sheet. 
 

Haul Calculations 
 
Measure haul, calculate excavation hauled and average haul distance for the project. Labeling 
average haul for each balance is not recommended. 
 

1. Calculate and label the Haul for each balance.   
a. The haul for each balance is the adjusted area between the mass diagram and the 

neutral axis. 
b. Haul = Adjusted Area = MicroStation Area / (exaggeration factor) 
c. The “Adjusted Area” from the mass diagram is in the measurement “CY*Ft”.  

Haul is usually noted in “CY*Sta” or “CY*Mile”. Convert the measurement as 
necessary (divide by 100 or 5280 respectively). 

 
2. Calculate and label the “Excavation Hauled” for each balance.  The “Excavation Hauled” 

for each balance is the sum of all upward movement in the mass diagram.  
a. Excavation Hauled within the balance = 

Sum Mass Ordinates of all peaks or highs within the balance  
- (minus) 
Sum Mass Ordinates of all valleys or lows within the balance  

 
3. (Optional) Calculate and label the “Average Haul Distance for the Balance”.  

a. Average Haul Distance for the Balance = 
Haul for the Balance 
/ (divide) 
Excavation Hauled within the balance  
 

4. Calculate and label the “Haul for the Project”.  This is the sum of haul for all balances or 
the sum of adjusted area between the mass diagram and the neutral axis. 
 

5. Calculate and label the “Excavation Hauled for the Project”.  This is the sum of 
Excavation Hauled for all balances. 
 

6. Calculate and label the “Average Haul Distance for the Project”. 
a. Average Haul Distance for the Project = 

Haul for the Project 
/ (divide) 
Excavation Hauled within the Project  
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Annotate Mass Diagram  
Annotate mass diagram with haul and key mass ordinates 
(excavation hauled). The NDDOT standards include at text 
favorite to label key mass ordinates.  
 

 
 
 
 
 
 
 
 
 
 

 
A sheet model with the applicable sheet cell will need 
to be manually created.  Using the Named Boundary 
tool by Drawing Boundary  
(Detail_View_2D_Sheet_Only) is  a good way to 
make the sheet model.   
 
 
  



CADD Standards 
 

5.15 Sheets (Named Boundaries) 
Aug 2022 

 
ORD Sheets are created with the Named Boundary tool found under the OpenRoads Drawing 
Production (workflow) >, Drawing Production (tab). 
Plan sheets can be cut with or without an alignment.  Plan and profile sheets require an alignment 
with a profile. Cross Sections require an alignment and a 3D model.   
 
Creating sheets from an empty dgn that references other files is a recommended workflow that 
can help you manage files.  Example, create a 060pp* drawing that is used as a pointer file.   

Plan Only Sheets Using an Alignment 
1. Create a dgn such as 090PL.dgn and reference in applicable dgn’s for the sheets. 
2. Access the Named Boundary Tool (OpenRoads Drawing Production > Drawing 

Production). 
3. Set the type of boundary to 

“Civil Plan”.  Then pick an 
applicable Drawing Seed.  
Note plan and profile sheets 
are also included in “Civil 
Plan” boundaries, but these 
types of sheets will be 
discussed later in this chapter.  

4. Selecting a “Drawing Seed” 
will adjust many of the 
Named Boundary settings 
such as: 

• Detail scale 
• Name 
• Group 
• Length 
• Offsets 
• Overlap 
• Boundary Cords 

The first (top) “Name” in the dialog box is for the drawing model name.  This can be 
changed if desired or left as the default.  Make sure the “Create Drawing” and “Show 
Dialog” options are selected. 
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5. Follow the prompts shown in the ORD (MicroStation) status bar (lower left). 
• Identify path element – Pick Horizontal Alignment 
• Identify path start point to place boundary - Start location 
• Identify path end point to place boundary – Stop location 
• Data point in plan view to place boundary 

The start and stop locations – stations could also be typed in the dialog box. 
 

6. After the “Data point in plan view to place 
boundary” prompt is completed, the Create 
Drawing dialog box will open. The settings 
in this dialog have been setup with the 
CADD standards (sheet seeds settings).  
The “Add to Sheet Index” and “Open 
Model” optional settings that are 
sometimes adjusted.  The other settings are 
usually left as is.  Select the OK button to 
create sheets. 
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7. The north arrow is placed using an offset from the alignment.  The NDDOT CADD 
standards intended to place the north arrow in the upper left corner of the sheet.  On tight 
curves, the north arrow will need to be manually moved.  The north arrow has been 
placed in the drawing model.  Move the arrow in the drawing model if it falls outside of 
the sheet boundary. 

 
Note that in areas where the sheets are cut from curved alignments, there will be a gap on 
the right side of the sheet because a literal length is used to stop the boundary. 
 

8. Note, the named boundaries used for the sheets are on a dedicated level that is in the 
construction class.  NDDOT pen tables will turn off construction class elments for 
printing. 
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Plan Only Sheets Placed without an Alignment 
1. Create a dgn such as 120MK*.dgn and reference in applicable dgn’s for the sheets. 
2. Access the Named Boundary Tool (OpenRoads Drawing Production > Drawing 

Production). 
3. Rotate the view as desired for the sheet. 
4. Set the type of boundary to “From Drawing Boundary”.  Then pick an applicable 

Drawing Boundary.  Note the “…Sheet_Only” Drawing Boundaries do not use an 
intermediate “Drawing” model.  

5. The “Name” can be changed to name the 
drawing or sheet model.  The scale 
should be adjusted as needed.  Turn on 
the “Create Drawing” option.  

 

 
 
 
6. Place the boundary with your cursor. Then 
the Create Drawing dialog box will open.  
Adjust the sheet annotation scale to match the 
Detail Scale used for the Drawing Boundary.  
See the “Sheet Index” section of this document 
for information about the “Add to Sheet Index” 
option. Click OK to create the sheet. 
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Plan and Profile Sheets 
1. Create a dgn such as 060PP.dgn and reference in applicable dgn’s for the sheets. 
2. At least 2 view windows need to be open, one for the plan view including the alignment 

and another view for the profile.  See the ViewSet Macro section of this manual for 
related helpful tools.  

3. Access the Named Boundary Tool (OpenRoads Drawing Production > Drawing 
Production). 

4. Set the type of boundary to “Civil Plan”.  
Then pick an applicable Drawing Seed.   

5. Selecting a “Drawing Seed” will adjust 
many of the Named Boundary settings such 
as: 

• Detail scale 
• Name 
• Group 
• Length 
• Offsets 
• Overlap 
• Boundary Cords 

6. The first (top) “Name” in the dialog box is 
for the drawing model name.  This can be 
changed if desired or left as the default. 
The second “Name” is for the Named Boundaries.  Renaming the Boundary group can 
help you manage multiple groups of sheets in one dgn.  The “Create Drawing” and 
“Show Dialog” options do NOT need to be selected. 

7. Follow the prompts shown in the ORD (MicroStation) status bar (lower left). 
• Identify path element – Pick Horizontal Alignment 
• Identify path start point to place boundary - Start location 
• Identify path end point to place boundary – Stop location 
• Data point in plan view to place boundary 

The start and stop locations – stations could also be typed in the dialog box. 
8. If you left the Create Drawing and Show Dialog setting turned on, the Create Drawing 

dialog will open.  This dialog is not needed at this time.  Cancel the dialog.  At this point 
just the Named Boundaries have been placed, no additional models have been created. 
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9. Access the Named Boundary Tool 
a second time.  This time set the 
type of boundary to “Civil 
Profile” and set the Drawing Seed 
to the applicable scale that 
matches the seed used for the 
“Civil Plan” view. 

10. Many of the settings will be 
populated from the Drawing Seed.   
Set the Method to “From Plan 
Group” and select the Plan Group 
from the drop-down list.  

11. Follow the prompts shown in the 
ORD (MicroStation) status bar 
(lower left). 
• Identify profile view 
• Data Point in profile view to 

place boundary 
• Data Point in the profile view 

a third time to accept boundaries. 
12. The Create Drawing Dialog box should open.  Again, most of these settings will be 

correctly set by the previously selected sheet Seed.  The “Add to Sheet Index” is an 
option to consider. See Sheet Index chapter.  Click the OK button to create the sheets. 

 
13. Once the plan and profile sheets are created, additional manual adjustments will be 

required similar to step 7 for “Plan Only Sheets Using an Alignment” instructions. 
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Cross Sections Sheets 
 

Cross Sections Interval  
The following are recommended minimums cross section sheet intervals.  These intervals are not 
the same as Template Drop intervals. Neither are these standards a construction field staking 
standard. 
 
Recommended Minimums  

• Rural projects should use an interval of 100’ and  50’ within super elevated curves and 
spirals.   

• Urban (curb and gutter) projects should use an interval of  25’.   
• Extra cross sections should be added for all centerline pipe.   
• Extra cross sections should be added at all super elevation key stations such as; end 

normal crown, begin super, begin full super, end full super, end super, and begin normal 
crown. 

• Extra cross sections should be added for wetland areas.  The interval of cross sections 
through a wetland should be between 10’ and 50’.  If the wetland cross section is 
generally uniform in shape such as a linear ditch wetland, a long interval can be used.  If 
the wetland doesn’t have a uniform linear shape a shorter interval should be used to show 
changes in in-slope, width and depth.  If there is onsite wetland mitigation or a wetland is 
to be moved, the cross sections need to show enough detail and use a short enough 
interval to properly construct the wetlands.  Designers should also consider providing 
additional drawings in the plans if these changed wetlands have an irregular shape. 

 
Other additional “Optional” cross sections have been considered in the CADD standards. The 
recommended minimum intervals are close together and address these “Optional” cross sections 
to a degree.  Additional sections can be used at the designer’s discretion.  These additional – 
optional sections may include: 
 
Optional (extra cross sections) 

• Intersections, approaches and driveways  
• Inlets, ADA ramps, building entrances 
• Horizontal roadway breaks such as begin taper, end taper, begin lane, end lane, PC’s, 

PT’s, curve returns and others. 
• Vertical curve breaks such as PVC’s and PVT’s. 
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Creating Cross Section Sheets 
1. Create a dgn such as 200XS.dgn and reference in applicable dgn’s for the sheets.  This 

should include the 3D - corridor model, terrain, and alignment. 
2. Set the active terrain model.  Setting the terrain model active will also create a Default-

3D Model 
3. At least 2 view windows need to be open, one for the plan view including the alignment 

and another for a 3D view of the corridor.  See the ViewSet Macro section of this manual 
for related helpful tools (View Control > Views Plan/3D).  

4. Access the Named Boundary Tool (OpenRoads Drawing Production > Drawing 
Production). 

5. Set the type of boundary to “Civil Cross 
Section”.  Then pick an applicable Drawing 
Seed.   

6. Selecting a “Drawing Seed” will adjust 
many of the Named Boundary settings such 
as: 
• Detail scale 
• Name 
• Group 
• Offsets 
• Interval 
• Vertical Exaggeration 
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Follow the prompts shown in the ORD (MicroStation) status bar (lower left). 
• Identify Path Element (horizontal alignment) 
• Identify path start point to place boundary 
• Identify end point to place  boundaries 
• Data Point in plan view to place boundaries 

 

7. The Create Drawing Dialog box should 
open.  Again most of these settings will be 
correctly set by the previously selected 
sheet Seed.  The “Add to Sheet Index” is an 
option to consider. See Sheet Index 
chapter.  Click the OK button to create the 
sheets.  
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5.16 Sheet Index 
April 2022 

 
The Sheet Index can store title block information for the individual sheets.  The sheet index can 
be used to change title block information in multiple sheets at one time.  Sheet Index information 
is stored in the workset parent folder in a dgnws file.  
Example: 

S:\STANDARD\CE(XX)\WorkSpaces\Design\WorkSets\00000000.002.dgnws 
This file is created when the project workset is first created.  The dgnws is originally created 
from a template file that is located at: 
 S:\STANDARD\CE(XX)\WorkSpaces\Template\WorkSetTemplate.dgnws 
The dgnws should be setup before creating sheets.  There will be complications using a sheet 
index that was created after the sheets were created.  The dgnws only works with Sheet Models.  
Sheets that were setup in simple design models will not work with the dgnws.   
After the workset (dgnws) has been created, it is accessed by selecting the workset, opening a 
dgn, and opening ORD Explorer.   The Sheet Index is a tab within Explorer. 
Dgnws information is linked at different levels. 

• Advance Properties 
• Index Properties 
• Folder Properties 
• Sheet Properties 

The following is an overview of where NDDOT standard 
values are stored. 

• Advance Properties – NDDOT is not currently 
using. 

• Index Properties 
o PCN 
o Project Number 

• Folder Properties 
o LS Date 
o LS Name 
o LS Number 
o PE Date 
o PE Name 
o PE Number 
o Section Number 
o Title Block Lines 1 through 8 

• Sheet Properties 
o Sheet Values 1 through 8 
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Additional index fields can be added.  These are only the fields delivered in the NDDOT 
template.  There is only one set of parent Index Properties per workset. Therefore, the PCN and 
Project Number are set at this level.  The Folder Properties allow multiple sets of Index values.  
Each folder can contain another set of these values.  The sheet properties are actual sheet model 
properties.  They are usually unique to each model.  These fields are not setup in the standard 
sheets but are provided for custom workflows and custom tables. 
 
The following is an overview of using a sheet index. 

1. Create a project workset.   
 

2. Create sheets within sheet models. 

 
 
 
 
 
 

3. Open the Explorer and the Sheet Index tab.  
 

4. Open the sheet index for Editing.  By default, the 
Sheet Index is set to read only. 

 
5. Create folders for different groups of Index 

values.  Usually at least one folder is setup for 
each section of the plans.  Note Element 
Information needs to be used in conjunction with 
Explorer to change field values. 
 
 

6. Adjust Index values by selecting folders or files and using Element Information. Note the 
order of this step and step 7 can be interchanged.  
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7. Add sheets to the appropriate folders.  The sheet models 
will automatically inherit the sheet index values for the 
folder. 

 
 
 
 
 
 
 
 
 
 
 

8. Modify sheets with sheet values if desired.  These 
Adjustments can be made with the Text Editor and 
Field Editor.  Right click in the Text Editor and select 
Insert Field.  
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9. From the Field Editor Select the property that is desired for the field. 

 
10. Changes to the Sheet Index might not immediately change 

values in the active model.  The active model can be updated 
by switching to a different model and then reopening the 
model were updates are desired.  The “Update All Fields” 
tool can also be used to sync changes in the sheet index and 
the sheet model text.   This tool can be found in the 
“Drawing” workflow, “Annotate” tab, “Text” panel.  Its 
within a split menu.   
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5.17 ViewSet and SnappableToggle Macros 
April 2022 

 
The ViewSet Macros are used to adjust views to common formats and perspectives. Some of 
these macros are available through a right click popup (Context Menu) menu, some of them are 
available through the default roadway design function keys and some are available in both 
context menu and function keys. 
 
Right click and press on a view to open the 
popup menu.  Several of the ViewSet Macros are 
under the “View Control” flyout menu.  
 
Some of these tools prompt you to interact with 
microstation elements such as an alignment.  
These tools will coordinate with the microstation 
elements to open Multi-Model Views. 
Some Multi-Model Views are required for 
specific workflows like using named boundries 
to create sheets.  The ViewSet Macro is 
discussed in these workflows. 
 
 
 
 
 
 
 
 
 
 
The SnappableToggle works with elements on levels “Sht Lines 2” to “Sht Lines 6”. The 
SnappableToggle enables or disables snapping or displaying for elements on these levels.  It is 
intended to be used where sheet gridlines could complicate workflows.   
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The default roadway design function keys access some of these macros.  The following table lists 
the subroutines, function key (if any) and context menu tool name (if any). 
Subroutine Key Context Menu Tool Name 
SnappableToggle Shift+F1   
LevelsToggle Shift+F2   
ExaggerateZForAttachment Shift+F4 Exaggerate Z for Attachment 
FourView Shift+F5 4 Views Plan/Profile/XS/3D 
ToggleViewLineWeights Shift+F6   
ToggleViewConstructions Shift+F7 Toggle Construction Class 
Toggle Shift+F8 Toggle 
TwoView3DF9 Shift+F9   
SetActiveModeltoDrawLast Shift+F10 Ref Adjust Colors 
AnalyzeTerrainModelPoint Shift+F11   
DeleteUnusedFonts Shift+F12   
OneView   1 View 
TwoView3D   2 Views Plan/3D 
TwoViewsPLPROF   2 Views Plan/Profile 
TwoViewsPLSE   2 Views Plan/Superelevation 
TwoViewsPLXS   2 Views Plan/XS 
ThreeViewsPLPROF3D   3 Views Plan/Profile/3D 
ThreeViewsPLXS3D   3 Views Plan/XS/3D 
AccuDrawToggleOnOff     
TwoView     
ThreeViewsPLPROFXS     
ThreeViewsPLSuperXS     
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5.18 Text Favorites and Labels 
Aug 2022 

 
“Text Favorites” are annotation linked fields that can be stored for repetitive use.   These linked 
fields can be used to automate civil labels like station, offset, and elevation as well as many other 
properties.  The “Place Label” and “Civil Labeler” tools use text favorites fields to build labels 
from the “Text Favorite” settings.  The “Place Label” and “Civil Labeler” tools are accessed 
from the “OpenRoads Drawing Production (workflow) > Drawing Production (tab)”. 

  
 
The Place Label settings need to be manually coordinated.  Only 
some combinations of settings are applicable CADD standards.   
 

• Presently the NDDOT doesn’t have a cell library for 
Labels that include “text favorites”.  The text favorites 
(without cells) are used. 

• Many text favorites are view dependent (plan, profile or 
cross sections).  Select a text favorite that is applicable 
to the active model. 

• The Place Label tool doesn’t use the level for the cell or the dimension style.  The Place 
Label tool uses the active level.  Make sure you set the applicable level before using this 
tool. 

• The Place Label tool uses the text styles stored with text favorite.   Variations of similar 
Text Favorites have been created with different text style associations. 

Text Favorites Format Text Style 
Plan Sta O/s Plan Decimal 05 Sta 0+00.00 O/s 0.00 Rt Text 0.05 
Plan Sta O/s Plan Decimal 06 Sta 0+00.00 O/s 0.00 Rt Text 0.06 
Plan Sta O/s Plan Decimal 07 Sta 0+00.00 O/s 0.00 Rt Text 0.07 
Plan Sta O/s Plan Decimal 08 Sta 0+00.00 O/s 0.00 Rt Text 0.08 
Plan Sta O/s Plan Decimal 09 Sta 0+00.00 O/s 0.00 Rt Text 0.09 

• Select a dimension style that matches the text style within the text favorite.  Example 
Dim 0.07 for Plan Sta O/s Decimal 07. 

• Look for prompts when using the labeling 
tools.  Example, you may need to select a civil 
alignment to use a text favorite for stationing.  
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The “Civil Labeler” is like the “Place Label” tool, but it does some things better. 
• Civil Labeler coordinates setting better. 

o Can use element templates 
o Use a hierarchy for text and dimension styles. 
o Settings are saved and organized in a folder structure. 

• Civil Labeler can work with multiple targets at the same time.  Example an intersection 
of alignments accesses both alignment stationing. 

• Civil Labeler has additional association locks to control edits.  Both tools have Element 
and Relative association.  However, Civil Labeler also has Annotation and Rotation 
association locks. 

The biggest advantage of the Place Label tool is that it works with cells that are built with text 
favorites. 
 
Several Bentley labels are included with the NDDOT standards.  The Bentley labels have not 
been fully standardized for plan production.   The Bentley labels are included to show users what 
the tool can produce and to encourage expansion of the NDDOT standards. 
 
The labels in the folders Bridge, Design, 
Photo and Traffic are more refined for 
NDDOT plan production. The Civil 
Labeler is a new tool for the NDDOT and 
these refinements are ongoing. The folders 
are intended to group standards by 
NDDOT organization sections.  Certain 
sections are responsible for certain 
drawings and the applicable labels should 
be used accordingly.  
 
Like the Place Label tool, look for prompts when using the 
Civil Labeler.  Example, you may need to select a civil 
alignment to use a text favorite for stationing. 
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5.19 Alignment Data Sheets 
Aug 2022 

 
Alignment Data Sheets (082SD_*.dgn) are plan sheets used to communicate alignment data and 
points for topographical features such as curb radii and Manholes. In this process, electronic text 
files (CSV – Comma Separated Values) are created that can be imported into survey equipment 
and corresponding paper documents are created.  Surveyors should not have to key in this 
information.  The following is an overview of the Alignment Data Sheet workflow. 

1. Create an ADP*.dgn and reference applicable drawings. 
a. Consider using managed models (civil coordinated 2D and 3D models). 
b. Reference the applicable alignment dgn that the points will be associated within 

the tables. 
c. Design*.dgn and DS_Util*.dgn are typical references. 
d. Consider using the ADP*.dgn as a live reference for the 082SD sheets. 

 
2. Place Civil Geometry Points.   

a. See “OpenRoads Modeling (workflow) > 
Geometry (tab) > Horizontal (panel) > Points. 

b. The ADP feature can be used for both 2D and 3D 
Alignment Data Points.  However, a second 
similar feature is also available if segregating 2D 
and 3D points is desired. The ADPZ feature (z = 
elevation) is intended for 3D Alignment Data 
Points.  The ADP feature could be used for only 
2D points and the ADPZ feature could be used 
only for 3D points.  

c. The Elevation Mode should be set to “None” for 
2D points and “Value” for 3D points. 

 

d. After points have been placed, use Element Annotation to automatically place the 
point labels.   Wait to move labels for clarity purposes until late in the workflow.  
Realize removing and replacing Element Annotations will negate previous 
repositioning of labels. 
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e. Consider labeling applicable curve and 
radius point in a manner that lets people 
know the two are associated with each 
other.  In this example ADP11 is the 20’ 
radius point for the curve shown.  

 
 
 
 
 
 
 

3. Create 082SD sheets for the plans.  Laying out these sheets will help set boundaries for 
the individual sheet CSV reports. See Section 5.15 for guidance on using Named 
Boundaries for sheet creation. 

 
4. Create CSV reports for plan sheets and for construction surveying. 

a. See “OpenRoads Modeling (workflow) > Home (tab) > Model Analysis and 
Reporting (panel) > Reports > Point Feature Station Offset Elevation Report. 

b. The default report will open to a 
StationOffsetElevationFeature report.  Other 
report formats are available.  This Section will 
focus on NDDOT custom formats intended to 
create CVS files.  

i. ADP_Plans* reports are intended for 
plan sheet tables. Separate reports 
should be saved for each plan sheet 
table. 

ii. ADP_Surveyor* reports are intend to be 
given to surveyors for actual staking. 
One report can be created for the entire 
project. Don’t forget to supply this file 
in the project supplemental design 
data (Post on MFT Site). 

iii. The reports with a *Z* in the name are 
intended for elevations. 
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c. The report can be saved to the csv format but it is not listed as a File > Save As 
option. 

i. Choose File > Save As > Microsoft word. 
ii. Change the “Save as type” to Text File. 

iii. Provide a File name with a csv extension. 
iv. Save the document.  Files saved in this format should not need to be 

reformated for imports. 
5. Using table seeds to import the sheet CSV reports (ADP_Plans*) into the individual plan 

sheets. 
a. Open the applicable plan sheet model. 
b. Select the Table tool. One of the locations the 

tool can be located is OpenRoads Modeling 
(workflow) > Drawing Production (tab) > 
Place Table.  

c. Within the Place Table dialog, select the 
“From file” option. 

d. Pick a table “Seed”.  The table Seed sets 
headers and formatting.    

i. ADP_2D is for files with no elevation 
column. 

ii. ADPZ_3D is for files with an elevation column. 
e. Select a CSV report file that was created in the previous step. 
f. The table will be shown 

attached to the cursor.  
Place the table on the 
sheet.  There is a 
placement point in the 
sheet cell that can be 
used to consistently 
place text or tables.  
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Axiom 
 

6.1 Axiom Settings Files 
April 2023 

 
Axiom stores setting in “*.ini” (initialization) files.   Currently the NDDOT has the default ini 
files. 

• tbadmin.ini (title block administrator) 
• office.ini (Office Importer for Quantities) 
• office_RW.ini (Office Importer for RW sheets) 

 
The following DOS batch file will copy the above files on your computer.  NDDOT CADD 
standards will look for these files when using Axiom TBA or Office Importer. 
 
 S:\STANDARD\CE*\Install\Axiom\Copy_ini.bat 
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6.2 Axiom Title Block Manager 
Jan 2019 (minor edits) 

 
The Axiom Title Block Manager (TBM) tool is used to edit (manage) MicroStation title blocks 
and tags.  This tool allows multiple title blocks and tags from multiple drawings to be edited 
from one spreadsheet. 
 

1. General Title Block Manager Setup 
a. Only the Central Office has access to this tool.  The tool “Title Block 

Administrator” should be available within MicroStation under the Axiom pull 
down menu. 

b. TBM will work with a blank Microsoft Excel spreadsheet.  Users can save a 
blank spread sheet to their project directory before they start TMB or this can 
be created while running TBM (see step 2c).  Using a preformatted 
spreadsheet is not recommended. 

c. Don’t Drop your Sheet Cells.  Your Tags and Title Blocks will have to be 
recreated.  Dropping cells should be avoided, because it takes time and can be 
complicated. 

d. This section doesn’t discuss TBM in detail.  For more information on TBM 
see Axiom’s User Guides; 
M:\APPS\Production\Design\AxiomV10\TBAdmin\TBAdminV10.pdf 
 

2. Update Title Block Manager Excel Spreadsheet from Selected Drawings 
a. In Title Block Administrator’s main dialog box, Select Action: “Update 

database from selected design files.” 
b. Click the <Select> button to the right of the “Design Files:” field.  The dialog 

that opens allows you to select a batch of files for processing.  Select the files 
that you want to manage.  You need “write access” to these files and they 
should all use standard sheet cells.  After selecting the files that you want to 
manage, click <OK> to return to the Title Block Administrator main dialog. 

c. Select your database (Excel Spreadsheet).  This could be an empty spread 
sheet that you created before you started TBM or you can have TBM create 
one for you now by typing in a path and file name.  Remember Excel files 
have an xls extension.  Also note that spreadsheet can’t be open while you run 
TBM. 

d. Select a name and location for your report file.  Example (c:\temp\TBM.rep).  
This file only documents what you have done. 
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e. This step is optional.  If you want to work with just one type of tag set within 
one spread sheet, the specific tag set or sets can be specified in the TBM 
settings.  Example, if you only want to edit just DIP tags in one spread sheet, 
you would select “Settings>Change Settings” from the TBM pull down menu.  
Then you would type “bordercell” in the “Tag sets to process” field.  Note, the 
character “*” can be used in the “Tag sets to process” field.  The “*” character 
means it will process all tags within the drawing. 

f. CAUTION, if you process multiple tag sets at one time, your spread sheet 
may imply false tag relationships.  Example, you may need to process a cell 
with the tag sets named “bordercell” and “titleblock”.  The tag named 
“bridge” is part of the tag set named “bordercell”.  However your spread sheet 
will contain a cell for the tag named “bridge” in the tag set named 
“titleblock”.  This is a false relationship.  Nothing will happen if you fill it in 
because it doesn’t exist within your drawing.  These false fields are not 
important if you remember that they are not used.  You must be aware of 
which tags belong to which tag set. 

g. Click the Start button to begin the update. At the end of processing, you will 
see summary totals.  Click <OK>. 

h. Now you can select <Display Report> to see a summary of what was done. 
i. Open the Excel by pressing the <Edit Database> button to see what was 

added. 
 

3. Update Selected Drawings from Title Block Manager Spreadsheet 
a. If you just completed step 2, your file list is still there as <Edited File List>.  

If not, use the <Edit List> dialog to select your files. 
b. Open database by clicking on the <Edit Database> button. You will see all of 

your design files represented one row per tag set.  Note most sheet cells have 
multiple tag sets. 

c. Edit the data fields as needed.  The data fields have been grouped by tag sets.  
You may have to sort on the tag set name in order to edit groups of data fields.  
Note, page and section numbers should not use preceding zeros – place 
holding zeros in the title blocks. 

d. Save and close the spreadsheet. 
e. In MicroStation - Axiom, change the “Action:” to <Update selected design 

files from Database>.  Make sure that your TBM spreadsheet is selected and 
you have specified a report file. 

f. Now click <Start> to begin the update. At the end, you will see summary 
totals. 

g. Click <OK> to those totals. 
h. Open the MicroStation files to see your changes. 
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6.3 Axiom Office Importer 
April 2023 

 
Axiom Office Importer relies on both Microsoft Office and Axiom setting to accommodate 
NDDOT CADD Standards.  See section 6.1 for an overview of Axiom settings.   The following 
is an overview of Microsoft Excel setting to be used with quantities placed in sheets such as 
040RM, 060PP, and 090PL sheets.  These sheets have a 4” wide area on the right side of the 
sheet for quantity tables. 
 
Excel Settings 

Font Size 10 
Height 15 
Width Column 1 (SPEC) 6 
Width Column 2 (CODE) 7 
Width Column 3 (BID ITEM) 50 
Width Column 4 (QUANTITY) 7 
Width Column 5 (UNIT) 7 
Justification Column 1 (SPEC) Center 
Justification Column 2 (CODE) Center 
Justification Column 3 (BID ITEM) Left 
Justification Column 4 (QUANTITY) Right 
Justification Column 5 (UNIT) Right 

 
Notes 

• Place line spacing in MicroStation is approximately 2 (1.95) times text height. 
• Some advanced characters might not work with the NDDOT true type font. 

o The following hardcoded characters don’t work. 
 Left Single Quote 
 Right Single Quote 
 Left Double Quote 
 Right Double Quote 

o Simple “Single Quote” and “Double Quote” work. 
• Office Importer for RW legal descriptions is set up for Microsoft Word with 11 point text 

size. 
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Other Standards and Procedures 
 

7.1 As-built Plans   (Record Drawings) 
April 2022 

 
The “Construction Records Manual” (Section 7) discusses what is to be included in As-Built 
Plans.  The decision document “NDDOT As-built Plan Process”, June 2018, provides additional 
guidance.  Most As-Built information is documented with Adobe commenting tools. As-built 
cross sections are one of a few types of drawing where CADD tools are required.    
 

Adobe Edit tools for As-builts 
The as-built documents should preserve all as-design information.  Adobe edits are often 
indistinguishable from original information.  Therefore, Adobe Edit tools should be avoided for 
as-built documents.   

Adobe Commenting tools for As-builts 
Some adobe comments need to be expanded to be fully displayed or read.  Sticky notes, 
attachments, and notes within other commenting graphics may not be fully visible when the 
document is first open.   Today, Adobe commenting tools are common practice.  In the distance 
future these tools may be replace by other technology.  Therefore, compressed comments should 
be avoided for as-built documents. 
 

 
 
Recommended Adobe commenting tools for as-builts include Add Text Comment, Add Text 
Box, and Drawing Tools are recommended. 
 
Blue text and graphics are recommended for documenting As-built changes.   
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CADD tools for As-builts 
Cross sections are an example of when CADD tools may be needed to be used with adobe tools 
to create as-built documents. CADD tools can be used, but the ultimate As-Built deliverable is in 
pdf.   

• All as built information that is different than the information from Design will be kept in 
an As-built subfolder located in the project directory, usually located under a district or 
consultant subfolder.   

• The as-built changes should only be made to the new files within the as-built folder.  
Include only the features that have changed from the original design. Separate drawing 
will be needed to manage symbology overrides. 

• Traditional as-builts are black and white except for the as-built information.  As-built 
information should appear blue.  When creating as-built drawings the ‘level symbology” 
for all design drawings should be set to color “0” (black and White) and the “level 
symbology” for all as-built drawings should be set to color “1” (blue).  This symbology 
should produce a black, white and blue set of plans. 

• As-built drawings are the only drawings where a suffix modifier is mandatory.  All as-
built drawings are to be named with a suffix modifier “AB”. 

 
Most as-built drawings reference the original design drawings.  Referencing is usually preferred 
over copying because changes can be quickly identified, and it is less redundant.  The as-built 
terrain is typically added to the cross sections.  The as-design model is typically displayed with 
the as-built info. 
 
 
 
  



CADD Standards 
 

7.2 Design Division’s Quick Maps  
Jan 2019  

 
This tool can be used to create maps for “Design Plan Title Sheets” and reports.  The Design 
Division’s Quick Maps are accessed through the web; 
http://gis.dot.nd.gov/external/ge_html/?viewer=ext_quickmap 
 
If you just want a simple county map, don’t use this service. County maps as pdf’s can be 
retrieved from https://www.dot.nd.gov/business/maps-portal.htm#countybasemaps .   
 

http://gis.dot.nd.gov/external/ge_html/?viewer=ext_quickmap
https://www.dot.nd.gov/business/maps-portal.htm#countybasemaps
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7.3 Tags, Professional Stamping and Signing 
April 2022 

 
Most Consultants and NDDOT Districts don’t have Axiom Title block Manager.  However, 
these people still need to use the same sheet library (sheets.cel) and still have to address the 
professional engineer stamping requirements.  The following notes discuss how these users can 
operate. 
 

1. The sheets library has been modified.  Most of the title blocks for the sheet cells have 
been filled with “tags”.  Tags are special MicroStation elements that look like “text” 
elements. 
a. These tags have been added so that the sheet cells can be used with Axiom 

Title Block Manager.  However, you don’t need TBM to edit these tags.  The 
tags can be edited with just the MicroStation “Edit Tags” tool. 

b. Title block tags can be deleted without dropping the cell.  So if you don’t want 
to use them, they can be deleted and you could fill out the title blocks with 
normal text.  However, the Standard Committee recommends using the “Edit 
Tags” tool.  The preformatted tags are setup with the standard symbology. 

 
2. Several of the standard sheets have a title block for a profession engineer’s or 

registered surveyor’s stamp.  The PE-LS Electronic Distribution Statement is no 
longer used and does not need to be filled out. 
 
In order to avoid having to maintain multiple versions of a drawing (preliminary and 
one for stamping), special print drivers and pen tables are being used to control when 
the PE note is printed and when it is not printed.  The following pen tables are used;  
a. Preliminary.tbl  
b. PE_Stamping.tbl  

 
3. The title sheet has several signature lines. These lines are left blank in the dgn file and 

are completed with digital signatures in the pdf file.  The digital signature graphic 
includes typed name, signature graphic and date. 
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7.4 Addenda and Change Orders  
April 2022 

 
Plan revisions before the Bid Opening are referred to as Addenda.  Plan Revisions after the Bid 
Opening are referred to as Change Orders. 
 
All plan sheets cells have an area (revision block) reserved for addenda and change order 
information.  This revision block is part of the upper left title block. 
 

 
 
Addendum and Change Order plan sheets shall include the words “Revised” or “Sheet Added”, 
as applicable, and the date in this revision block. If the sheet was previously revised as an 
addendum or change order, keep the original revised note and add another one (example: 
Revised 2-10-10, Revised 3-07-10).  If the project is moved to a later bid opening or if the 
project is rebid, the revision block should be reset to “null” entries (blank fields) and the sheet 
should be included in the plans as a normal sheet. 
 
This revision block contains a MicroStation tag set Named “Revision_Box”.  This block contains 
enough tags for 4 revisions.  There are tags to describe the type of change (“Revision” or “Sheet 
Added”) and tags for the dates.  The Revision_Box tag set can be edited with Axiom Title Block 
Manager or the standard MicroStation “Edit Tag” tool.  The default tag values are empty.  You 
cannot see the tags when the sheet cell is first placed, but they are still part of the cell. 
 
If an addendum or change order added or voided a plan sheet, the plan sheet containing the table 
of contents must also be revised as part of the change.  The table of contents does not need to be 
revised if the revised sheets are already listed. 
 
If sheets need to be added in the middle of a section, alphabetical suffixes should be added to the 
sheet number (example: section 80 sheet 10A, section 80 sheet 10B, section 80 sheet 10C …).  
Alphabetical suffixes should only be used for sheets added with an addendum or a change order.  
These suffixes should not be used in the original plans.  The original plans should always be 
renumbered if sheets are added. 
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When the plans are signed, all of the files should be set to read only. The read only setting shall 
not be turned off.    
 
All plan revisions (addenda and change orders) shall never be made in the original files.  The 
original files shall never be edited after they have been signed and sealed.  If changes are needed, 
copies of the files should be made. 
 
All plan revision information shall be kept in separate folders located in the designers’ 
corresponding project directory.  A separate folder shall be used for each addendum and change 
order that is issued.  A new folder named “Addendum (followed by a letter) shall be added for 
each addendum that is issued (Ex. “Addendum A”). Likewise, a new change order folder 
(followed by a letter) shall be added for each change order that is issued (Ex. ChangeOrder A.) 
When the next revision is added, the folder should end with the next letter in the alphabet.  
 
The dgn files use letters to indicate versions.  Final pdf files use numbers to indicate 
versions.  The dgn files use letters because the actual version “number” might not be 
known at the time it is created or it could change between the time it is started and when it 
is completed.  
 
Examples:  R:\project\80046083.017\DESIGN\Addendum_A 

R:\project\80046083.017\DESIGN\Addendum_B 
R:\project\80046083.017\DESIGN\Addendum_C 
R:\project\80046083.017\DESIGN\ChangeOrder_A 
R:\project\80046083.017\BRIDGE\ChangeOrder_ A 
R:\project\80046083.017\BRIDGE\ChangeOrder_B 
R:\project\80046083.017\TRAFFIC\ChangeOrder_A 

 
The original files should not be modified for addenda and change orders.  If changes need to 
be made to a file, the file should be copied into the respective addenda or change order folder 
and a suffix modifier shall be added to the end of the filename.  Addenda shall use the modifier 
“AD” followed by the group letter.  Change Orders shall use the modifier “CO” followed by the 
group letter (example: 060PP_004_PP_AD-A  or 060PP_004_PP_CO-A).  If sheets were added, 
the sheet number suffix should be used in the file name (example: 060PP_004A_PP_AD-A). 
   
If design details were documented in one drawing then referenced in cut sheets, then the revised 
details should be documented in one drawing then referenced in cut sheets. 
 
Example:  A driveway should not be built at the location shown in the original design plans.  

Originally the driveway information was specifically drawn in the file 
R:\project\80046083.017\DESIGN\design.dgn then referenced into 
R:\project\80046083.017\DESIGN\Sheets\060PP_006_pp_geelan1.dgn.  The 
person creating the change order drawings should create new drawings named 
“design_CO-A.dgn and 060PP_006_pp_geelan1_CO-A.dgn.  Note that the file 
name uses a suffix modifier “CO-#,” where # is the change order group letter.    
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 The change order modifications should only be made to the new files within the 
Change Order folders.  Include only the features that have changed from the 
original design.dgn file to the design CO A.dgn.  The change order driveway 
would be drawn within 
R:\project\80046083.017\DESIGN\ChangeOrder_A\design_CO-A.dgn and 
then referenced and clipped into 
R:\project\80046083.017\DESIGN\ChangeOrder_A\Sheets\060PP_006_pp_ 
geelan1-CO-A.dgn. 

 
When changes are made to a drawing that is referenced into other drawings, all parties involved 
in making the original plans shall be notified of the changes and the location of the new revised 
drawing. 
 
Most revised drawings reference the original design drawings.  Referencing is usually preferred 
over copying because changes can be quickly identified, and it is less redundant.  However, there 
are exceptions to referencing for addenda and change orders.   
 
OpenRoads civil geometry, features and corridors may use reference paths that are difficult to 
reestablish.  Some of these references are more than a graphic reference.  They may include a 
civil (OpenRoads) reference such as the references used for corridor modeling.  If the file 
involved with the plan revision includes civil (OpenRoads) references, then the original file 
should be backed up and then the original file can be edited.  The backed-up files should use a 
suffix modifier similar to the one discussed for plan revisions, but they should include the phrase 
“Pre” (examples: RDM_Pre-AD-A, RDM_Pre-CO-A).  The backed-up file should be placed in 
the Addendum or Change order folder. 
 
Drawings that do not have reference files attached or drawings with extensive changes can be 
copied directly into the Change Order folder and do not need to be referenced back into the new 
change order drawing.  All of the changes can then be made in the change order drawing.  For 
example, a detailed drawing of a Lift station may have many revisions.  This drawing could be 
copied from the design folder into the Change Order folder. 
 
Remember to rename these copied drawings with the addenda “AD-#” or change order “CO-#” 
suffix modifier. 
 
The element symbology for these revised drawings should be the same as the symbology used 
for the design plans. 
 
Update the supplement design data such as AMG files to match the applicable plan revisions.  
Consultants should resubmit changed supplemental design data with the addenda or change 
order. 
 
Refer to the Design Manual, Section 1-9, Plan Revisions and Change Orders, for additional 
administrative requirements. 
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7.5 Incorporating Microsoft Word and Excel Documents in PDF Plan Sets 
Oct 2008 

 
Plan sets contain some sheets that are created from Microsoft Word and Excel.  These sheets 
include the Table of Contents, Notes, and Traffic Control Devices List. 
 

1. There are templates available for these sheets on the Plan Preparation Guide website 
at http://www.ugpti.org/dotsc/prepguide/index.php.  These are special sheets that 
have macros built into them for printing. 

2. Put the page numbers in the upper right-hand corner. 
3. When printing these sheets, do not use the File => Print option from the menu bar.  

Instead use the following method to print the sheets: 
a. The Table of Contents and Notes sheets have dialog boxes that launch when 

you first open the files.  If you accidentally closed the dialog boxes, they can 
be opened by closing and then reopening the file. 

b. The Traffic Control Devices List has a Print Plan Sheet button located at the 
top of the Input sheet. 

 
 
  

http://www.ugpti.org/dotsc/prepguide/index.php
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7.6 Web Map Services (WMS) and Raster Manager  
July 2015 

 
A Web Map Service can be used with MicroStation Raster Manager to reference existing data.  
Two different data source are discussed in this section; OnRamp and NAIP imagery.  These data 
sources are used by many NDDOT ArcMap users.  Now this data can be accessed directly from 
MicroStation. 
 
The following are instructions to reference a WMS. 
 

1. Attach a Geographic Coordinate System to your drawing.  See Section 3.21 (GCS). 
 

2. Open Raster Manager and select 
File>New>WMS from the Raster 
Manager Dialog.  The WMS Map 
Editor dialog box should open. 

 
3. Click on the “Servers” button. The 

Servers Manager dialog box should 
open.  Several URL address should 
be shown in the left panel.   

 
 
 
 
 
 
 
OnRamp data from the NDDOT GIS server 
http://gis.dot.nd.gov/arcgis/services/cad/basemap_dot/MapServer/WmsServer 

 
 

 

http://gis.dot.nd.gov/arcgis/services/cad/basemap_dot/MapServer/WmsServer


CADD Standards 
 

4. Select one of these addresses and click the Ok button.  The Servers Manager dialog 
box will close and the address will be entered into the WMS Map Editor dialog box.  
Near the upper left corner of this dialog box there will be a panel that shows a layer 
tree. 

 
5. Select a desired layer (branch).  Then select the “Add to map” button.  The Layer will 

be added to the Map Layers panel in the lower left.  This step can be repeated to add 
additional layers from the same server. 
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6. Select the “Save and Attach” button near the lower right.  You will be prompted to 

name and save a file (.xwms) that contains the WMS linking information.  After you 
have saved the .xwms file, the Raster Attachment Options dialog box will open. 

 
7. Expand the Geometry panel within 

the Raster Attachment Options 
dialog.  Within this panel set the 
property “Inherit GeoCS from 
Model” to “Not Inherited”.  Then 
Click the Attach button.  

 
Note re-projected rasters can’t presently be 
clipped in MicroStation. 
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7.7 Google Earth and Google Maps  
April 2022 

 
Google Map imagery from the “Free Addition” shall not be used for any documents that are used 
outside of the department.  Don’t use a Google Map in a concept report or public meeting.  The 
“Professional” version of Google Earth is required for sharing information externally. 
 
If your using Google Map imagery for an internal purpose. Don’t remove the Google water 
marks.  You are using copyrighted material. Note, the NDDOT has an Arc Internet Mapping 
Service that is available to all employees.  Imagery from this tool is often better than Google 
imagery.   
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Miscellaneous Help 

8.1 Using MicroStation Files in Microsoft Word 
April 2022 

 
There are several ways to export a MicroStation drawing to a format that can be imported into 
Microsoft Word.  The following is a list of some of the common methods. 
 

1. Windows Cut and Paste 
2. Print Screen 
3. MicroStation Image Capture Tool 
4. Print Drawing to an Image file 

a. Tagged Image Format (.tif) 
b. Joint Photographic Expert Group (.jpg) 

 
Window Cut and Paste is one of the easiest way to bring a drawing into Word.  However, the 
image quality is poor.  Linestyles appear altered.  Sometimes text is not exported.  Images 
imported using this method are not typically good enough for reports.  This procedure is not 
documented in this manual. 
 
Print screen is another easy way to bring a drawing into Word.  This method usually requires 
considerable cropping once imported into Word.  The background color usually needs to be 
changed to white.  Image quality is OK. This procedure is not documented in this manual. 
 
The MicroStation Image Capture tool can be used to export images to a wide variety of image 
file formats.  This tool allows for cropping during the export process.  The background color 
usually needs to be changed to white.  Image quality is OK.  This tool can be found in the 
Drawing (workflow) > Utilities (tab) > Image (panel).   No further documentation on this 
procedure is given in this manual.  
 
Using MicroStation printing tools to export a drawing to an image file is typically the best 
method to use for most NDDOT reports in the Word document format.  Good image quality can 
usually be maintained.  There are numerous variations with this process.  The active background 
color used during the export process is less of a concern. 
 



CADD Standards 
 

Printing a Drawing to an Image File 
 
There are several variations of this process.  This manual will discuss how to export an “tiff” file 
from MicroStation.    This format is recommended for word documents because file sizes are 
small and image integrity is good.  
 
The same techniques used to print a drawing to paper, using MicroStation print tools, are used to 
print a drawing to an image file.  The main difference is that different plot drivers are used.  
Several plot drivers have been modified for NDDOT use.  They are located at: 
S:\STANDARD\CE*\Organization\plotdrv.  From the MicroStation “Print” dialog box, select 
“File>Select Bentley Driver”.    The “Select Bentley Driver File” dialog box should open.  In 
order to create an tiff file select S:\STANDARD\V8I \plotdrv\Manually_Pick_Printer\NDDOT-
tiff.plt.  When you print the drawing, you will be prompted for a file name and a location to save 
the file. 
 
Once the image file has been created, it can be imported into Microsoft Word.  In Word, select 
“Insert>Picture>From File”.  
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8.2 Bentley View 
Oct 2008 

 
If you don’t have MicroStation and you just want to view and print CADD drawings, this might 
be the tool for you.  This tool is easy to use, and it is free.  People like district engineers and 
administrative assistants could use this tool to view and print MicroStation drawings. 
 
Exporting drawings to PDF takes little time.  However, some reviews benefit from eliminating 
even the smallest step.  If all reviewers have CADD viewers, drawing preparation effort is 
minimized.  Bentley View does not “push” the information to the end user as much as PDF, but 
it is more flexible in terms of not needing to process drawings into another format.  Bentley 
View reads directly from raw CADD - dgn files. 
 
Some people don’t have MicroStation installed on their computer.  It is not practical for them to 
become proficient nor is it cost efficient to install a full version of MicroStation on their 
computer.  But occasionally they may need to review a drawing, (example a drawing was sent to 
them by email).  If this person had Bentley View, they would not have to ask the sender to 
convert the drawing to another format or ask someone with MicroStation to help them view the 
drawing.  They could view and or print the drawing themselves.   
 
Note, privileges to certain servers for certain uses may need to be adjusted.  Some people may 
benefit if they had access to the CADD Server. 
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8.3 Roadway Inventory Management System (RIMS)  
Mar 2011 

 
The Roadway Inventory Management System (RIMS) tool can export information to a PDF.  
This manual does not intend to explain how to use RIMS.  This manual only highlights some of 
the options while print to a PDF. 
 
RIMS files exported to PDF are named after your RIMS User ID, Year, Month, day and Time 
(example, JONCOL1.080917085600.PDF).  RIMS documents exported to PDF are created in the 
directory:  O:\000 Reports.   
 
Print Sequence Numbers are used to control the print format.  Some print formats don’t work 
with some reports.  Data may be clipped from the print or hard to read.  The table below can be 
used to help select the correct print format. 
 

RIMS 
Printer 
ID 

Print 
Sequence 
Number 

Characters 
per Inch 
(CPI) 
 

Lines 
per 
Inch 
(LPI) 

Orientation 
 

Size Typical Use 

PDF 1 12 6 Portrait 8.5x11  
PDF 2 12 8 Portrait 8.5x11  
PDF 3   Landscape 11x8.5  
PDF 4 18  Landscape  11x8.5  
PDF 5 18 10 Portrait 8.5x11 Most Milestone 

Reports 
PDF 6 18 10 Landscape  11x17 Quantity Sheets with 

Border 
PDF 7 18 10 Landscape 11x17 Quantity Sheets 

without Border 
PDF 8  8.5 Portrait  8.5x11 Milestone Reports 

with less margins 
 
 
Additional Notes 

• PDF’s of the Quantity sheets and other should be stored in the project Directory.   
• Please review, print, or store this report, then delete it from the site in order to keep this 

folder manageable. The folder will be purged each month. 
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